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Preface 

ORTI3D was originally developed by Olivier Atteia of the Georesources and Environment Research 

Laboratory at the University of Bordeaux Montaigne (France) as an interface for reactive transport 

modeling. Initially, the code was designed as a pre- and post-processor for MODFLOW, MT3DMS, 

and PHT3D. ORTI3D was expanded to include support for several additional codes including 

SEAWAT, MIN3P, and finally MODFLOW_USG. Currently, support for the parameter estimation and 

model calibration such as PEST is also partially implemented in ORTI3D.  

Recently, with the support of G&E Transfert – NUMINEO (a technology transfer office in the 

development and application of innovative groundwater modeling solutions) and Anchor QEA, LLC 

(an environmental and engineering consulting company), Elicia Verardo began to make efforts to 

explain the theory and the method used in the code. In parallel, we are working on code 

development to improve the visual appearance, completeness, and consistency of functionality, 

reliability, ease, and flexibility of its use and wrote most of the present manual.  

The development of ORTI3D for reactive transport modeling with the powerful reactive 

multicomponent transport model PHT3D is largely supported by its developer Henning Prommer. 

We are very grateful to Henning Prommer, who provides the educational release of PHT3D, 

explanations of the program parameters, and many valuable comments and criticism to continually 

improve ORTI3D.  

The implementation in ORTI3D of the reactive transport code for variably saturated media MIN3P is 

performed closely with its developer Ulrich Mayer. We are indebted to Ulrich Mayer, who provides 

continually the educational release of MIN3P and the corresponding input instruction.  

More generally, many thanks are due to Henning Prommer, Ulrich Mayer, Dimitri Vlassopoulos, and 

their colleagues for their contribution in developing, checking, and validating the various parts of the 

software. 

Obtaining Technical Support 

Technical support is available in ORTI3D at any time:  

 In the unlikely event that you discover a bug in ORTI3D 

 If you would like to contact us with comments or suggestions 

You may send us your questions via the contact form on the ORTI3D website: 

https://www.orti3d.org/contact/ 

Our technical support will try to treat your questions as quickly as possible; however, please allow up 

to 2 business days for a response. 

https://www.orti3d.org/contact/
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Training and Consulting Services 

G&E Transfert – Numineo, CSIRO and ENSEGID offer high-quality training courses using ORTI3D 

globally.  

G&E Transfert – Numineo offers courses designed to provide a rapid introduction to essential 

knowledge and skills on the use of ORTI3D. Most ORTI3D functionalities are browsed through 

practical examples on reactive transport models. For further information, please contact: 

e.verardo@numineo.fr 

CSIRO offers courses designed to undertake or assess numerical modeling studies of groundwater 

flow, transport, and geochemical reactions with PHT3D. For further information, please contact: 

henning.prommer@csiro.au 

ENSEGID offers courses designed to provide an introduction to geochemical modeling and 

knowledges about soil and groundwater pollution. For further information, please contact: 

olivier.atteia@ipb.fr 

G&E Transfert – Numineo also offers expert consulting and peer reviewing services for data 

management, groundwater modeling and reactive transport modeling. For further information, 

please contact: 

e.verardo@numineo.fr 

 

mailto:e.verardo@numineo.fr
mailto:henning.prommer@csiro.au
mailto:olivier.atteia@ipb.fr
mailto:e.verardo@numineo.fr
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1 Introduction to ORTI3D 

1.1 Object 

ORTI3D is a 3D graphical user interface (GUI) for modeling groundwater flow, transport, and reactive 

processes with the following: 

 The modular 3D finite-difference groundwater model MODFLOW of the USGS (Harbaugh et 

al. 2000) 

 The solute transport model MT3DMS (Zheng and Wang 1999) 

 The saturated-unsaturated, fluid-density-dependent groundwater flow and transport model 

SEAWAT (Langevin et al. 2008) 

 The reactive transport codes PHT3D (Prommer et al. 2001) which is coupling MT3DMS with 

PHREEQC 

 The unstructured grid version of MODFLOW for Simulating Groundwater, MODFLOW-USG 

using a Control Volume Finite-Difference Formulation (Panday et al., 2013) 

 The solute transport model MODFLOW USG transport (Panday, 2017) 

 The reactive transport codes PHT-USG which coupling MODFLOW USG transport and 

PHREEQC (Panday et al., 2019) 

 The saturated-unsaturated reactive transport code MIN3P (Mayer et al. 2012) 

 The parameter estimation program PEST (Doherty 2005) 

Features in ORTI3D allow you to do the following: 

 Build 2D, 3D, and radial models. 

 Quickly dimension the model domain and select units, as well as easily assign model 

properties and boundary conditions.  

 Write input files and run models with the aforesaid numerical codes.  

 Write the files necessary to use the parameter estimation program PEST. 

 Easily assign input data. A background value is specified over the whole domain and 

modifications are made by adding zones within which the parameter values are different. This 

allows easily modifying the spatial discretization of the model during the model building 

process. 

 Interpolate input data from wells (topography or hydraulic conductivity). 

 Write more complex input data through the use of formulas. 

 Run Python scripts in the batch module of the interface. 

 Visualize and export results. 
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The purpose of this user guide is to provide information on the use of the following numerical codes 

with ORTI3D: 

 MODFLOW series i.e. MODFLOW 2000, MT3DMS and PHT3D  

 MODFLOW USG series i.e. MODFLOW USG, MODFLOW USG transport and PHT-USG  

 PEST 

The use of MIN3P, SEAWAT, and OPENGEOSYS are not described in this user guide.  

1.2 Orti3d Installation 

1.2.1 System Requirements 

ORTI3D requires the following minimum hardware configurations: 

 Windows XP or later version 

 Processor 32-bit or 64-bit 

 Hard disk 300 megabytes (MB) 

 RAM 2 gigabytes (GB) 

1.2.2 Installing the Orti3d Interface  

ORTI3D can be installed from the following link:  

https://www.orti3d.org/downloads/ 

ORTI3D must be installed on your local hard disk to run. The installation procedure is outlined in the 

aforesaid link. 

Note that once installation of ORTI3D is complete, there will be a number of files in the program 

folder, plus several subfolders containing additional files. Please do not delete any files or subfolders 

in the ORTI3D program folder, as all files are needed for the proper functioning of the software. 

1.2.3 Starting ORTI3D 

Once ORTI3D has been installed on your computer, to start ORTI3D from Windows, double-click the 

ORTI3D icon named startOrti3d. 

 

https://www.orti3d.org/downloads/
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1.3 About the Interface 

The ORTI3D interface has been specifically designed to increase modeling productivity and facilitate 

the setup of 3D groundwater flow and contaminant transport models. In order to simplify the 

graphical interface, ORTI3D is divided into the following different sections present in the same 

window: 

 

 Main Menu 

 Spatial Attributes 

 Parameters 

 Results 

 Toolbox 

The Main Menu section is used to create, open, and save ORTI3D project files, import and export 

data, select additional options available in ORTI3D, access to help files, and download the latest 

version of ORTI3D.  

The Spatial Attributes section allows the user to graphically assign all the necessary input 

parameters for building a 3D groundwater flow and contaminant transport model. 

The Parameters section allows the user to modify model settings, write model files, and run the 

models. Model settings have default settings, which are capable of running most simulations. This 

section also includes the chemistry setting for the reactive transport model. 

The Results section allows the user to display all of the modeling results for the groundwater flow 

and reactive transport simulations. 

The Toolbox section allows the user to modify the display option of the model domain.  

1.3.1 Getting Around in ORTI3D 

A Microsoft compatible mouse functions as follows: 

 Left button: This is the regular “click” button. 

 Right button: This button closes polygons or ends a line during the use of the zone tools.  

Hovering the mouse pointer over a function button in ORTI3D to displays the role of the button. 

The <Alt> shortcut key can be used to access Main Menu section. Simply press the <Alt> key and 

the letter key at the same time to access the item.  

The <Ctrl +c> and <Ctrl +v> shortcut keys can be used to copy and paste data. 
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The <Ctrl +n> shortcut keys can be used to create a new model project. 

The <Ctrl +o> shortcut keys can be used to open a model project. 

The <Ctrl +s> shortcut keys can be used to save the model project. 

The <Ctrl +q> shortcut keys can be used to quit the model project. 

1.3.2 Main Menu 

The Main Menu section contains the following options: 

 

File: Create a new ORTI3D project, select a file utility (open, save, save as), and exit 

ORTI3D. 

Import: Select features to import:  

 Observed Head, Tracer and Chemistry data 

 PHT3D solutions, user and postfix species 

Export: Select features to export: 

 Grid-Dependent Parameter or Result text file (.txt) 

 Grid-Dependent Parameter or Result vtk file (.vtk) 

Add-In: Select additional MODFLOW or MT3DMS modules, use batch module and add 

initial chemistry option.  

Help: Get general information on how use ORTI3D and update latest version of ORTI3D. 

 

The File menu options are described as follows: 

New: Creates a new ORTI3D project (for more details, see Section 2.1). 

Open: Opens an existing ORTI3D project. 

Save: Saves the current project. 

Save As: Saves the current project with a different filename. 

Exit: Closes the project and exits ORTI3D. 
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1.3.3 Spatial Attributes 

The Spatial Attributes section contains the following options: 

 

Parameters selection: Select the model, the module, and the parameter.  

Media selection: Select the media for the 3D model. 

Background value: Assign a parameter value for the whole domain.  

Type of value: Select the type of value (one value, zone, formula, interpolation, import 

zone, or array). 

Display result: Graphically display the result. 

Creating zones: Create a zone (point, line, rectangle, polygon, or variable polygon). 

Modifying zones: Move, modify shape, or delete zone; modify value of zone. 

1.3.4 Parameters 

The Parameters section contains the following options: 

 

1.Model: 
 Set dimensions and type of model. 

 Set model domain size and grid size. 

 Set layer dimensions for 3D model. 

 Set time frame. 

 Add an underlying map. 

   

2.Flow: 
 Select flow model settings. 
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 Write input files for flow models (MODFLOW and MIN3P). 

 Run flow models (MODFLOW and MIN3P). 

 Simulate particle trajectories. 

   

3.Transport: 
 MT3DMS reactive module option.  

 Select model settings. 

 
Write input files for solute transport models (MT3DMS, SEAWAT and 

MIN3P). 

 Run solute transport models (MT3DMS, SEAWAT and MIN3P). 

   

4.Chemistry: 
 Import thermodynamic database for PHT3D model. 

 Define solution compositions for PHT3D model. 

 Select model settings. 

 Write input files for reactive transport models (MIN3P and PHT3D). 

 Run reactive transport models (MIN3P and PHT3D). 

   

5. PEST: 
 Select PEST background parameters. 

 Select PEST zone parameters. 

 Check PEST files. 

 Write PEST files. 

 Run PEST. 
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1.3.5 Results 

The Result section contains the following options: 

 

   
Indicate which plane (X, Y or Z) is display for 3D model. 

   
Switch between contour lines and color maps.  

1. Model: Select the Plane, the Layer, and the time (Tstep) to display simulation results, 

display the Grid, and display the underlying Map. 

2. Flow: Display Head simulation contour, water content (Wcontent) contour (for 

unsaturated flow models), velocity vectors (Veloc-vect), velocity magnitude  

contours (Veloc-magn), and trajectories of Particles. 

3. Transport: Display Tracer simulation contour. 

4. Chemistry: Display chemical Species simulation contour, select Units, and display User 

added chemical species. 

5. Observation: Select Type of observation to display: Time-series, Profile, or Calibration plots 

and select the Result to display (Head, Wcontent, Tracer, Chemistry).  

1.3.6 Toolbox 

The Toolbox section contains the following options: 

 Go back to the initial model domain view. 

 Redo or undo the view of the model domain. 
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 Move the model domain view. 

 Zoom in on the model domain view. 

 Modify the margins of the model domain view. 

 Save the model domain view. 

 
Indicates x and y position of the mouse cursor in the model domain and the 

value of the result displayed (z).  

1.4 Orti3d Project File 

Each ORTI3D project consists of a unique data file. This file is distinguished by the following 

extension: 

Projectname.orti 

Although ORTI3D project files are easily distinguished by the project name prefix, it is strongly 

recommended that the user create a separate folder for each modeling project to make it more 

practical to manage all model files created for the simulation. This is especially true for MT3DMS, 

PHT3D, and MIN3P, because when these models are used, the input files created are automatically 

assigned names independent of the ORTI3D project file name, as follows: 

 mt3ms.extension 

 pht3d.extension 

 min3p.extension  

Although the ORTI3D project files are written in XML format, it is not recommended to manually 

modify or manipulate the data in these files. ORTI3D will not be able to successfully open a project if 

it encounters any unexpected error or incorrect file format.  

That being said, advanced users could modify the file in a text editor program. If this is attempted, it 

is strongly recommended to back up the original project file generated by ORTI3D before replacing 

or manually modifying it. 
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2 Getting Started 

2.1 Create a New Model 

To create an ORTI3D model project, select File/New from the Main Menu section. A New Model 

window will appear. Select the directory where you want to save the model files, and type in the new 

ORTI3D project name (e.g., MyModel). Press the Open button to finish creating the new model.  

Please ensure that you do not include punctuation, accented characters, or other “odd characters” 

(i.e., non-English or non-alphanumeric) in the project name or directory pathname.  

2.2 Open Existing Orti3d Model Project 

To open an ORTI3D model project that has been created previously, do the following: 

 Select File/Open from the Main Menu section. An Open window will appear.  

 Navigate to the directory where the ORTI3D file project is located.  

 Select the file and then click the Open button. Another window will appear on your screen 

indicating file opened.  

 Press the OK button to finish opening your existing model. 

2.3 Use an existing MODFLOW model 

To use an existing MODFLOW model: 

 Place all MODFLOW files in the model folder 

 Create an ORTi3D model file and name it as the MODFLOW model 

 Define a grid of the ORTi3D model identical to the grid of the MODFLOW model 

 Disable the 'Write Flow Model' button: 

 
o Click on the “Model” button under the Parameter/1.Model section. 

o Check the box “Use other flow model?” and then click the “Ok” button. 
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3 Global Operations 

3.1 Saving the Model 

The current data and display settings for the model can be saved at any time by selecting File/Save 

from the Main Menu or by using the <Ctrl +s> shortcut keys. An Info window will appear with the 

message file saved. Press the OK button. 

In addition, you can save the current model project in a different folder. This function allows you to 

save different versions of the same model project in different folders.  

To Save As the current model project, do the following:  

 Selecting File/Save As from the Main Menu section. 

 A Save window will appear. Navigate to the directory where you want to save the model 

project.  

 Indicate the file name and then click the Open button. 

3.2 Importing Site Maps 

A site map (or basemap) of the model domain may be added for locating important characteristics of 

the model or for visualizing observation data to adjust the model. ORTI3D supports the use of site 

maps in PNG graphics image file formats. There is no georeferencing option available in ORTI3D, so 

the image must have the same dimension as the model domain. Consequently, when the domain 

size is modified, a new image must be done. It is advised to first create a map that has the size of the 

model domain through an image editor and then create the domain in the ORTI3D interface using 

the map as a background. 

To import a basemap, do the following:  

 
 Click on the Map button under the Parameters/1.Model section. 

 A Choose Map window will appear. Navigate to the directory where the basemap is 

located.  

 Select the file and then click the Open button. 

The site map can be either active or hidden by checking or unchecking the Map checkbox under the 

Results/1.Model section. The site map file is not associated to the model project file. The site map 

has to be imported each time the model project is opened. 
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3.3 Import Options 

3.3.1 Import Observation Data 

ORTi3D has an import option to import observation data of three different types as follows: 

 Head observation data 

 Tracer observation data 

 Chemistry observation data 

To import observation data, do the following: 

 Select Import/Head Observation Data (or Tracer observation data or Chemistry observation 

data) from the Main Menu section.  

 A head observation data window will appear. 

 Set or copy paste your head observation data in the table respecting the title of each 

column. 

The titles of the column are as follows: 

 Head observation data: Well – Layer – Time – Head  

 Tracer observation data: Well – Layer – Time – Tracer 

 Chemistry observation data: Well – Layer – Time – Chemical species 1 – Chemical species 2 

The well name must match the name of an Observation zone in the model (for more details, see 

Section 7.2). 

For 3D models, Layer represents the model layer at which the Observations were recorded (starting 

from 0 increasing with depth). For 2D models, Layer is 0.  

Time is the time at which the Observations were recorded. The times indicated here must match 

with the model output times.  

Head is the value of head in model units. 

Tracer is the value of tracer concentration in model units. 

Chemical species is the value of chemical species concentration in moles/L. 

3.3.2 Import User Species 

ORTI3D has an import option to import user species for which calculations may be performed from 

the model results. This option may be used, for instance, to compute the isotope ratios of chemical 

species. The data file formats currently supported by ORTI3D for importing user species are ASCII 

text files (.TXT). The file must contain the name of the user species followed by the formula that 
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contains the calculations to perform from the model result. This information has to be provided on 

one line for each user species, as follows (between hook the information provided by the modeler): 

‘Name’=‘Formula’ 

… 

… 

‘Name’=‘Formula’ 

 

‘Name’ is the keyword used to specify the name of the user species, which may be any words 

(without blanks or special characters). 

‘Formula’ is the mathematical formula that contains the calculation to perform with the model result 

obtained for a PHT3D chemical species. The name of the PHT3D chemical species must be spelled 

exactly as it is in the PHT3D Database. 

For example, for the calculation of an isotope ratio, the text file may be as follows: 

Delta_tce=(Tce_h/(Tce_l+1.10-12)/0.011237-1)*1,000 

Delta_dce=(Dce_h/(Dce_l+1.10-12)/0.011237-1)*1,000 

Deltal_vc=(Vc_h/(Vc_l+1.10-12)/0.011237-1)*1,000 

Delta_eth=(Eth_h/(Eth_l+1.10-12)/0.011237-1)*1,000 

 

where Delta_tce is the user species, Tce_h and Tce_l are PHT3D chemical species (here heavy and 

light isotopes).  

To import user species file, do the following: 

 Select Import/User Species from the Main menu section.  

 An Open Solution window will appear. Navigate to the directory where the user species file is 

located. 

 Select the file and then click the Open button. 

 An Info window will appear with the message User Species Imported. Press the OK button. 

The user species results can be displayed under the Results/4.Chemistry section (for more details, 

see Section 7). 

3.3.3 Import Postfix Species 

Optionally, an additional file may be used by advanced users to control PHT3D simulations. This file 

has fixed names, postfix.phrq, and it shall be in the same directory as the model project folder. The 

content of this file should consist of PHREEQC statements that are appended to the PHREEQC input 
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file generated by PHT3D. Through this option, the user has access to less routinely used PHREEQC 

capabilities for which the input can currently not be provided by the standard PHT3D input files. 

For example, surface complexation and exchange species can be defined via the postfix.phrq files as 

follows:  

SELECTED_OUTPUT 

 -file selected.out 

 -reset false 

USER_PUNCH 1 

 -headings time cell F_Hfos F_Hfow F_Alo F_sorb Ca_X2 

 -start 

10 PUNCH TOTAL_TIME/86400 

20 punch STR$(cell_no) 

30 F_Hfos = MOL("Hfo_sF")+MOL("Hfo_sOHF-") 

40 F_Hfow = MOL("Hfo_wF")+MOL("Hfo_wOHF-") 

50 F_Alo = MOL("Al_sOHF-") + MOL("Al_sOHF2-2") 

60 F_sorb = F_Hfos + F_Hfow + F_Alo 

70 Ca_X2 = MOL("CaX2") 

80 PUNCH F_Hfos F_Hfow F_Alo F_sorb Ca_X2 

 -end 

END 

 

The postfix.phrq file must set up the following: 

 SELECTED_OUTPUT section 

‒ The output file must be named selected.out 

 USER_PUNCH 1section 

‒ The first column of the selected.out file must be the time 

‒ The second column of the selected.out file must be the cell number (as a string; if not, 

it does not work for large models) 

‒ There can be any number of following columns; they will be used as species names by 

ORTI3D (e.g., five species, F_Hfos, F_Hfow, F_Alo, F_sorb and Ca_X2) 

 For each new species, indicate the formula that defines it 

‒ F_Hfos = MOL("Hfo_sF")+MOL("Hfo_sOHF-") 

‒ F_Hfow = MOL("Hfo_wF")+MOL("Hfo_wOHF-") 

‒ F_Alo = MOL("Al_sOHF-") + MOL("Al_sOHF2-2") 

‒ F_sorb = F_Hfos + F_Hfow + F_Alo 

‒ Ca_X2 = MOL("CaX2") 
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To run a simulation with postfix species, do the following: 

 Place the postfix.phrq file in your model project folder.  

 Write PHT3D files and run PHT3D from the interface with the plume button.  

To import user species files, do the following: 

 Select Import/Postfix Species from the Main Menu section.  

 An Info window will appear with the message Postfix Species Imported. Press the OK 

button. 

The postfix species results can be display under the Results/4.Chemistry section (for more details, 

see Section 7). 

3.4 Export Options  

ORTI3D is capable of exporting the model inputs and outputs to numerous file formats, including 

graphics image files, ASCII Array files, and VTK files.  

3.4.1 Exporting the Model Display Area 

ORTI3D can export the model display area to a variety of graphics file types, including .EPS, .JPEG, 

.PGF, .PDF, .PNG, .PS, .RAW, .SVG, .TIF formats.  

To export the model display area to a graphics image file, do the following: 

 
 Click on the Save button under the Toolbox section. 

 A Save to File window will appear. Navigate to the directory where you want to 

save the graphics image file.  

 Select the type of graphics image that you want to create. 

 Indicate the file name and then click the Open button. 

 

3.4.2 Exporting Input/Output Data Text Files 

ORTI3D can export the model input/output data to ASCII Array (.TXT) file format (i.e., rows x columns 

array of values for each selected output data) for each selected model layer. Data for multiple layers 

can be exported to separate files for each layer.  

To Export model input to a data file, do the following:  

 Display the input variable to export from the Spatial Attributes section (for more details, see 

Section 4). 

 Select Export/Current Parameter from the Main Menu section. 
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 An Info window will appear with the name of the file saved. Press the OK button. The .TXT file 

is automatically saved in the current model project folder. 

To Export model output to a data file, do the following:  

 Display the output variable to export from the Result section (for more details, see Section 7). 

 Select Export/Current Result from the Main Menu section. 

 An Info window will appear with the name of the file saved. Press the OK button. The .TXT file 

is automatically saved in the current model project folder. 

3.4.3 Exporting Input/Output Data VTK Files 

ORTI3D can export the model input/output data to VTK (.vtk) files format (i.e., rows x columns array 

of values for each selected output data) for each selected model layer. Data for multiple layers can 

be exported to separate files for each layer.  

To Export model input to a data file, do the following:  

 Display the input variable to export from the Spatial Attributes section (for more details, see 

Section 4). 

 Select Export/Current Parameter VTK from the Main Menu section. A Save VTK window 

will appear. 

 Navigate to the directory where you want to save the VTK file.  

 Indicate the file name and then click the Save button. 

To Export model output to a data file, do the following:  

 Display the output variable to export from the Result section (for more details, see Section 7). 

 Select Export/Current Result VTK from the Main Menu section. A Save VTK window will 

appear. 

 Navigate to the directory where you want to save the VTK file.  

 Indicate the file name and then click the Save button. 
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4 Model Input Data 

4.1 General Input 

4.1.1 Model Group 

Different numerical codes or group of codes are available in ORTI3D for modeling groundwater flow, 

transport and reactive processes as follows:  

 MODFLOW series 

 MODFLOW USG series  

 Min3p 

 SEAWAT1 

  

Characteristic 

MODFLOW series MODFLOW USG series 

MIN3P SEAWAT  
MODFLOW MT3DMS PHT3D 

MODFLOW_USG 

/ Transport 

PHT-

USG 

Finite difference X X X X   X  

Finite volume    X X X   

         

Saturated flow X   X X X X  

Unsaturated flow X2    X3 X   

Variable density       X  

Solute transport  X X X X X   

Energy transport     X3  X  

Reactive transport   X  X X   

 

To select the suitable numerical code for your model project, do the following:  

 
 Click on the Model button under the Parameter/1.Model section. 

 Select the type of numerical code in the group drop-down list and then click the 

“OK” button. 

                                                   

1 This code is available under Modflow series (MT3DMS code) through the VDF and VSC packages. 

2 This option is available through the UZF and NWT packages. 

3 These options are available in PHT-USG but not implemented in ORTI3D.  
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As a reminder, the purpose of this user guide is to provide information on the use of the MODFLOW 

series codes (MODFLOW, MT3DMS, and PHT3D) and MODFLOW USG with ORTI3D. 

4.1.2 Model Dimension 

ORTI3D is capable building models with different dimensions, including the following:  

 2D horizontal 

 3D 

 Vertical cross section 

 Radial 

4.1.2.1 2D Horizontal and 3D Model 

For the 2D horizontal and 3D models, the model area is displayed with a top view. The horizontal axis 

is the x axis and the vertical axis is the y axis. A detailed description of the options for 3D grid 

discretization is provided in Section 4.1.5. 

 

 

4.1.2.2 Vertical Cross Section Model 

For vertical cross section models, the view in ORTI3D is displayed as a cross section. The horizontal 

axis is the x axis and the vertical axis is the z axis.  

 

 

4.1.2.3 Radial Model 

As for vertical cross section models, the view in ORTI3D for radial model is displayed as a cross 

section. The horizontal axis is the x axis and the vertical axis is the z axis.  
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For the radial option, ORTI3D generates a 2D vertical grid with all parameters modified with the 

distance from the well. We use the so-called Langevin approach, in which permeability, porosity, and 

similar parameters are increasing with radius. This is done automatically inside the interface, so the 

user sets the parameters as they are in the physical medium. However, when looking at the same 

parameters in the MODFLOW (LPF for instance) or MT3DMS (BTN) files, the parameters will be 

different, as they were scaled according to the distance from the well. 

To select the model dimension of your model project, do the following:  

 
 Click on the Model button under the Parameter/1.Model section. 

 Select the type of numerical code in the dimension drop-down list and then click 

the OK button. 

4.1.3 Flow Model Layer Types 

In ORTI3D, when MODFLOW is used as flow model, the numerical formulations, which are used to 

describe groundwater flow, depend on the type of each model layer. The layer types are as follows:  

 Confined: The layer is strictly confined. For transient simulations, the confined storage 

coefficient (specific storage × layer thickness) is used to calculate the rate of change in 

storage. Transmissivity of each cell is constant throughout the simulation. 

 Unconfined: In MODFLOW, and thus ORTI3D, an unconfined layer is simulated as a 

convertible layer. When the calculated hydraulic head is below the top of the cell, the specific 

yield is used to calculate the rate of change in storage for this layer type. During a flow 

simulation, the transmissivity of each cell varies with the saturated thickness of the aquifer. To 

get more information about convertible layer, refer to Section 5.1.4. 

 Mix (for 3D model): For 3D models, the layer may be either confined or unconfined 

(convertible). To define different layer types for 3D models, refer to Section 5.1.4.  

To select the flow model layer type of your model project, do the following:  

 
 Click on the Model button under the Parameter/1.Model section. 

 Select the flow model layer types in the type drop-down list and then click the OK 

button. 
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4.1.4 Model Domain and Grid Design - MODFLOW series 

In ORTI3D, to select the size of the model and design the grid, do the following:  

 
 Click on the Grid button under the Parameter/1.Model section. 

 Set Xmin, Ymin (or Zmin), Xmax, Ymax (or Zmax), dx and dy (or dz) and then click the OK 

button. 

4.1.4.1 Size of the Model 

The model domain is typically represented by the coordinates of two points along the x and y axis 

(or z axis in case of cross section or radial model). The model origin is the Xmin and Ymin (or Zmin) 

world coordinate location of the bottom left-hand corner of the model domain. The model corner is 

the model coordinate of the top right-hand corner Xmax and Ymax (or Zmax) of the model domain.  

4.1.4.2 Grid Design 

Grid spacing along the x (dx) and y (dy) axis (or z [dz] axis in case of cross section or radial model) is 

customizable through the ORTI3D interface. 

To have uniform grid spacing, indicate cell size in the x-direction in the dx box and in the y-direction 

(or z-direction) in the dy (or dz) box.  

In many situations a non-uniform grid spacing may be advantageous, to allow for a finer grid 

discretization in the area of interest, and larger grid spacing in areas that are less important or where 

less data are available. A refined grid allows the user to get more detailed information in the area of 

interest, while minimizing the total grid size used in the model. Minimizing the total number of grid 

cells will reduce the computational time required for run the model. 

To generate a non-uniform grid, there are the following two possibilities in ORTI3D:  

1. To get progressive variable cell sizes, indicate in the dx and dy (or dz) box the starting value in 

x-coordinate and y-coordinate (or z-coordinate) respectively following by the cell size at that 

value. Cells size between two values in x-coordinate or y/z-coordinate will be automatically 

computed by ORTI3D in order to smooth cell size difference between two consecutive cells. Be 

aware that grid size calculation is not mathematically possible for all inputs, and sometimes the 

user may not obtain exactly the grid size corresponding to the inputs. 
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2. To get fixed variable cell sizes, the simple method is to indicate a range with the same cell sizes, 

as follows: 

0 10 

40 10 

45 5 

55 5 

60 10 

100 10 

Cell sizes between two values in x-coordinate or y/z-coordinate will be uniform in this case.  

In both cases, it is mandatory to provide cell sizes from the model origin (Xmin and Ymin (or Zmin) ) to 

the maximum of the model domain size (Xmax and Ymax (or Zmax)). 

In each phase of your model project, you can change the size of the grid cells. If the grid is refined or 

coarsened, all model input data zones are unchanged. For example, if a cell with a pumping well 

representing by a point zone is divided into five cells, only the cell with the point zone will be treated 

as well and the pumping rate will be kept the same as that of the previous cell size. This is true for all 

type of input data zone available in ORTI3D. 
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Note that for numerical stability, the cell sizes difference between two consecutive cells should not 

be larger than a ratio of 2 or 3.  

The grid lines can be either active or hidden by checking or unchecking the Grid checkbox under the 

Results/1.Model section.  

4.1.5 Model domain and grid design – MODFLOW USG series 

MODFLOW USG allow the use of structured and unstructured grid.  

For the use of structured grid (rectangular cells), the definition of model domain and grid design in 

ORTI3D is the same as for the MODFLOW series code grid (cf. 4.1.4 Model Domain and Grid Design - 

MODFLOW series).  

For the use of unstructured grid, ORTI3D allow to use Delaunay triangle and Voronoi Polygons. The 

nested grid is not implemented up to now.   

In ORTI3D, the calculation for triangles is done by Delaunay triangulation computed with Gmesh. For 

Voronoi polygons, the polygons are built from the triangles by finding the mediatrice of each 

triangle side, and further building the polygons. Then, the MODFLOW USG characteristics (area, 

connections, side length..) are calculated internally in ORTI3D. 

It must be outlined that due to this automated calculations the cells cannot be modified one by one, 

they are globally modified by providing local densities. However, we kept the same strategy as 

previously: the spatial information is provided by zones and ORTI3D calculates automatically the 

properties attached to each cell. Therefore, if the mesh is modified the model properties are 

modified consequently. If the model domain is modified, make sure that the objects defined in 

boundary conditions remain in the domain. 
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4.1.5.1 Model domain 

In ORTI3D, to define the MODFLOW USG model domain, do the following:  

 
 Click on the Grid button under the Parameter/1.Model section. 

 Set Xmin, Ymin (or Zmin), Xmax, Ymax (or Zmax), dx and dy (or dz) to build a rectangular 

domain which can embed your whole mesh.   

 Click the OK button. 

 
 Click on the “Parameter” button under the Parameter/2.Flow section. 

 Choose DISU in the first drop-down list.  

 Choose DISU.2- Type of mesh in the second drop-down list.  

 Set the desired option (Triangle or Voronoi) in the third drop-down list.  

 Click the “Apply” button. 

 

or 

 

 

 Choose MODFLOW – DISU – disu.3 Mesh in the first three drop-down list under 

the Spatial Attributes section. 

 Draw the outline of the domain with the rectangle or polygon tool for assigning 

and editing distributed input data. 

 A Zone window will appear.  

 It is MANDATORY to give to this polygon the name domain in the Zone Name 

box. 

 Set the density of the mesh at the domain boundaries in the Zone value box. This 

value will be the approximate size of the polygon at the boundaries. 

 Click the OK button. 

 

or 

 

 Click on the Grid button under the Parameter/1.Model section to calculate the 

meshing. 

 Wait until the mesh appear.  

4.1.5.2 Mesh design 

The mesh can be refined globally by changing the domain density or it can also be refined at given 

places (for instance rivers or wells) by adding points or lines. 

To locally refine or coarse the mesh assign horizontal conductivity values: 

 Choose MODFLOW – DISU – disu.3 Mesh in the first three drop-down list under the Spatial 

Attributes section. 

 Draw a point or a line with the point or line tool for assigning and editing distributed input 

data. 

 A Zone window will appear.  
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 It is MANDATORY to give to the point the name pointXX and to the line the name lineXX 

the Zone Name box (where you can chose XX). 

 Set the density of the mesh around the point or the line in the Zone value box. This value 

will be the approximate size of the polygon at the boundaries. 

 Click the OK button. 

 

or 

 

 Click on the Grid button under the Parameter/1.Model section to calculate the 

meshing. 

 Wait until the mesh appear.  

Do not set the points or lines too close to the domain boundary it will not work. 

4.1.6 3D Discretization 

In ORTI3D, the 3D approach contains the following two types of objects:  

 Media: Consider media as the geological strata; all properties will be the same in one medium.  

 Layer: Used mainly for computing transport when vertical dispersivity is small (a lot of cases), 

so one media can be subdivided in several layers; the properties given for one media will 

automatically be attributed to the embedded layers. 

To define the 3D geometry of your model, do the following:  

 
 Click on the 3D button under the Parameter/1.Model section. 

 Set the top of each media in the Top of Media box. 

 Set the bottom of the model in the Bottom box.  

 Set the number of layers in each media in the nb of layers box as follows: 

‒ If you indicate one number, all media will get the same number of layers.  

‒ To assign different number of layers per media, indicate a number of layers 

per media (either a number per line). 

‒ To divide the thickness of a medium (uniform or non-uniform) into multiple 

layers with progressive thicknesses, indicate two numbers per media (either 

two numbers per line) smaller than one. The first number will be the thickness 

ratio of the top layer of the medium, the second number will be the thickness 

ratio of the bottom layer, and the intermediate layers thickness will be 

calculated to obtain a geometric progression. 

  Click the OK button, then a 3Dlayers window will appear. 

 This window displays the 3D geometry of the model (number of media, number of 

layers and layers elevation).  

 Click the OK button. 
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A numerical model using layers with constant elevations often cannot represent true hydrogeological 

conditions caused by variable layer thickness and surface topography. In order to accommodate 

these conditions for the MODFLOW series model, ORTI3D supports an interpolation module to 

create variable top and bottom elevations for each layer. A detailed description of the interpolation 

option in ORTI3D is provided in Section 4.2.5. When interpolation is used, the number of media and 

layers per media are still provided from the 3D button. The thickness of layers is calculated by 

dividing the medium thickness of each cell by the number of layers for the medium. It is also 

possible to build the geometry from grid imported as arrays (see 4.2.7) 

4.1.7 Model Output Time 

Model output time is the time at which the results are saved and displayed. In ORTI3D, model output 

time is managed in the same way for all type of model projects (MODFLOW series model). For the 

MODFLOW model, the model output time is used to define the length of stress periods (i.e., time 

intervals during which all external excitations or stresses [boundary conditions, pumping rates, etc.] 

are constant). 

To set the output time frame of your model project, do the following:  

 
 Click on the Time button under the Parameter/1.Model section. 
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 Set the total simulation time of your model in the Total Simulation Time box. The 

start time is 0 by default in ORTI3D and cannot be changed.  

 Set the stress periods size in the Step Size box. 

 Click the OK button. 

 

Stress periods size could be constant or variable. To define your own stress periods, indicate the start 

time for each new stress period length in the Total Simulation Time box and the new stress period 

length beginning at this time in the Step Size box, as follows: 

 

 

In this example, the stress period size will be 1 from time 0 to time 10, and the stress period size will 

be 10 from time 10 to time 50. 

For the MODFLOW series model, the length of stress periods is not relevant to a steady-state flow 

simulation. However, if you want to perform contaminant transport simulation with MT3DMS and/or 

PHT3D at a later time, you must specify the actual time length in the table.  

The data collected for each modeling project is rarely synchronized in terms of stress periods, so 

ORTI3D merges the time schedules for all transient input data (pumping wells, boundary conditions) 
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with the model output time set by the user to determine the length of each stress period. For 

example, if the time schedule provided for a well does not coincide with the model output time then 

ORTI3D will consider the time schedules of the well to determine the length of each stress period. 

4.2 Tools for Assigning and Editing Distributed Input Data 

Groundwater flow and contaminant transport model require many different types of data 

(parameters, boundary and initials conditions) to simulate the hydrogeological and 

hydrogeochemical processes influencing the flow of groundwater and migration of dissolved 

contaminants. In ORTI3D, the hydrogeological and hydrogeochemical characteristics of the model 

are classified into the following input data:  

 Spatially Distributed model data. 

 Uniform model data. 

The following is a description of how to assign and edit distributed data with ORTI3D. For specific 

descriptions of the data requirements and data entry options, refer to the sections describing each 

data type. 

Distributed data are set under the Spatial Attributes section. A major specificity of ORTI3D is that 

the spatial attributes are not entered on a grid but as zones that will be transformed to grid 

attributes only when the files are written. Thus, grid properties may be modified at any time during 

the modeling process. 

4.2.1 Background Value 

The minimum information to be provided for distributed data in ORTI3D is the background value. 

This value will be applied in all the cell of your model. 

To set grid Background value:  

 Select the appropriate model data in the first three drop-down list under the Spatial 

Attributes section. 

 For 3D model, select the appropriate media in the Media drop-down list under the Spatial 

Attributes section. 

 In the Spatial Attributes section assign or edit a value in the Backg. Box. 

 Click the “Ok” button. 

4.2.2 Creating Zones 

Data zones can be assigned to the model grid cells using one of the options available under the 

Spatial Attributes/Add Zones section.  
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Point zone is used to select individual grid cells where the data zone will be assigned. To add a 

Point zone:  

 
 Select the appropriate model data in the first three drop-down list under the Spatial 

Attributes section. 

 Choose zone in the Type drop-down list under the Spatial Attributes section. 

 Click on the “Point” button under the Spatial Attributes/Add Zones section. 

 Left-click at the grid cell where the data zone will be assigned.  

 

Line zone is used to select horizontal, vertical or diagonal line of grid cells where the data zone will 

be assigned. To add a Line zone:  

 
 Select the appropriate model data in the first three drop-down list under the Spatial 

Attributes section. 

 Choose zone in the Type drop-down list under the Spatial Attributes section. 

 Click on the “Line” button under the Spatial Attributes/Add Zones section. 

 Left-click at the start point of the line and left-click again at the end point of the 

line.  

 

Rectangle zone is used to stretch a rectangular window around the group of cells where the data 

zone will be assigned. To add a Rectangle zone:  

 
 Select the appropriate model data in the first four drop-down list under the Spatial 

Attributes section. 

 Choose zone in the Type drop-down list under the Spatial Attributes section. 

 Click on the “Rectangle” button under the Spatial Attributes/Add Zones section. 

 Left-click at one corner of the rectangle and left-click again at the opposite corner 

to define the rectangle dimensions. 

 

Polygon zone is used to digitize a polygon around or below the group of grid cells where the data 

zone will be assigned. To add a Polygon zone:  

 
 Select the appropriate model data in the first three drop-down list under the Spatial 

Attributes section. 

 Choose zone in the Type drop-down list under the Spatial Attributes section. 

 Click on the “Polygon” button under the Spatial Attributes/Add Zones section. 
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 Left-click at the start point of the polygon and at intermediate points of the polygon 

shape, then right-click at the end point of the polygon. To set a closed polygon, 

make sure that the end and start points of the polygon are at a distance smaller 

than the cell size. 

 If the first and last points of a polygon are created in the same cell, the polygon will 

automatically be closed. 

 

Variable polygon zone is used to digitize open polygons where the data will linearly vary from one 

point to the next, along the lines. This option is only available for open polygons. To add a Variable 

polygon zone:  

 
 Select the appropriate model data in the first three drop-down list under the Spatial 

Attributes section. 

 Choose zone in the Type drop-down list under the Spatial Attributes section. 

 Click on the “Variable polygon” button under the Spatial Attributes/Add Zones 

section. 

 Left-click at the start point of the polygon and at intermediate points of the polygon 

shape.  

 At each point a Value window will appear that asks the value for the point that has 

just been created. 

 Right-click at the end point of the variable polygon. Do not close a variable 

polygon, it will not work as variable if it closed. 

 Explanations regarding the transient value zones are provided at the end of this 

paragraph. 

For packages with multiple values, the parameter which varies over space is: 

 DRN [drain]: the elevation. 

 RIV [river]: the stage. 

 GHB [general-head boundary]: the elevation. 
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Once the grid cells have been selected using one of the Add Zones options described previously, a 

Zone window will appear as shown in the following figure. In this window set: 

 

 The name of the zone in the Zone name box. 

 The media(s) to assign the zone in the Zone media box. Set a single value corresponding to 

the media number to assign the zone in one media. Set two numbers separated by a dash 6 

(0-2 for instance), if the zone spans several media. This option is only available for 3D model.  

 Zone coordinates to modify zone location in the Zone coords box. They can also be copied 

and pasted to create new zone at the same location. This is useful for the situation where you 

have to set a boundary condition and a value specified at the same location for example.  

 The temporal scheme of the considered data (i.e., Steady or Transient in the Temporal drop-

down list). 

 The value of the data to assign at the zone in the Zone value box.  

‒ Set a single value to specify a constant value zone.  

‒ To specify transient value zone:  

 Set Transient in the Temporal drop-down list.  

 Two columns will appear in the zone value box. 

 Set in the first column the starting time and in the second column the value at 

that time. Starting times may be different than the model output times. 

‒ For variable polygon, the values are specified in the Z column of the Zone cords box. 

Set a value of 0 in the Zone value box. 
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Note that the values to be specified in the Zone value box are different for “Initial chemistry” 

data in PHT3D. For descriptions of this data entry options, refer to the sections “Initial 

chemistry” on page 94.  

For some packages (e.g., DRN [drain], RIV [river], GHB [general-head boundary]) several values 

have to be provided. For these packages, a table will appear on the top right of the dialog, the 

user shall enter value in that table.  

Transient value zone specificity 

For packages with multiple values, transient values should be provided in the table at the bottom 

right of the dialog box. The parameter which varies over time is: 

 DRN [drain]: the elevation. 

 RIV [river]: the stage. 

 GHB [general-head boundary]: the elevation. 

 

For variable polygon zone transient values provided in the table at the bottom right of the dialog 

box will be summed to the values specified in the Z column of the Zone cords box. 

 

Boundary zones in MODFLOW_USG.  

Although the zones in MODFLOW_USG are built exactly built in the same way as for all models, the 

user shall be careful when building the zones that are close to the model limits in case of using Voronoi 

cells. Indeed ORTI3D will use these zones to identify the cells that are below the zone line to allocate 

them a boundary value. The user must be careful because the Voronoi cells are selected if the zone 

line intersect them. Therefore it is advised to locate the zone close to the domain limit in order to have 

only one cell selected. The best option is to set the zone and then use the view button to see the 

potential result for the model input.  

4.2.3 Editing Zone 

Data zones can be viewing, editing or delete using one of the options available under the Spatial 

Attributes/Modify Zones section.  

To viewing and editing the data values and settings: 

 Select the appropriate model data in the first three drop-down list under the Spatial 

Attributes section. 

 Select the zone to view or modify in the drop-down list under the Spatial Attributes/Modify 

Zones section.  

 Click on the “Val:” button under the Spatial Attributes/Modify Zones section. 
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 The Zone window will appear. The functionality and settings for zone is explained in “Creating 

zone” on page 28. 

To modify zone location:  

 
 Select the zone to modify in the drop-down list under the Spatial 

Attributes/Modify Zones section.  

 Click on the “Move zone” button under the Spatial Attributes/Modify Zones 

section. 

 Left-click on the red point and hold the mouse button down to move the zone to 

the desired location. 

 

To modify zone shape:  

 
 Select the zone to modify in the drop-down list under the Spatial 

Attributes/Modify Zones section.  

 Click on the “Modify polygon” button under the Spatial Attributes/Modify 

Zones section. 

 Left-click on the red points and holds the mouse button down to modify the point 

location. 

 To insert a new point: Left-click on a red point and press “i” on the keyboard. 

 To delete a point: Left-click on the point to delete and press “d” on the keyboard. 

 Right-click to end editing.  

 

To delete zone:  

 
 Select the zone to delete in the drop-down list under the Spatial 

Attributes/Modify Zones section.  

 Click on the “Delete zone” button under the Spatial Attributes/Modify Zones 

section. Note that NO UNDO option is available. 

 

To delete all zones:  

 
 Select one zone in the drop-down list under the Spatial Attributes/Modify Zones 

section.  
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 Click on the “Delete all zones” button under the Spatial Attributes/Modify Zones 

section. Note that NO UNDO option is available. 

4.2.4 Import Input Data Zone Files 

ORTI3D has an import option to import point zone. The data file formats currently supported by 

ORTI3D for importing model data are ASCII text files (.TXT). The file must contain the Name, Value, 

Media and Coordinates of the zone. This information has to be provided on one line for each point, 

as follows (in bold the keywords that must contain the file, followed by the information provided by 

the modeler): 

Name zone1  Value 0 Media 0 coord X Y 

 

To import data zone files: 

 Select the appropriate model data in the first three drop-down list under the Spatial 

Attributes section. 

 Choose importZones in the Type drop-down list under the Spatial Attributes section. 

 Navigate to the directory where the data zone file is located.  

 Select the file and then click the “Open” button. 

Note that to see the imported point zones in the drop-down list under the Spatial 

Attributes/Modify Zones section it is necessary to reselect the model data where zones have been 

imported. After this operation, make sure that the type is set to zone (and not importZones) in the 

Type drop-down list under the Spatial Attributes section. 

4.2.5 Interpolation Module 

ORTI3D allows interpolating model data values from discrete data points using a selection of two 

popular data interpolation schemes: 

 Inverse distance from a built-in module. 

 Thiessen polygon from a built-in module. 

 Kriging from the PyKrige module. 

The interpolate wizard involves the following two steps: 

 Step 1: Create or import point zones.  

 Step 2: Choose interpolation options. 
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Step 1 is describe in detail in “Creating zone” on page 28 if you want create manually discrete data 

points or in “Import input data zone files” on page 34 if you desire import a set of data points from 

files.  

To select your interpolation options preference (Step 2): 

 Select the appropriate model data in the first three drop-down list under the Spatial 

Attributes section. 

 Select the appropriate model media in the Media drop-down list under the Spatial 

Attributes section. 

 Choose interpolate in the Type drop-down list under the Spatial Attributes section. 

 An interpolation window will appear. 

 Select the interpolation method under the Interpolation method drop-down list. 

 Set up your interpolation options preference under the section Interpolation parameters. 

 To display the interpolation results click the “Show result” button.  

 Click the “Ok” button. 
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To save the result of the interpolation, two options are implemented: 

1. Recalculate each time files are written: the interpolation will be recalculate at each model run 

with the selected interpolation method and parameters. This option could be useful when using 

PEST to adjusting model parameter. To choose this option: 

 Select Recalculate each time files are written under the “Save options” drop-down list. 

 Click the “Save” button. 

2. Save results as array: the interpolation result will be saved under an ASCII text files (.gvar) (see 

above the format). The import array option will be used thereafter to define the distributed 

model data of the selected model parameter. To choose this option: 

 Select Save results as array under the “Save options” drop-down list. 

 Click the “Save” button. 

 A Save to array window will appear. 

 Navigate to the directory where you want save the model property data file. 

 Click the “Save” button. 

 The type of data will be automatically set to importArray in the Type drop-down list under 

the Spatial Attributes section. 

To display the interpolation results in the model display area:  

 Check the View box on the right of the Type drop-down list under the Spatial Attributes 

section. 

4.2.6 Formula 

4.2.6.1 General Use 

ORTI3D has a formula option to calculate the value of one parameter over the grid with Python 

functions. All Python function may be used to perform any type of calculation. This can be used, for 

instance, to generate randomly distributed data, interpolate data, or to create a tilt in the geometry. 

The formula given by the last line of the formula value = ‘ ’ will be used by ORTI3D to calculate the 

parameter value at each grid cell. Consequently, make sure that the result has the same shape than 

the grid shape:  

number of layers x number of rows x number of columns 

To set formula: 

 Select the appropriate model data in the first three drop-down list under the Spatial 

Attributes section. 

 Choose formula in the Type drop-down list under the Spatial Attributes section. 
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 An input Python formula window will appear. 

 Set up the line value = ‘ ’ to define the parameter value at each grid cell. 

 Click the “Ok” button. 

For example, in the following figure, the model dimension is 2 layers, 25 rows and 20 columns. A 

random value between 0 and 10 will be applied in each grid cells of the top layer and a random 

value between 0 and 5 will be applied in each grid cells of the bottom layer for the parameter. 

 

 

4.2.6.2 Specificity for Grid Model Design 

The shape of the result (value = ‘ ’) of formula use to define the top elevation of each layers and the 

bottom elevation of the last layer is: 

number of layers +1 × number of rows × number of columns 

4.2.7 Importing file of distributed model data 

ORTi3D has an import option to import model distributed property values (Boundary condition, 

Conductivities, Storage, Initial Heads, Initial Concentrations, Dispersion…). This feature does not work 

for distributed property with transient values as: Well, Drain, River… 

The data file formats currently supported by Visual MODFLOW for importing model property data 

include: 

For uniform distributed data: 

 ASCII text files (.txt, .dat): rows x columns array of values with row write on one line 
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 ESRI grid files (.asc) 

For non-uniform distributed data: 

 ASCII text files (.gvar) with: 

o At the first row y direction: -1 if the origin of the array is on the top corner left and 1 

is the origin of the array is on the bottom left corner 

o At the second row DELR: the cell width along rows 

o At the third row DELC: the cell width along columns 

o Following by rows x columns array of values (row may be write on several lines) 

An array of distributed model data has to be imported for each model media. The data files have to 

be located in the model folder. The paths of the input files are kept in the ORTi3D model file, so 

when opening a model they will be read form these files.  

When the model grid spacing does not correspond to the grid dimension of the distribution array, a 

bivariate interpolation scheme is used to calculate the property value for each model grid cell.  

To import an array of distributed data: 

 Select the appropriate model data in the first three drop-down list under the Spatial 

Attributes section. 

 Select the appropriate model media in the Media drop-down list under the Spatial 

Attributes section. 

 Choose importArray in the Type drop-down list under the Spatial Attributes section. 

 A Choose Array window will appear. 

 Indicates the name (with full path) of the model property data file being imported. Use the 

Browse button to navigate to the directory where the file of distributed model data is 

located. 

 Select the file and then click the “Open” button. 

 Click the “OK” button.  

To display the distributed model data imported in the model display area:  

 Check the View box on the right of the Type drop-down list under the Spatial Attributes 

section. 

4.2.8 Contouring Input Data 

The ability to display color maps of the model data values assigned to each grid cell is particularly 

useful when distributed model data have been interpolated to the model grid, or when many zones 

of data are used.  
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To display model data values assigned: 

 Select the model data to display in the first three drop-down list under the Spatial Attributes 

section. 

 For 3D model, select the appropriate media in the Media drop-down list under the Spatial 

Attributes section. 

 Check the View box located just after the Type drop-down list under the Spatial Attributes 

section. 

 To remove the color map, uncheck the box.  

4.3 MODFLOW and MODFLOW USG Input Data 

4.3.1 This section is about MODFLOW and MODFLOW USG. When the 

operation of MODFLOW and MODFLOW USG differs then this is 

specified. Otherwise, the term MODFLOW designates both 

codes.Import MODFLOW Packages 

In ORTI3D the MODFLOW package available are the following: 

 Process packages 

‒ BAS6 – Basic package 

‒ DIS – Discretization package for MODFLOW 

‒ DISU – Discretization package for MODFLOW USG 

 Groundwater flow packages 

‒ LPF – Layer-property flow package 

‒ HFB6 – Horizontal flow barrier package 

‒ UPW – Upstream weighting package 

‒ UZF – Unsaturated zone flow package 

 Specified-head boundaries packages 

‒ CHD – Time-variant specified-head package 

 Specified flux boundaries packages 

‒ RCH – Recharge package 

‒ WEL – Well package 

 Head-dependent flux boundary packages 

‒ DRN – Drain package 

‒ EVT – Evapotranspiration package 

‒ GHB – General-head boundary package 

‒ MNW2 – Multinode well package 

‒ RIV – River package 

 Solver packages 
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‒ DE4 – Direct solver package for MODFLOW 

‒ PCG – Preconditioned conjugate-gradient package for MODFLOW 

‒ SIP – Strongly implicit procedure package for MODFLOW 

‒ SOR – Slice-successive overrelaxation package for MODFLOW 

‒ NWT – Newton solver package for MODFLOW 

‒ SMS – Sparse matrix solver package for MODFLOW USG 

The packages included by default in ORTI3D when you created a new model project are: DIS, BAS6, 

LPF, WEL and PCG for MODFLOW and DISU, BAS6, LPF, WEL and SMS for MODFLOW USG. 

To include different packages: 

 Selecting Add-In/MODFLOW_modules from the Main menu section. 

 A Select Modules window will appear. 

 Check the box corresponding of the packages that you want to use. 

 Uncheck the box corresponding of the packages that you do not want to use.  

 Click the “Ok” button. 

4.3.2 MODFLOW Model Properties 

4.3.2.1 Top and Bottom Elevation 

2D And 3D Model 

In ORTI3D, you can set the top of each media of your model and the bottom of the last media. 

These parameters may be defined as distributed property values (for more details see “Tools for 

assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate top and bottom elevation of media from point zone values (imported or set 

manually). 

For 3D models, top and bottom elevations of each media are automatically set from information 

provide in the “3D” button under the Parameter/1.Model section (for more details, see 

Section 4.1.5). If you desire non-uniform top and bottom elevation of media, you can design media 

thickness from the command presented as follows.  

For 2D horizontal models, you have to set top and bottom elevations of your model from the 

command presented as follows. 



 

ORTi3D User’s Manual – v2.1 41 September 2021 

To assign top elevation values of model media(s): 

 Choose MODFLOW – DIS – dis.6 Top for MODFLOW or MODFLOW – DISU – dis.7 Top for 

MODFLOW USG in the first three drop-down list under the Spatial Attributes section. 

 For 3D model, select the media in the Media drop-down list under the Spatial Attributes 

section or in the Zone media box of zone window. 

 Set the top elevation values with the desired tool for assigning and editing distributed input 

data. 

To assign bottom elevation values of model media: 

 Choose Modflow – DIS – dis.7 Bottom for MODFLOW or MODFLOW – DISU – dis.8 

Bottom for MODFLOW USG in the first three drop-down list under the Spatial Attributes 

section. 

 For 3D model, select the last media in the Media drop-down list under the Spatial 

Attributes section or in the Zone media box of zone window. 

 Set the bottom elevation values with the desired tool for assigning and editing distributed 

input data. 

Cross Section and Radial Model 

For cross section and radial models, top and bottom elevations of each media are automatically 

set from information provide in the “Grid” button under the Parameter/1.Model section (for more 

details see “Model domain and Grid design” on page 21). 

Information about the DIS package can be found in the MODFLOW-2000 user guide on page 45, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the DISU package can be found in the MODFLOW-USG user guide on page 17, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.2.2 Hydraulic Conductivity 

By default, the LPF package is used in ORTI3D to inform flow layer properties. The conductivity 

parameter values of the model are as follows: 

 Horizontal conductivity in the direction of the model x axis. 

 Horizontal Anisotropy (i.e., the ratio of hydraulic conductivity in the direction of the model y 

axis to hydraulic conductivity in the direction of the model x axis). 

 Vertical conductivity in the direction of the model z axis or ratio K (ratio of horizontal to 

vertical hydraulic conductivity). 
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Horizontal conductivity and vertical conductivity parameters may be defined as distributed 

property values (for more details see “Tools for assigning and editing distributed input data” on 

page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate conductivity of media from point zone values (imported or set manually). 

Horizontal Conductivity 

To assign horizontal conductivity values: 

 Choose MODFLOW – LPF – lpf.8 Hydraulic conductivity in the first three drop-down list 

under the Spatial Attributes section. 

 Set the horizontal conductivity values with the desired tool for assigning and editing 

distributed input data. 

Vertical Conductivity or Ratio K 

In ORTI3D, there are two options for defining the vertical conductivity of the conductivity property 

zone: 

 Vertical conductivity in the direction of the model z axis.  

 Ratio K (ratio of horizontal to vertical hydraulic conductivity). 

To set the vertical conductivity option: 

 
 Click on the “Parameter” button under the Parameter/2.Flow section. 

 Choose LPF in the first drop-down list.  

 Choose LPF.5- flag for vertical cond in the second drop-down list.  

 Set the desired option in the third drop-down list.  

 Click the “Apply” button. 

 

To assign vertical conductivity or ratio K values: 

 Choose MODFLOW – LPF – lpf.9 Vertical cond. or ratio Kh/Kv in the first three drop-down 

list under the Spatial Attributes section. 

 Set the vertical conductivity or ratio K values with the desired tool for assigning and editing 

distributed input data. 
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Anisotropy 

By default, in ORTI3D, the horizontal anisotropy is set as value for the entire layer and cannot be 

managed as distributed data at this time.  

To assign anisotropy value for the entire layer and for all layers of 3D models: 

 
 Click on the “Parameter” button under the Parameter/2.Flow section. 

 Choose LPF in the first drop-down list.  

 Choose LPF.4- Horizontal anisotropy in the second drop-down list.  

 Click the “Media” button. A lpf.4 window will appear. 

 Set the anisotropy value for each media in the box. The value MUST be greater 

than 0.  

 Click the “Apply” button. 

 

Information about the LPF package can be found in the MODFLOW-2000 user guide on page 59, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the LPF package can be found in the MODFLOW-USG user guide on page 32, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.2.3 Storage 

By default, the LPF package is used in ORTI3D to inform flow layer properties. The storage parameter 

values of the model are as follows: 

 Specific storage 

 Specific yield 

For transient flow simulations, MODFLOW requires dimensionless storage terms specified for each 

layer of the model. These parameters are read only for a transient simulation (at least one transient 

stress period). 

In a confined layer, the storage term is given by the confined storage coefficient (specific storage [L-

1] × layer thickness [L]). The specific storage is defined as the volume of water that a unit column of 

aquifer releases from storage under a unit decline in hydraulic head. The confined storage coefficient 

is required if the layer type is confined (for more details, see Section 5.1.4). 

In an unconfined layer, the storage term is given by specific yield. Specific yield is defined as the 

volume of water that an unconfined aquifer releases from storage per unit surface area of aquifer per 

unit decline in the water table. Specific yield is required if the layer type is convertible (for more 

details, see Section 5.1.4). 
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Specific storage and specific yield parameters may be defined as distributed property values (for 

more details see “Tools for assigning and editing distributed input data” on page 28): 

 Set background values. 

 Set zones of value. 

 Import point zone values. 

 Interpolate specific storage or specific yield of media from point zone values (imported or set 

manually). 

To assign specific storage values: 

 Choose MODFLOW – LPF – lpf.10 First storage coeff in the first three drop-down list under 

the Spatial Attributes section. 

 Set the specific storage values with the desired tool for assigning and editing distributed 

input data. 

To assign specific yield values: 

 Choose MODFLOW – LPF – lpf.11 2nd storage coeff in the first three drop-down list under 

the Spatial Attributes section. 

 Set the specific yield values with the desired tool for assigning and editing distributed input 

data. 

Information about the LPF package can be found in the MODFLOW-2000 user guide on page 59, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the LPF package can be found in the MODFLOW-USG user guide on page 32, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.2.4 Horizontal Flow Barrier Package 

The horizontal flow barrier (HFB) is used to simulate thin, vertical, low-permeability barriers 

that impede the horizontal flow of groundwater such as sheet pile walls, slurry trenches, or other 

objects that act as a barrier to flow. 

Barriers are simulated as a series of HFBs located on the boundary between two adjacent finite-

difference cells in the same layer. Barrier width is not explicitly considered but is represented as 

hydraulic characteristic defined as barrier hydraulic conductivity divided by barrier thickness. 
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The HFB package is not included by default in ORTI3D. Therefore, to assign horizon barrier condition 

to the groundwater system, enable HFB package (for more details see “Import MODFLOW packages” 

on page 39). 

HFB may be defined on distributed property values: 

 Set “line” or “polyline” zones of value. ORTi3D automatically calculated the appropriate cell 

faces (black line) based on the intersection point of the polyline (blue line). 

 

 

To assign an HFB in the model: 

 Choose MODFLOW – HBF6 – hbf.3 Hydraulic Characteristic Kh/e in the first three drop-

down list under the Spatial Attributes section. 

 Assign HFB with the desired tool for assigning and editing distributed input data. 

 A Zone window will appear.  

 Set the hydraulic characteristic to assign at the zone in the Zone value box. 
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Information about the HFB package can be found in the MODFLOW-2000 user guide on page 63, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the HFB package can be found in the MODFLOW-USG user guide on page 48, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.2.5 Upstream Weighting Package (UPW) 

The upstream weighting package is used to specify properties controlling flow between cells in 

MODFLOW-NWT (for more details see “Newton solver (NWT)” on page 111). When MODFLOW-

NWT is selected as the flow engine, the UPW property has to be selected instead of the LPF 

property package.  

In ORTI3D, enable UPW and NWT packages and disable LPF and PCG packages (for more details 

see “Import MODFLOW packages” on page 39). 

Input data types and formats for the UPW package are nearly identical to those for the LPF package 

(for more details see “Conductivity” and “Storage” on page 41 and 43).  

However, the re-wetting option is not present in the UPW package because all layers that are 

specified as convertible are assumed to be wettable in the UPW Package (for more details see “Re-

wetting Settings” on page 104). 

The variable IPHDRY is new to the UPW Package. IPHDRY is a flag that indicates whether 

groundwater head will be set to HDRY (predefined heads for dry cells) when the groundwater head 

is less than 1×10-4 above the cell bottom.  

To set if predefined heads are applied for dry cells: 

 
 Click on the “Parameter” button under the Parameter/2.Flow section. 

 Choose UPW in the first drop-down list.  

 Choose upw.1- General flags in the second drop-down list.  

 Set the IPHDRY flag in the IPHDRY drop-down list.  

 Click the “Apply” button. 

 

Information about the UPW package can be found in the MODFLOW-NWT report, located in the 

Doc folder of your ORTI3D installation folder. 

4.3.2.6 Unsaturated Zone  

In ORTI3D, the unsaturated zone option is available when MODFLOW-NWT (for more details see 

“Newton solver (NWT)” on page 111) is the selected flow engine for the model. 
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To perform an unsaturated flow model, enable UZF and NWT packages and disable PCG package 

(for more details see “Import MODFLOW packages” on page 39). When the UZF package is used, the 

RCH, EVT, and ETS packages are not normally used or at least not used in the same locations 

because the UZF simulates recharge and evapotranspiration. 

The UZF package is intended to provide an efficient means of simulating recharge of groundwater in 

MODFLOW that considers the effects of flow, evapotranspiration, and storage in the unsaturated 

zone. It is also intended to be used for coupling MODFLOW to precipitation-runoff models. An 

approximation to Richards’ equation is solved to simulate vertical unsaturated flow. The approach 

assumes that unsaturated flow occurs in response to gravity potential gradients only and assumes 

uniform hydraulic properties in the unsaturated zone for each vertical column of model cells. The 

Brooks-Corey function is used to define the relation between unsaturated hydraulic conductivity 

versus water phase saturation.  

In order to solve the variably saturated flow problem using the UZF package it is necessary to specify 

initial and saturated water contents, saturated vertical hydraulic conductivity, and an exponent in the 

Brooks-Corey function. Residual water saturation is calculated internally by the UZF package on the 

basis of the difference between saturated water content and specific yield. 

When the option to use vertical hydraulic conductivity in the LPF package is specified, the layer(s) 

that contain cells where unsaturated flow will be simulated must be specified as convertible (for 

more details, see Section 5.1.4). Neither parameter estimation nor solute transport can be simulated 

with the UZF package. 

Information about the UZF package can be found in the MODFLOW-UZF report, located in the Doc 

folder of your ORTI3D installation folder. 

4.3.2.7 Initial Heads 

MODFLOW requires initial hydraulic heads at the beginning of a flow simulation. In a steady-state 

simulation, the initial values are starting values for the iterative equation solvers. An appropriate 

initial value for the starting heads of the simulation can reduce the required run time significantly. 

Initial heads can be set arbitrarily, provided they are higher than the bottom elevation of the cells. 

Initial hydraulic heads at constant-head cells will be kept constant during the flow simulation (for 

more details see “Constant specified-head boundary conditions” on page 49). The initial hydraulic 

heads in constant-head cells must be higher than the elevation of the bottom of these cells, because 

MODFLOW does not convert dry constant-head cells to inactive cells. Note that the heads at the 

prescribed head cells must be the actual model values.  
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Initial heads parameter may be defined on distributed property values (for more details see “Tools 

for assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate initial heads of media from point zone values (imported or set manually). 

To assign initial heads values: 

 Choose MODFLOW – BAS6 – bas.5 Initial and fixed head in the first three drop-down list 

under the Spatial Attributes section. 

 Set the initial heads values with the desired tool for assigning and editing distributed input 

data. 

Information about the BAS6 package can be found in the MODFLOW-2000 user guide on page 50, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the BAS6 package can be found in the MODFLOW-USG user guide on page 6, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.3 MODFLOW Boundary Conditions  

4.3.3.1 Boundary Conditions (BAS6) 

A boundary conditions array is required by flow models. The boundary conditions array contains a 

code for each model cell that indicates whether:  

 The hydraulic head is computed (active cell).  

 The hydraulic head is kept fixed at a given value (constant-head cell).  

 No flow takes place within the cell (inactive cell).  

It is suggested to use 1 for an active cell, -1 for a constant-head cell, and 0 for an inactive cell. For 

constant-head cells, the initial hydraulic head remains the same throughout the simulation.  

Boundary conditions may be defined as distributed property values (for more details see “Tools for 

assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 
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To assign boundary conditions at model cells: 

 Choose MODFLOW – BAS6 – bas.3 Boundary conditions in the first three drop-down list 

under the Spatial Attributes section. 

 Assign boundary conditions values with the desired tool for assigning and editing 

distributed input data. 

Information about the BAS6 package can be found in the MODFLOW-2000 user guide on page 50, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the BAS6 package can be found in the MODFLOW-USG user guide on page 6, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.3.2 Constant Specified-Head Boundary Conditions 

The constant specified-head boundary condition is used to fix the head value in selected grid cells 

regardless of the system conditions in the surrounding grid cells, thus a specified-head boundary 

provides inexhaustible source or sink of water. In some situations, constant specified-head 

boundary condition may be unrealistic and may lead to unrealistic predictions, particularly when 

used in locations close to the area of interest. 

Constant specified-head values may be defined as distributed property values (for more details see 

“Tools for assigning and editing distributed input data” on page 28): 

 Set zones of value. 

 Import point zone values. 

 Interpolate constant concentration of media from point zone values (imported or set 

manually). 

Constant specified-head values must be assigned in constant-head boundary condition cells 

(i.e., cells with a value of -1 [for more details see “Boundary conditions (BAS6)” on page 48]). 

In ORTI3D, to fix the constant specified-head value in selected grid cells: 

 Choose MODFLOW – BAS6 – bas.5 Initial and fixed head in the first three drop-down list 

under the Spatial Attributes section. 

 Assign constant specified-head value with the desired tool for assigning and editing 

distributed input data. 

 If a zone tool is used, a Zone window will appear.  

 Select Steady in the Temporal drop-down list. 

 Set the constant specified-head value to assign at the zone in the Zone value box. 
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In ORTI3D, when the temporal scheme is set to Steady in zones assigned at the bas.5 Initial and 

fixed head section, constant specified-head values are written in the .BAS6 file. 

Information about the BAS6 package can be found in the MODFLOW-2000 user guide on page 50, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the BAS6 package can be found in the MODFLOW-USG user guide on page 6, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.3.3 Time-Variant Specified-Head Boundary Conditions (CHD) 

For transient simulations, the time-variant specified-head package allows the specified heads to be 

linearly interpolated in time between the beginning and end of each stress period. Thus, constant-

head cells take different head values for each time step. 

Time-variant specified-head values may be defined as zone property values (for more details see 

“Tools for assigning and editing distributed input data” on page 28): 

 Set zones of value. 

In ORTI3D, to set the time-variant specified-head value in selected grid cells: 

 Choose MODFLOW – BAS6 – bas.5 Initial and fixed head in the first three drop-down list 

under the Spatial Attributes section. 

 Assign time-variant specified-head condition with the desired tool for assigning and editing 

distributed input data. 

 A Zone window will appear.  

 Select Transient in the Temporal drop-down list. Two columns will appear in the zone value 

box. 

 Set in the first column the starting time and in the second column the specified-head value 

at that time at that time. Note that in ORTI3D, time interval can be set independently of the 

model output time.  

In ORTI3D, when the temporal scheme is set to Transient in zones assigned at the bas.5 Initial and 

fixed head section, the time-variant specified-head values are written in the .CHD file. In this case 

the time-variant specified-head package changes automatically the boundary flag value assigned 

in the bas.3 Boundary conditions section. 

Information about the CHD package can be found in the MODFLOW-2000 user guide on page 78, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the CHD package can be found in the MODFLOW-USG user guide on page 11, 

located in the Doc folder of your ORTI3D installation folder. 
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4.3.3.4 Well Boundary Conditions 

In MODFLOW, an injection or a pumping well is represented by a model cell. Therefore, a pumping 

well located in the corner of a grid cell will produce identical results compared to a pumping well 

located in the exact center of the same grid cell. Negative cell values are used to indicate pumping 

wells, while positive cell values indicate injection wells. 

The injection or pumping rate of a well is constant during a given stress period and is independent of 

both the cell area and the head in the cell. It is implicitly assumed by MODFLOW that a well screened 

through the entire thickness of the grid cell.  

MODFLOW can simulate wells that penetrate more than one model medium. In this case, in ORTI3D, 

the media where the well extends and the total injection or pumping rate have to be specified. The 

individual layer injection or pumping rate for a multilayer well is calculated, in ORTI3D, by dividing 

the total rate in proportion to the layer transmissivities.  

Well condition may be defined as zone property values (for more details see “Tools for assigning 

and editing distributed input data” on page 28): 

 Set zones of value. 

 Import point zone values. 

In ORTI3D, when a well is assigned to more than one cell in horizontal or vertical direction (with line, 

rectangle or polygon zone tool), the individual cell injection or pumping rate is equal to the total 

injection or pumping rate divided by the number of cells. ORTI3D maintains the X and Y coordinates 

independent of the model grid. Therefore, if the grid is modified, the original pumping well location 

is not affected. 

To assign an injection or pumping well in the model: 

 Choose MODFLOW – WEL – wel.1 zones for Wells in the first three drop-down list under 

the Spatial Attributes section. 

 Assign well condition with the desired tool for assigning and editing distributed input data. 

Information about the WEL package can be found in the MODFLOW-2000 user guide on page 69, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the WEL package can be found in the MODFLOW-USG user guide on page 52, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.3.5 Recharge Boundary Conditions (RCH) 

The recharge package is designed to simulate a specified flux distributed over the top of the 

groundwater system and specified in units of length/time. Most of the time, recharge comes from 
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precipitation percolating into the groundwater system. In addition, the recharge package can be 

used to simulate recharge from other water sources (such as irrigation, artificial recharge or pond 

infiltration). 

By default, ORTI3D will set the recharge to be applied to the uppermost active (wet) layer of the 

model for each vertical column of grid cell. However, ORTI3D allows the user to specify that the 

recharge be applied only to the top grid layer (for more details see “Recharge settings” on page 105).  

The RCH package is not included by default in ORTI3D. Therefore, to assign recharge to the 

groundwater system, enable RCH package (for more details see “Import MODFLOW packages” on 

page 39). 

Recharge condition may be defined on distributed property values (for more details see “Tools for 

assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate recharge of media from point zone values (imported or set manually). 

To assign a recharge boundary condition in the model: 

 Choose MODFLOW – RCH – rch.2 Recharge value in the first three drop-down list under the 

Spatial Attributes section. 

 Assign recharge condition with the desired tool for assigning and editing distributed input 

data. 

Information about the RCH package can be found in the MODFLOW-2000 user guide on page 67, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the RCH package can be found in the MODFLOW-USG user guide on page 40, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.3.6 Evapotranspiration Boundary Conditions (EVT) 

The evapotranspiration (ET) package simulates the effects of plant transpiration, direct evaporation, 

and seepage at the ground surface in removing water from the saturated groundwater regime. The 

EVT package requires the following data: 

 Maximum ET Rate [LT-1]: the maximum evapotranspiration loss.  

 Elevation of the ET surface [L]: is the water table elevation at which this maximum value of 

evapotranspiration loss occurs. 

 Extinction Depth [L]: is the depth below the top of cell elevation where the 

evapotranspiration rate is negligible. 
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 Layer indicator: By default, ORTI3D will set the ET to be applied to the uppermost active 

(wet) layer of the model for each vertical column of grid cell. However, ORTI3D allows the user 

to specify that the evapotranspiration be applied only to the top grid layer (for more details 

see “Evapotranspiration settings” on page 106).  

For each horizontal cell location and for each stress period the ET package reads values of the 

maximum evapotranspiration loss. Likewise, values of the ET surface elevation or water table 

elevation at which evapotranspiration is maximum and the extinction depth are read for each 

horizontal cell location for each stress period. The EVT Package is based on the following 

assumptions: 

1. When the water table is at or above the elevation of the ET surface, evapotranspiration loss from 

the water table occurs at the maximum ET rate. 

2. No evapotranspiration occurs when the depth of the water table is below the elevation of the ET 

surface and exceeds the ET extinction depth.  

3. In between these limits, evapotranspiration varies linearly with the water table elevation. 

The EVT package is not included by default in ORTI3D. Therefore, to assign evapotranspiration to the 

groundwater system, enable EVT package (for more details see “Import MODFLOW packages” on 

page 39). 

Evapotranspiration condition may be defined on distributed property values (for more details see 

“Tools for assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate evapotranspiration of media from point zone values (imported or set manually). 

To set the Elevation of the ET surface in the model: 

 Choose MODFLOW – EVT – evt.2 Evapo. ref. surface in the first three drop-down list under 

the Spatial Attributes section. 

 Assign the Elevation of the ET surface condition with the desired tool for assigning and 

editing distributed input data. 

To set the Maximum ET Rate in the model: 

 Choose MODFLOW – EVT – evt.3 Evapotransp value in the first three drop-down list under 

the Spatial Attributes section. 

 Assign the Maximum ET Rate with the desired tool for assigning and editing distributed 

input data. 
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To set the Extinction Depth in the model: 

 Choose MODFLOW – EVT – evt.4 Evapo depth in the first three drop-down list under the 

Spatial Attributes section. 

 Assign the Extinction Depth with the desired tool for assigning and editing distributed input 

data. 

Information about the EVT package can be found in the MODFLOW-2000 user guide on page 73, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the EVT package can be found in the MODFLOW-USG user guide on page 44, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.3.7 Drain Boundary Conditions (DRN) 

The drain package simulates the effects of features such as agricultural drains, which remove water 

from the aquifer. Drains are defined by assign two types of values to model cells: 

 Drain hydraulic conductance [L2T-1]: The drain conductance is a lumped conductance 

describing all of the head loss between the drain and the groundwater system. This loss is 

caused by the characteristics of the convergent flow pattern toward the drain, as well as on 

the characteristics of the drain itself and its immediate environment. 

 Mean elevation of the drain [L]: The drain head of the free surface of water within the drain. 

The drain runs only partially full, so that the head within the drain is approximately equal to 

the average elevation of the drain. 

Drain serve to simulate water removed from the aquifer at a rate proportional to the difference 

between the head in the aquifer and the mean elevation of the drain, so long as the head in the 

aquifer is above that elevation. If, however, the water table elevation falls below the drain elevation, 

then the drain has no effect on the aquifer.  

The drain hydraulic conductance represents the constant of proportionality. In most situations a 

specific formulation of drain conductance would require detailed information that is not usually 

available. These details include the detailed head distribution around the drain, aquifer hydraulic 

conductivity near the drain, distribution of the fill material, hydraulic conductivity of fill material, 

number and size of the drain pipe openings, the amount of clogging materials, and the hydraulic 

conductivity of the clogging materials. In practice, drain conductance is usually adjusted during 

model calibration. 

The DRN package is not included by default in ORTI3D. Therefore, to assign drain condition to the 

groundwater system, enable DRN package (for more details see “Import MODFLOW packages” on 

page 39). 
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Drain condition may be defined on distributed property values (for more details see “Tools for 

assigning and editing distributed input data” on page 28): 

 Set zones of value. 

To assign a drain condition in the model: 

 Choose MODFLOW – DRN – drn.1 Drains: elevation, conductance in the first three drop-

down list under the Spatial Attributes section. 

 Assign drain condition with the desired tool for assigning and editing distributed input data. 

 A Zone window will appear.  

 To set the drain parameters specify two values in the table on the top right of the window, 

first the mean elevation of the drain followed by the drain hydraulic conductance value.  

In ORTI3D, the mean elevation of the drain and the drain hydraulic conductance cannot be set as 

transient values. The elevation of the drain can be set variable in space by using Variable polygon 

zone tool (for more details see “Tools for assigning and editing distributed input data” on page 28).  

Information about the DRN package can be found in the MODFLOW-2000 user guide on page 71, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the DRN package can be found in the MODFLOW-USG user guide on page 56, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.3.8 River Boundary Conditions (RIV) 

The river package is used to simulate the flow between an aquifer and a surface water feature, such 

as rivers, lakes or reservoirs. Rivers are defined by assign the following three values to the model 

cells: 

 Hydraulic conductance of the riverbed [L2T-1]: The river conductance represents the 

resistance to flow between the surface water feature and the groundwater caused by the 

seepage layer (riverbed). 

 Head in the river (stage) [L]: The free water surface elevation of the surface waterbody. This 

value can be different with time. 

 Elevation of the bottom of the riverbed [L]: The elevation of the bottom of the seepage 

layer (bedding material) of the surface water feature. 

Surface water feature can either contribute water to the groundwater system, or act as groundwater 

discharge zones, depending on the hydraulic gradient between the surface water feature 

and the groundwater system. If the hydraulic head in the aquifer is above the surface water feature 

(HRIV), flow is into the river, represented as a negative inflow to the aquifer. It means that water 
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flows from the aquifer into the river and is removed from the groundwater model. For the case that 

the hydraulic head in the aquifer is lower than HRIV, flow is positive into the aquifer.  

The RIV package is not included by default in ORTI3D. Therefore, to assign river condition to the 

groundwater system, enable RIV package (for more details see “Import MODFLOW packages” on 

page 39). 

River condition may be defined on distributed property values (for more details see “Tools for 

assigning and editing distributed input data” on page 28): 

 Set zones of value. 

To assign a river condition in the model: 

 Choose MODFLOW – RIV – riv.1 River: stage, conduct., Rbot in the first three drop-down 

list under the Spatial Attributes section. 

 Assign river condition with the desired tool for assigning and editing distributed input data. 

 A Zone window will appear.  

 To set the river parameters specify three values in the table on the top right of the window, 

first the head in the river (stage) followed by the hydraulic conductance of the riverbed 

and the elevation of the bottom of the riverbed values.  

In ORTI3D, the head in the river (stage) can be set as transient values and the elevation of the 

bottom of the riverbed can be set variable in space by using Variable polygon zone tool (for more 

details see “Tools for assigning and editing distributed input data” on page 28). 

Information about the RIV package can be found in the MODFLOW-2000 user guide on page 65, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the RIV package can be found in the MODFLOW-USG user guide on page 59, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.3.9 General-Head Boundary Conditions 

The GHB package is used to simulate head-dependent flow boundaries (Cauchy boundary 

conditions). A GHB cell is defined by two cell values: 

 GHB hydraulic conductance [L2T-1]: The GHB hydraulic conductance represents the 

resistance to flow between the boundary head and the model domain. 

 Hydraulic head at the boundary [L]: This is the head at the boundary. This head may be 

physically based, such as a large lake, or may be adjusted during model calibration. 

In the GHB package, the flux at the boundary is always proportional to the difference between the 

head in the cell and the reference head assigned at the boundary. The GHB package provides no 
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limiting value of flow to bind the linear function in either direction. Therefore, as the difference 

between the head in the cell containing the boundary and the source head increases/decreases, flow 

into or out of the cell continues to increase without limit. Accordingly, the GHB package must be 

used with care to ensure that unrealistic flows into or out of the system do not develop during the 

simulation. 

The GHB package is not included by default in ORTI3D. Therefore, to assign general-head boundary 

condition to the groundwater system, enable GHB package (for more details see “Import MODFLOW 

packages” on page 39). 

GHB condition may be defined on distributed property values (for more details see “Tools for 

assigning and editing distributed input data” on page 28): 

 Set zones of value. 

To assign a GHB condition in the model: 

 Choose MODFLOW series – MODFLOW – GHB – ghb.1 General Head: head, conductance 

in the first four drop-down list under the Spatial Attributes section. 

 Assign GHB condition with the desired tool for assigning and editing distributed input data. 

 A Zone window will appear.  

 To set the general-head boundary parameters specify two values in the table on the top 

right of the window, first the hydraulic head at the boundary followed by the GHB 

hydraulic conductance values.  

In ORTI3D, the hydraulic head at the boundary can be set as transient values and can be set 

variable in space by using Variable polygon zone tool (for more details see “Tools for assigning and 

editing distributed input data” on page 28). 

Information about the GHB package can be found in the MODFLOW-2000 user guide on page 76, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the GHB package can be found in the MODFLOW-2000 user guide on page 62, 

located in the Doc folder of your ORTI3D installation folder. 

4.3.4 Particles 

In ORTI3D, a semianalytical particle-tracking scheme (based on Pollock method) is used to calculate 

the groundwater paths and travel times. Particle-tracking is not available for Modflow USG.  

Forward particle-tracking pathlines are used to predict where groundwater is flowing, and how long 

it will take to reach a given location if it starts from a known location at a known time. Backward 
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particle-tracking pathlines are used to predict where groundwater at a given location and time is 

coming from, and how long it took to get there.  

Through the interactive graphical modeling environment of ORTI3D, the user can place particles to 

calculating particle-tracking pathlines from steady-state and transient flow simulation output 

obtained using MODFLOW. Both forward and backward particle tracking are allowed for steady-state 

and transient flow simulations. For transient flow simulations, particles can start from any time step. 

The particle-tracking simulation goes further until all particles leave the model or until the user-

specified time limit is reached. 

To simulate particle trajectories for your flow model: 

 
 Select a time step in the Tstep drop-down list under the Results/1.Model section. 

 Click on the “Particle” button under the Parameter/2.Flow section. 

 A Particle window will appear. Choose forward or backward in the direction drop-

down list and click the “OK” button. 

 Move the mouse cursor to the desired position to your active model area and left-

click.  

 Each time you click on a point, a new particle trajectory is drawn. 

 To end particles, use a right-click on your active model area. 

 

Different options are available to display particle-tracking pathlines, for more details see “Pathline 

maps” on page 135. 

4.4 Mt3dms Input Data 

4.4.1 Importing Mt3dms Packages 

In ORTI3D the MT3DMS package available are the following: 

4.4.1.1 Transport Packages 

 BTN – Basic transport package. 

 SSMs – Sink and source mixing package. 

 ADV – Advection package. 

 DSP – Dispersion package. 

4.4.1.2 Reactive Packages 

 RCT – Chemical reaction package. 
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4.4.1.3 Solver Package 

 GCG – Generalized conjugate-gradient solver package. 

4.4.1.4 Seawat Packages 

 VDF – Variable density flow package. 

 VSC – Viscosity package. 

4.4.1.5 Unsaturated PHT3D Packages 

 UZT – Unsaturated zone transport package. 

The packages included by default in ORTI3D when you created a new model project are: BTN, ADV, 

DSP and GCG. 

To include different packages: 

 Selecting Add-In/Mt3dms_modules from the Main menu section. 

 A Select Modules window will appear. 

 Check the box corresponding of the packages that you want to use. 

 Uncheck the box corresponding of the packages that you do not want to use.  

 Click the “Ok” button. 

4.4.2 Mt3dms Model Properties 

4.4.2.1 Effective Porosity 

Effective porosity is the pore space through which flow actually occurs. In MT3DMS, effective 

porosity is used to calculate the average velocity of the flow through the porous medium.  

Effective porosity parameter may be defined as distributed property values (for more details see 

“Tools for assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate conductivity of media from point zone values (imported or set manually). 

To assign effective porosity values: 

 Choose Mt3dms – BTN – btn.11 Porosity in the first three drop-down list under the Spatial 

Attributes section. 

 Set the effective porosity values with the desired tool for assigning and editing distributed 

input data. 
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Information about the BTN package can be found in the MT3DMS user guide on page 102, located 

in the Doc folder of your ORTI3D installation folder. 

4.4.2.2 Dispersion 

Dispersion in porous media is a process that tends to spread the contaminants over a greater region 

than would be predicted solely from the advective path of the plume. Dispersion is caused by 

mechanical dispersion, a result of deviation of the flowpaths as groundwater travels through the 

interconnected pores of the soil, and by molecular diffusion due to concentration gradients. The 

effects of molecular diffusion are generally negligible compared with mechanical dispersion, and 

only become important when groundwater velocity is very low. Hydrodynamic dispersion is the sum 

of mechanical dispersion and molecular diffusion and is defined by assigning the following 

parameters to the model cells: 

 Longitudinal dispersivity for each transport grid cell [L]. 

 Ratio of horizontal to longitudinal dispersivity for each layer [L]. 

 Ratio of vertical to longitudinal dispersivity for each layer [L]. 

 Molecular diffusion coefficient for each layer [LT-1]. 

These parameters may be defined as distributed property values (for more details see “Tools for 

assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate parameter values of media from point zone values (imported or set manually). 

To assign the longitudinal dispersivity values: 

 Choose Mt3dms – DSP – dsp.2 Longitudinal disp in the first three drop-down list under the 

Spatial Attributes section. 

 Set the longitudinal dispersivity values with the desired tool for assigning and editing 

distributed input data. 

To assign the ratio of horizontal to longitudinal dispersivity values: 

 Choose Mt3dms – DSP – dsp.3 Ration Transv/Long disp in the first three drop-down list 

under the Spatial Attributes section. 

 Set the ratio of horizontal to longitudinal dispersivity values with the desired tool for 

assigning and editing distributed input data. 



 

ORTi3D User’s Manual – v2.1 61 September 2021 

To assign the ratio of vertical to longitudinal dispersivity values: 

 Choose Mt3dms – DSP – dsp.4 Ration Vert/Long disp in the first three drop-down list 

under the Spatial Attributes section. 

 Set the ratio of vertical to longitudinal dispersivity values with the desired tool for 

assigning and editing distributed input data. 

To assign the molecular diffusion coefficient values: 

 Choose Mt3dms – DSP – dsp.5 molecular diffusion coefficient in the first three drop-down 

list under the Spatial Attributes section. 

 Set the molecular diffusion coefficient values with the desired tool for assigning and editing 

distributed input data. 

Information about the DSP package can be found in the MT3DMS user guide on page 118, located 

in the Doc folder of your ORTI3D installation folder. 

4.4.2.3 Chemical Reaction: Sorption (RCT Package) 

Chemical reactions (RCT package) supported by the MT3DMS transport model integrate sorption 

reactions. In ORTI3D, the multiple chemical species option of MT3DMS is not implemented. Only one 

chemical species may be simulated. The multiple chemical species option of the MT3DMS RCT 

package is available through the use of PHT3D (for more details see “Chemical reaction: Multiple 

chemical species (RCT package)” on page 84). To obtain a non-reactive simulation with pht3d input, 

the user can remove the line containing the pht3d_ph.dat file in the pht3d.nam file. The results will 

be available in the chemistry panel even if no reaction happened. 

The RCT package is not included by default in ORTI3D. Therefore, to include chemical reaction in 

transport model, enable RCT package (for more details see “Import MT3DMS packages” on page 58). 

Sorption Methods 

Sorption is implemented in MT3DMS through use of the retardation factor R with four different set 

of sorption methods: 

 Linear isotherm: The retardation factor is independent of the concentration field and is 

calculated only once for each cell in the beginning of the simulation. 

 Freundlich isotherm: The retardation factor is calculated at the beginning of each transport 

step following the Freundlich nonlinear isotherm. 

 Langmuir isotherm: The retardation factor is calculated at the beginning of each transport 

step following the Langmuir nonlinear isotherm. 

 Nonequilibrium sorption: When the local equilibrium assumption is not valid, the sorption 

process is represented through a first-order reversible kinetic reaction. 
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To set the desired sorption method: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose RCT in the first drop-down list.  

 Choose rct.1- major flags in the second drop-down list.  

 Set the sorption method in the ISOTHM: sorption drop-down list.  

‒ Linear isotherm: choose linear. 

‒ Freundlich isotherm: choose freundlich. 

‒ Langmuir isotherm: choose langmuir. 

‒ Nonequilibrium sorption: choose kinetic sorption. 

 Click the “Apply” button. 

 

Sorption Parameters 

The sorption parameters will depend on which sorption method is selected and are presented as 

follows.  

Sorption parameters may be defined as distributed property values (for more details see “Tools for 

assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate sorption parameters of media from point zone values (imported or set manually). 

The bulk density: The soil bulk density is used to calculate the retardation factor for each 

chemical species and for each sorption method. 

To assign the bulk density values: 

 Choose Mt3dms – RCT – rct.2a density in the first three drop-down list under the Spatial 

Attributes section. 

 Set the bulk density values with the desired tool for assigning and editing distributed input 

data. 

The first sorption parameter (SP1): 

 For linear isotherm and nonequilibrium sorption: SP1 is the distribution coefficient [L3M-1]. 

 For Freundlich isotherm: SP1 is the Freundlich equilibrium constant (the unit depends on the 

Freundlich exponent a). 

 For Langmuir isotherm: SP1 is the Langmuir equilibrium constant [L3M-1]. 
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To assign the first sorption parameter values: 

 

 

 

 

 

 Click on the “Spc” button under the Parameter/3.Transport section. A Select 

Species window will appear.  

 Choose Mt3dms in the Type drop-down list.  

 Write Tracer in the Species box. 

 Click the “OK” button. 

 Click on the “RCT” button under the Parameter/3.Transport section. An RCT 

Parameters window will appear.  

 Set the first sorption parameter (SP1) under the SP1 column. 

 Click the “OK” button. 

 To assign a spatially variable value of the first sorption parameter (SP1): 

‒ Choose Mt3dms – RCT – rct.3 1st sorption parm in the first three drop-

down list under the Spatial Attributes section. 

‒ Set the first sorption parameter values with the desired tool for assigning 

and editing distributed input data. 

‒ The value of the first sorption parameter will be the product of the value 

assigned in the “RCT” button under the Parameter/3.Transport section and 

the spatially variable value. 

 

The second sorption parameter (SP2): 

 For linear isotherm sorption: SP2 is read but not used. 

 For Freundlich isotherm: SP2 is the Freundlich exponent a. 

 For Langmuir isotherm: SP2 is the total concentration of the sorption sites available [MM-1]. 

 For nonequilibrium sorption, SP2 is the first-order mass transfer rate between the dissolved 

and sorbed phases [T-1]. 

To assign the second sorption parameter values: 

 

 

 

 

 

 Click on the “Spc” button under the Parameter/3.Transport section. A Select 

Species window will appear.  

 Choose Mt3dms in the Type drop-down list.  

 Write Tracer in the Species box. 

 Click the “OK” button. 

 Click on the “RCT” button under the Parameter/3.Transport section. An RCT 

Parameters window will appear.  

 Set the second sorption parameter (SP2) under the SP2 column. 

 Click the “OK” button. 
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 To assign a spatially variable value of the second sorption parameter (SP2): 

‒ Choose Mt3dms – RCT – rct.4 2nd sorption parm in the first three drop-

down list under the Spatial Attributes section. 

‒ Set the second sorption parameter values with the desired tool for assigning 

and editing distributed input data. 

‒ The value of the second sorption parameter will be the product of the value 

assigned in the “RCT” button under the Parameter/3.Transport section and 

the spatially variable value. 

 

The initial concentration: Represent the initial concentration for the nonequilibrium sorbed phase 

of all species. By default, the sorbed phase is assumed to be in equilibrium with the dissolved phase.  

To include an initial concentration for the nonequilibrium sorbed phase: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose RCT in the first drop-down list.  

 Choose rct.1- major flags in the second drop-down list.  

 Set given in the IGETSC: initial conc. drop-down list.  

 Click the “Apply” button. 

 

To assign the initial concentration values: 

 Choose Mt3dms – RCT – rct.2c concentrations in the first three drop-down list under the 

Spatial Attributes section. 

 Set the initial concentration values with the desired tool for assigning and editing 

distributed input data. 

Information about the RCT package can be found in the MT3DMS user guide on page 123, located 

in the Doc folder of your ORTI3D installation folder. 

4.4.2.4 Chemical Reaction: Dual-Domain Mass Transfer (RCT Package) 

Chemical reactions (RCT package) supported by the MT3DMS transport model integrate dual-

domain mass transfer simulation. In ORTI3D, the multiple chemical species option of MT3DMS is not 

implemented. Only one chemical species may be simulated. The multiple chemical species option of 

the MT3DMS RCT package is available through the use of PHT3D (for more details see “Chemical 

reaction: Multiple chemical species (RCT package)” on page 84). 
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The RCT package is not included by default in ORTI3D. Therefore, to include chemical reaction in 

transport model, enable RCT package (for more details see “Import MT3DMS packages” on page 58). 

Dual-Domain Mass Transfer Methods 

When porous media is conceptualized as a dual-domain system solute transport is mainly driven by 

advection through the high hydraulic conductivity zones (mobile water) whereas solute transport is 

primarily by diffusion through the low hydraulic conductivity zones (immobile water). Dual-domain 

may be simulated with or without sorption.  

To set the desired dual-domain method: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose RCT in the first drop-down list.  

 Choose rct.1- major flags in the second drop-down list.  

 Set the dual-domain method in the ISOTHM: sorption drop-down list.  

 Click the “Apply” button. 

 

Dual-Domain Mass Transfer Parameters 

The dual-domain parameters will depend if sorption option is selected or not and are presented as 

follows. 

Dual-domain parameters may be defined as distributed property values (for more details see “Tools 

for assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate dual-domain parameters of media from point zone values (imported or set 

manually). 

The bulk density: The soil bulk density is used to calculate the retardation factor for each 

chemical species when sorption is selected. 

To assign the bulk density values: 

 Choose Mt3dms – RCT – rct.2a density in the first three drop-down list under the Spatial 

Attributes section. 

 Set the bulk density values with the desired tool for assigning and editing distributed input 

data. 
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The immobile domain porosity: The porosity of the immobile domain is the ratio of pore spaces 

filled with immobile fluids over the bulk volume of the aquifer medium.  

To assign the immobile domain porosity values: 

 Choose Mt3dms – RCT – rct.2b immobile domain in the first three drop-down list under the 

Spatial Attributes section. 

 Set the immobile domain porosity values with the desired tool for assigning and editing 

distributed input data. 

The immobile initial concentration: Represent the initial concentration of each species for the 

immobile liquid phase. By default, the immobile domain is assumed to have zero concentration.  

To include an immobile initial concentration for a dual-domain transport model: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose RCT in the first drop-down list.  

 Choose rct.1- major flags in the second drop-down list.  

 Set given in the IGETSC: initial conc. drop-down list.  

 Click the “Apply” button. 

 

To assign the immobile initial concentration values: 

 Choose Mt3dms – RCT – rct.2c concentrations in the first three drop-down list under the 

Spatial Attributes section. 

 Set the immobile initial concentration values with the desired tool for assigning and editing 

distributed input data. 

The first sorption parameter (SP1): For dual-domain mass transfer with sorption, SP1 is the 

distribution coefficient [L3M-1]. 

To assign the first sorption parameter values:  

 

 

 

 

 

 Click on the “Spc” button under the Parameter/3.Transport section. A Select 

Species window will appear.  

 Choose Mt3dms in the Type drop-down list.  

 Write Tracer in the Species box. 

 Click the “OK” button. 

 Click on the “RCT” button under the Parameter/3.Transport section. An RCT 

Parameters window will appear.  

 Set the first sorption parameter (SP1) under the SP1 column. 
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 Click the “OK” button. 

 To assign a spatially variable value of the first sorption parameter (SP1): 

‒ Choose Mt3dms – RCT – rct.3 1st sorption parm in the first three drop-

down list under the Spatial Attributes section. 

‒ Set the first sorption parameter values with the desired tool for assigning 

and editing distributed input data. 

‒ The value of the first sorption parameter will be the product of the value 

assigned in the “RCT” button under the Parameter/3.Transport section and 

the spatially variable value. 

 

The second sorption parameter (SP2): For dual-domain mass transfer with sorption, SP2 is the 

first-order mass transfer rate between the two domains [T-1]. 

To assign the second sorption parameter values: 

 

 

 

 

 

 Click on the “Spc” button under the Parameter/3.Transport section. A Select 

Species window will appear.  

 Choose Mt3dms in the Type drop-down list.  

 Write Tracer in the Species box. 

 Click the “OK” button. 

 Click on the “RCT” button under the Parameter/3.Transport section. An RCT 

Parameters window will appear.  

 Set the second sorption parameter (SP2) under the SP2 column. 

 Click the “OK” button. 

 To assign a spatially variable value of the second sorption parameter (SP2): 

‒ Choose Mt3dms – RCT – rct.4 2nd sorption parm in the first three drop-

down list under the Spatial Attributes section. 

‒ Set the second sorption parameter values with the desired tool for assigning 

and editing distributed input data. 

‒ The value of the second sorption parameter will be the product of the value 

assigned in the “RCT” button under the Parameter/3.Transport section and 

the spatially variable value. 

 

Information about the RCT package can be found in the MT3DMS user guide on page 123, located 

in the Doc folder of your ORTI3D installation folder. 
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4.4.2.5 Chemical Reaction: Radioactive Decay or Biodegradation (RCT Package) 

Chemical reactions (RCT package) supported by the MT3DMS transport model integrate first-order 

irreversible rate reactions, such as radioactive decay or biodegradation. In ORTI3D, the multiple 

chemical species option of MT3DMS is not implemented. Only one chemical species may be 

simulated. The multiple chemical species option of the MT3DMS RCT package is available through 

the use of PHT3D (for more details see “Chemical reaction: Multiple chemical species (RCT package)” 

on page 84). 

The RCT package is not included by default in ORTI3D. Therefore, to include chemical reaction in 

transport model, enable RCT package (for more details see “Import MT3DMS packages” on page 58). 

Radioactive Decay or Biodegradation Methods 

In MT3DMS, radioactive decay or biodegradation can be simulated with a first-order irreversible rate 

reaction. The mass loss of both the dissolved phase and the sorbed phase may be represented. Note 

that this reaction package is not intended for modeling chemical reactions between species.  

To turn-on radioactive decay or biodegradation method: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose RCT in the first drop-down list.  

 Choose rct.1- major flags in the second drop-down list.  

 Set 1st order in the IREACT: kinetic reaction drop-down list.  

 Click the “Apply” button. 

 

Radioactive Decay or Biodegradation Parameters 

The first reaction parameter (RC1): The first-order reaction rate for the dissolved phase [T-1]. If a 

dual-domain system is simulated, the reaction rates for the liquid phase in the mobile and immobile 

domains are assumed to be equal.  

To assign the first reaction parameter values:  

 

 

 

 

 

 Click on the “Spc” button under the Parameter/3.Transport section. A Select 

Species window will appear.  

 Choose Mt3dms in the Type drop-down list.  

 Write Tracer in the Species box. 

 Click the “OK” button. 

 Click on the “RCT” button under the Parameter/3.Transport section. An RCT 

Parameters window will appear.  

 Set the first reaction parameter (RC1) under the RC1 column. 
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 Click the “OK” button. 

 To assign a spatially variable value of the first reaction parameter (RC1): 

‒ Choose Mt3dms – RCT – rct.5 1st order rate in the first three drop-down list 

under the Spatial Attributes section. 

‒ Set the first reaction parameter values with the desired tool for assigning 

and editing distributed input data. 

‒ The value of the first reaction parameter will be the product of the value 

assigned in the “RCT” button under the Parameter/3.Transport section and 

the spatially variable value. 

 

The second reaction parameter (RC2): The first-order reaction rate for the sorbed phase [T-1]. If a 

dual-domain system is simulated, the reaction rates for the sorbed phase in the mobile and 

immobile domains are assumed to be equal. 

To assign the second reaction parameter values: 

 

 

 

 

 

 Click on the “Spc” button under the Parameter/3.Transport section. A Select 

Species window will appear.  

 Choose Mt3dms in the Type drop-down list.  

 Write Tracer in the Species box. 

 Click the “OK” button. 

 Click on the “RCT” button under the Parameter/3.Transport section. An RCT 

Parameters window will appear.  

 Set the second reaction parameter (RC2) under the RC2 column. 

 Click the “OK” button. 

 To assign a spatially variable value of the second reaction parameter (RC2): 

‒ Choose Mt3dms – RCT – rct.6 1st rate sorbed in the first three drop-down 

list under the Spatial Attributes section. 

‒ Set the second reaction parameter values with the desired tool for assigning 

and editing distributed input data. 

‒ The value of the second reaction parameter will be the product of the value 

assigned in the “RCT” button under the Parameter/3.Transport section and 

the spatially variable value. 

Information about the RCT package can be found in the MT3DMS user guide on page 123, located 

in the Doc folder of your ORTI3D installation folder. 
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4.4.3 Mt3dms Boundary Condition 

4.4.3.1 Boundary Conditions (BTN) 

A boundary condition array is required by transport models. The boundary condition array contains a 

code for each model cell that indicates whether:  

 The concentration value is computed (active cell).  

 The concentration value is kept fixed at a given value (fixed concentration cell).  

 No transport takes place within the cell (inactive cell).  

It is suggested to use 1 for an active cell, -1 for a fixed concentration cell, and 0 for an inactive cell. 

For constant concentration cells, the initial concentration value remains the same throughout the 

simulation.  

Boundary conditions may be defined as distributed property values (for more details see “Tools for 

assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

To assign boundary conditions at model cells: 

 Choose Mt3dms – BTN – btn.12 Boundary conditions in the first three drop-down list 

under the Spatial Attributes section. 

 Assign boundary conditions values with the desired tool for assigning and editing 

distributed input data. 

Information about the BTN package can be found in the MT3DMS user guide on page 102, located 

in the Doc folder of your ORTI3D installation folder. 

4.4.3.2 Constant Concentration Boundary Conditions 

The constant concentration boundary conditions are used to fix the concentration value in 

selected grid cells regardless of the system conditions in the surrounding grid cells, thus a constant 

concentration boundary provides inexhaustible solute mass to the model domain in the form of a 

known concentration. An example of such a boundary condition is a spill that provides dissolved 

phase contamination at a fixed concentration for a relatively long period time. 

Constant concentration condition may be defined as distributed property values (for more details 

see “Tools for assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 
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 Import point zone values. 

 Interpolate constant concentration of media from point zone values (imported or set 

manually). 

Constant concentration values must be assigned in constant concentration boundary condition 

cells (i.e., cells with a value of -1 [for more details see “Boundary conditions (BTN)” on page 70]). 

In ORTI3D, to fix the constant concentration value in selected grid cells: 

 Choose Mt3dms – BTN – btn.13 Concentrations in the first three drop-down list under the 

Spatial Attributes section. 

 Assign constant concentration values with the desired tool for assigning and editing 

distributed input data. 

 If a zone tool is used, a Zone window will appear.  

 Select Steady in the Temporal drop-down list. 

 Set the constant concentration value to assign at the zone in the Zone value box. 

In ORTI3D, when constant concentration condition is assigned under the btn.13 Concentration 

section, the constant concentration values are written in the .BTN and .SSM files.  

Information about the BTN package can be found in the MT3DMS user guide on page 102, located 

in the Doc folder of your ORTI3D installation folder. 

4.4.3.3 Time-Variant Concentration Boundary Conditions 

The time-variant concentration boundary conditions are used to fix time-variant constant 

concentration value in selected grid cells. Thus, constant concentration cells take different 

concentration values for each time step. 

Time-variant concentration values may be defined as distributed property values (for more details 

see “Tools for assigning and editing distributed input data” on page 28): 

 Set zones of value. 

Time-variant concentration values must be assigned in constant concentration boundary 

condition cells (i.e., cells with a value of -1 [for more details see “Boundary conditions (BTN)” on 

page 70]). 

In ORTI3D, to fix the time-variant concentration value in selected grid cells: 

 Choose Mt3dms – BTN – btn.13 Concentrations in the first three drop-down list under the 

Spatial Attributes section. 

 Assign time-variant concentration values with the desired tool for assigning and editing 

distributed input data. 
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In ORTI3D, when time-variant concentration condition is assigned under the btn.13 Concentration 

section, the time-variant concentration values are written in the .BTN and .SSM files.  

Information about the BTN package can be found in the MT3DMS user guide on page 102, located 

in the Doc folder of your ORTI3D installation folder. 

4.4.3.4 Recharge Concentration Boundary Conditions 

The recharge concentration condition specifies the component concentration accompanying the 

recharge flux specified in the flow model. When no recharge is applied to the recharge concentration 

cells, then no component will be added to the model. 

Recharge concentration values may be defined as distributed property values (for more details see 

“Tools for assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate recharge concentration of media from point zone values (imported or set 

manually). 

In ORTI3D, to fix the recharge concentration value in selected grid cells: 

 Choose Mt3dms – BTN – btn.23 Recharge in the first three drop-down list under the Spatial 

Attributes section. 

 Assign recharge concentration values with the desired tool for assigning and editing 

distributed input data. 

In ORTI3D, when recharge concentration condition is assigned under the btn.23 Recharge section, 

the recharge concentration values are written in the .SSM file.  

Information about the SSM package can be found in the MT3DMS user guide on page 119, located 

in the Doc folder of your ORTI3D installation folder. 

4.4.3.5 Point Source Boundary Conditions 

The point source condition may ONLY be assigned in grid cells containing a flow boundary 

condition, namely: 

 Constant or time-variant specified-head boundary condition 

 Well boundary condition 

 Drain boundary condition 

 River boundary condition 

 General-head boundary condition 
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If a point source is assigned to a flow boundary condition, and the flow rate is set to 0, the point 

source will not add component to the model cells, and then no component will be added to the 

model. 

Point source concentration values may be defined as distributed property values (for more details 

see “Tools for assigning and editing distributed input data” on page 28): 

 Set zones of value. 

 Import point zone values. 

In ORTI3D, to fix the point source concentration value in selected grid cells: 

 Choose Mt3dms – BTN – btn.13 Concentrations in the first three drop-down list under the 

Spatial Attributes section. 

 Assign point source concentration values with the desired tool for assigning and editing 

distributed input data. 

In ORTI3D, when point source concentration condition is assigned under the btn.13 Concentration 

section, the point source concentration values are written in the .BTN and .SSM files.  

Information about the SSM package can be found in the MT3DMS user guide on page 119, located 

in the Doc folder of your ORTI3D installation folder. 

4.5 MODFLOW USG Transport Input Data 

4.5.1 Importing MODFLOW USG Transport Packages 

In ORTI3D, the MODFLOW USG Transport package available are the following: 

 BCT – Block-Centered Transport package. 

 PCB – Prescribed Concentration Boundary package. 

 CRCH – Concentration in Recharge package. 

 CSS – Concentration at Sources and Sinks package. 

 DPT – Dual Porosity Transport package. 

 DDF – Density Driven Flow package. 

The packages included by default in ORTI3D when you created a new model project are: BCT, PCB 

and CSS. 

To include different packages: 

 Selecting Add-In/MfUsgTrans_modules from the Main menu section. 

 A Select Modules window will appear. 

 Check the box corresponding of the packages that you want to use. 
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 Uncheck the box corresponding of the packages that you do not want to use.  

Click the “Ok” button. 

4.5.2 MODFLOW USG Transport Model Properties 

4.5.2.1 Transport Model Domain 

 

4.5.2.2 Effective Porosity 

Effective porosity is the pore space through which flow actually occurs. In MODFLOW USG 

Transport, effective porosity is used to calculate the average velocity of the flow through the porous 

medium.  

Effective porosity parameter may be defined as distributed property values (for more details see 

“Tools for assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate effective porosity of media from point zone values (imported or set manually). 

To assign effective porosity values: 

 Choose MfUsgTrans – BCT – bct.3 Porosity in the first three drop-down list under the 

Spatial Attributes section. 

 Set the effective porosity values with the desired tool for assigning and editing distributed 

input data. 

Information about the BCT package can be found in the Block-Centered Transport (BCT) process for 

Modflow-Usg user guide on page 332, located in the Doc folder of your ORTI3D installation folder. 

4.5.2.3 Dispersion 

Dispersion in porous media is a process that tends to spread the contaminants over a greater region 

than would be predicted solely from the advective path of the plume. Dispersion is caused by 

mechanical dispersion, a result of deviation of the flowpaths as groundwater travels through the 

interconnected pores of the soil, and by molecular diffusion due to concentration gradients. The 

effects of molecular diffusion are generally negligible compared with mechanical dispersion, and 

only become important when groundwater velocity is very low. Hydrodynamic dispersion is the sum 
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of mechanical dispersion and molecular diffusion and is defined by assigning the following 

parameters to the model cells: 

 Longitudinal dispersivity for each transport grid cell [L]. 

 Transverse dispersivity for each layer [L]. 

 Molecular diffusion coefficient [LT-1]. 

Dispersion can be set either isotropic or anisotropic. Anisotropic formula is not yet implemented in 

ORTI3D.  

To set whether Dispersion is simulated: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose BCT in the first drop-down list.  

 Choose bct.1a- Main flags in the second drop-down list.  

 Set the dispersion formula in the IDISP: Dispersion drop-down list.  

 Click the “Apply” button. 

Dispersivities may be defined as distributed property values (for more details see “Tools for assigning 

and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate dispersivities of media from point zone values (imported or set manually). 

To assign the longitudinal dispersivity values: 

 Choose MfUsgTrans – BCT – bct.6 long. dispersivity in the first three drop-down list under 

the Spatial Attributes section. 

 Set the longitudinal dispersivity values with the desired tool for assigning and editing 

distributed input data. 

To assign the transverse dispersivity values: 

 Choose MfUsgTrans – BCT – bct.6 transv. dispersivity in the first three drop-down list 

under the Spatial Attributes section. 

 Set the transverse dispersivity values with the desired tool for assigning and editing 

distributed input data. 

To 

set 

the 

 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose BCT in the first drop-down list.  

 Choose bct.1a- Main flags in the second drop-down list.  
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 Set the dispersion formula in the DIFFNC box.  

 Click the “Apply” button. 

Information about the BCT package can be found in the Block-Centered Transport (BCT) process for 

Modflow-Usg user guide on page 332, located in the Doc folder of your ORTI3D installation folder. 

4.5.2.4 Sorption 

Sorption Methods 

Sorption is implemented in MODFLOW USG Transport through use of the retardation factor R with 

two different set of sorption methods: 

 Linear isotherm: The retardation factor is independent of the concentration field and is 

calculated only once for each cell in the beginning of the simulation. 

 Freundlich isotherm: The retardation factor is calculated at the beginning of each transport 

step following the Freundlich nonlinear isotherm. 

To set if sorption is simulated and the desired sorption method: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose BCT in the first drop-down list.  

 Choose bct.1a- Main flags in the second drop-down list.  

 Set the sorption method in the IADSRB: sorption drop-down list.  

‒ Linear isotherm: choose linear. 

‒ Freundlich isotherm: choose freundlich. 

 Click the “Apply” button. 
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Sorption Parameters 

The sorption parameters will depend on which sorption method is selected and are presented as 

follows.  

Sorption parameters may be defined as distributed property values (for more details see “Tools for 

assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate sorption parameters of media from point zone values (imported or set manually). 

The bulk density: The soil bulk density is used to calculate the retardation factor for each 

chemical species and for each sorption method. 

To assign the bulk density values: 

 Choose MfUsgTrans – BCT – bct.4 Bulk density in the first three drop-down list under the 

Spatial Attributes section. 

 Set the bulk density values with the desired tool for assigning and editing distributed input 

data. 

The first sorption parameter (SP1): 

 For linear isotherm: SP1 is the distribution coefficient [L3M-1]. 

 For Freundlich isotherm: SP1 is the Freundlich equilibrium constant [L3M-1]. 

To assign the first sorption parameter values: 

 Choose MfUsgTrans – BCT – bct.14 Sorption in the first three drop-down list under the 

Spatial Attributes section. 

 Set the first sorption parameter values with the desired tool for assigning and editing 

distributed input data. 

The second sorption parameter (SP2): 

 For linear isotherm sorption: SP2 is read but not used. 

 For Freundlich isotherm: SP2 is the Freundlich exponent a [-]. 

To assign the second sorption parameter values: 

 Choose MfUsgTrans – BCT – bct.15 Sorption 2nd in the first three drop-down list under the 

Spatial Attributes section. 

 Set the first sorption parameter values with the desired tool for assigning and editing 

distributed input data. 
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Information about the BCT package can be found in the Block-Centered Transport (BCT) process for 

Modflow-Usg user guide on page 332, located in the Doc folder of your ORTI3D installation folder. 

4.5.2.5 Radioactive decay 

Radioactive Decay Methods 

In MODFLOW USG Transport, radioactive decay can be simulated with a zero- or first-order reaction 

rate. The mass loss of both the dissolved phase and the sorbed phase may be represented. Note that 

this reaction package is not intended for modeling chemical reactions between species.  

To turn-on and choose the zero-order decay method: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose BCT in the first drop-down list.  

 Choose bct.1- main flags in the second drop-down list.  

 Set zero-order decay method in the IZOD: zero order decay drop-down list.  

 Click the “Apply” button. 

To turn-on and choose the first-order decay method: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose BCT in the first drop-down list.  

 Choose bct.1- main flags in the second drop-down list.  

 Set first-order decay method in the IFOD: first order decay drop-down list.  

 Click the “Apply” button. 

Radioactive Decay Parameters 

Radioactive Decay parameters may be defined as distributed property values (for more details see 

“Tools for assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate Radioactive Decay parameters of media from point zone values (imported or set 

manually). 

To assign the zero-order reaction rate for the dissolved phase [M / (L3T)]: 

 Choose MfUsgTrans – BCT – bct.16 zero order decay (W) in the first three drop-down list 

under the Spatial Attributes section. 

 Set the values with the desired tool for assigning and editing distributed input data. 
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To assign the zero-order reaction rate for the solid phase [M / (L3T)]: 

 Choose MfUsgTrans – BCT – bct.17 zero order decay (S) in the first three drop-down list 

under the Spatial Attributes section. 

 Set the values with the desired tool for assigning and editing distributed input data. 

To assign the first-order reaction rate for the dissolved phase [T-1]:  

 Choose MfUsgTrans – BCT – bct.18 1st order decay (W) in the first three drop-down list 

under the Spatial Attributes section. 

 Set the values with the desired tool for assigning and editing distributed input data. 

To assign the first-order reaction rate for the solid phase [T-1]:  

 Choose MfUsgTrans – BCT – bct.19 1st order decay (S) in the first three drop-down list 

under the Spatial Attributes section. 

 Set the values with the desired tool for assigning and editing distributed input data. 

4.5.2.6 Information about the BCT package can be found in the Block-Centered 

Transport (BCT) process for Modflow-Usg user guide on page 332, located 

in the Doc folder of your ORTI3D installation folder.Initial concentration 

The initial concentration represent the initial concentration of the contaminant at any location in 

the domain.  

Initial concentration may be defined as distributed property values (for more details see “Tools for 

assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

 Interpolate Initial concentration of media from point zone values (imported or set manually). 

To assign the initial concentration values: 

 Choose MfUsgTrans – BCT – bct.20 initial concentrations in the first three drop-down list 

under the Spatial Attributes section. 

 Set the initial concentrations values with the desired tool for assigning and editing 

distributed input data. 

Note: If prescribed heads are provided to the flow simulation via negative values of the IBOUND 

array in the BAS package, it is not possible to provide concentrations at inflow nodes with the current 
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BCT packages. In that case, the code assumes that the concentration of species in the inflowing water 

is zero. 

Information about the BCT package can be found in the Block-Centered Transport (BCT) process for 

Modflow-Usg user guide on page 332, located in the Doc folder of your ORTI3D installation folder. 

4.5.3 MODFLOW USG Transport Boundary Condition 

4.5.3.1 Prescribed Concentration Boundary Conditions 

The prescribed concentration boundary conditions are used to fix constant or time-variant 

constant concentration value in selected grid cells. 

Prescribed concentration values may be defined as distributed property values (for more details see 

“Tools for assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 

In ORTI3D, to fix prescribed concentration value in selected grid cells: 

 Choose MfUsgTrans – PCB – pcb.2 conc at boundaries in the first three drop-down list 

under the Spatial Attributes section. 

 Assign prescribed concentration values with the desired tool for assigning and editing 

distributed input data. 

In ORTI3D, when prescribed concentration condition is assigned under the pcb.2 conc at 

boundaries section, the prescribed concentration values are written in the .PCB files.  

Information about the PCB package can be found in the Block-Centered Transport (BCT) process for 

Modflow-Usg user guide on page 84, located in the Doc folder of your ORTI3D installation folder. 

4.5.3.2 Recharge Concentration Boundary Conditions 

The recharge concentration condition specifies the component concentration accompanying the 

recharge flux specified in the flow model. When no recharge is applied to the recharge concentration 

cells, then no component will be added to the model. 

Recharge concentration values may be defined as distributed property values (for more details see 

“Tools for assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 
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 Interpolate recharge concentration of media from point zone values (imported or set 

manually). 

In ORTI3D, to fix the recharge concentration value in selected grid cells: 

 Choose MfUsgTrans – CRCH – crch.1 Recharge concentration in the first three drop-down 

list under the Spatial Attributes section. 

 Assign recharge concentration values with the desired tool for assigning and editing 

distributed input data. 

In ORTI3D, when recharge concentration condition is assigned under the crch.1 Recharge 

concentration section, the recharge concentration values are written in the .RCH file.  

Information about the RCH package can be found in the Block-Centered Transport (BCT) process for 

Modflow-Usg user guide on page 135, located in the Doc folder of your ORTI3D installation folder. 

4.5.3.3 Point Source Boundary Conditions 

The point source condition may ONLY be assigned in grid cells containing a flow boundary 

condition, namely: 

 Constant or time-variant specified-head boundary condition. 

 Well boundary condition. 

 Drain boundary condition. 

 River boundary condition. 

 General-head boundary condition. 

 

IN ORDER to do so, it is advised to copy the coordinates of the concerned zone from the flow section 

to the CSS section, so that the concerned cells are exactly the same in the transport part as in the 

flow part. 

If a point source is assigned to a flow boundary condition, and the flow rate is set to 0, the point 

source will not add component to the model cells, and then no component will be added to the 

model. 

Point source concentration values may be defined as distributed property values (for more details 

see “Tools for assigning and editing distributed input data” on page 28): 

 Set zones of value. 

 Import point zone values. 
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In ORTI3D, to fix the point source concentration value in selected grid cells: 

 Choose MfUsgTrans – CSS – css.1 source sink concentrations in the first three drop-down 

list under the Spatial Attributes section. 

 Assign point source concentration values with the desired tool for assigning and editing 

distributed input data. 

In ORTI3D, when point source concentration condition is assigned under the css.1 source sink 

concentrations section, the point source concentration values are written in: 

 Constant or time-variant specified-head boundary condition: the .CHD file. 

 Well boundary condition: the .WEL file. 

 Drain boundary condition: the .DRN file. 

 River boundary condition: the .RIV file. 

 General-head boundary condition: the .GHB file. 

4.6 Pht3d and PHT-USG Input Data 

This section is about PHT3D and PHT-USG. When the operation of PHT3D and PHT-USG differs then 

this is specified.  

4.6.1 Pht3d and PHT-USG Model Properties 

4.6.1.1 Transport Parameters 

For the simulation of solute transport of the mobile components, the model parameters that control 

advective and dispersive transport have to be specified. It is assumed that the parameters that define 

the physical transport of the chemicals are the same for every species/component (except for 

diffusion coefficient that can differ).  

In ORTI3D: 

 PHT3D transport model properties are defined in the MT3DMS transport model properties 

and under the same input menus. MT3DMS does not need to be run when PHT3D is run.  

 PHT-USG transport model properties are defined in the MODFLOW USG Transport model 

properties and under the same input menus. MODFLOW USG Transport does not need to be 

run when PHT-USG is run. 

Effective Porosity 

To set effective porosity in PHT3D transport model, please see “Effective porosity” section on 

page 59. 
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To set effective porosity in PHT-USG transport model, please see “Effective porosity” section on page 

74. 

Dispersion 

To set dispersion parameters in PHT3D transport model, please see “Dispersion” section on page 60. 

To set dispersion parameters in PHT-USG transport model, please see “Dispersion” section on 

page 74. 

Molecular Diffusion Coefficient 

PHT3D:In a multicomponent simulation, it is possible that different ions and solutes may have 

noticeably different molecular diffusion coefficients. In ORTI3D, the molecular diffusion coefficient 

can be specified on a component-dependent basis but NOT on a layer-by-layer basis (for 3D model) 

for PHT3D simulation.  

To set the component-dependent molecular diffusion coefficient values: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose DSP in the first drop-down list.  

 Choose dsp.1- multidiffusion in the second drop-down list.  

 Set the name of the specie followed by the molecular diffusion coefficient value, 

with one line by species, in the IMDIFF box.  

 Click the “Apply” button. 

 

 

Note that, the molecular diffusion coefficient values of the species not specified in the IMDIFF box 

will be the molecular diffusion coefficient values set for all species in the dsp.5 molecular 

diffusion coefficient under the Spatial Attributes section (for more details see “Dispersion” section 

on page 60). 

PHT-USG: 
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In PHT-USG only one molecular diffusion coefficient for contaminant in water is read even if there 

are multiple contaminants simulated.  

To set the molecular diffusion coefficient value: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose BCT in the first drop-down list.  

 Choose bct.1a- Main flags in the second drop-down list.  

 Set the molecular diffusion coefficient in the DIFFNC box.  

 Click the “Apply” button. 

Information about the BCT package can be found in the Block-Centered Transport (BCT) process for 

Modflow-Usg user guide on page 332, located in the Doc folder of your ORTI3D installation folder. 

 

4.6.1.2 Chemical Reaction: Multiple Chemical Species (RCT Package) 

To set multiple chemical species for the RCT package (only available for PHT3D): 

 

 

 Click on the “Spc” button under the Parameter/3.Transport section. A Select 

Species window will appear.  

 Choose Pht3d in the Type drop-down list.  

 Write the list of chemical species (as in the PHT3D Database) affected by sorption, 

dual-domain mass transfer and radioactive decay or biodegradation in the Species 

box. 

 Click the “OK” button. 

Sorption 

To set sorption parameters in PHT3D transport model, please see “Chemical reaction: Sorption (RCT 

package)” section on page 61. 

Dual-Domain Mass Transfer 

To set dual-domain mass transfer parameters in PHT3D transport model, please see “Chemical 

reaction: Dual-domain mass transfer (RCT package)” section on page 64. 

Radioactive Decay or Biodegradation 

To set radioactive decay or biodegradation parameters in PHT3D transport model, please see 

“Chemical reaction: Radioactive decay or biodegradation (RCT package)” section on page 68. 

Information about the RCT package can be found in the MT3DMS user guide on page 123, located 

in the Doc folder of your ORTI3D installation folder. 
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4.6.1.3 Pht3d Database 

Basic Concept 

A PHT3D Database file is needed for each PHT3D and PHT-USG model project. This file has to be 

distinguished by the following name: 

pht3d_datab.dat 

This file has to be present in the modeling project folder. It is strongly recommended that the user 

create a separate folder for each modeling project to make it more practical to manage all model 

files created for the simulation. 

The input file pht3d_datab.dat is mainly a PHREEQC-2 database file that defines both equilibrium and 

kinetic reactions. The syntax for the definition of the reactions is identical with the original PHREEQC-

2 syntax and as documented in the PHREEQC-2 manual by (Parkhurst and Appelo, 1999). 

The PHREEQC-2 keywords that might be used in PHT3D and PHT-USG to create a reaction network 

are listed as follows: 

 SOLUTION_MASTER_SPECIES: define all aqueous master species. 

 SOLUTION_SPECIES: define chemical reaction for each aqueous species in solution.  

 PHASES: define name and chemical reactions for each gas component and mineral.  

 EXCHANGE_MASTER_SPECIES: define the correspondence between the name of an 

exchange site (X) and an exchange species that is used as the master species in calculations 

(X-). 

 EXCHANGE_SPECIES: define the exchange species that are complexes between aqueous 

species and the exchange master species X (i.e., the occupants of the exchanger). 

 SURFACE_MASTER_SPECIES: define the correspondence between surface binding site names 

and surface master species.  

 SURFACE_SPECIES: define a reaction for each surface species including surface master 

species.  

 RATES: define mathematical rate expressions for kinetic reactions. 

More details about the keywords can be found in the PHREEQC-2 manual.  

A basic PHT3D Database, based on PHREEQC-2 database is given in the Doc folder of your ORTI3D 

installation folder. Note that, to set up a ‘new’ user-defined reaction network for PHT3D and PHT-

USG, a basic knowledge of PHREEQC-2 may be necessary and, at least for more complex cases, it is 

strongly recommended to first test and debug reaction definitions by setting up a PHREEQC-2 

batch-type simulation. 
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PHT3D Database in ORTI3D 

ORTI3D read the PHT3D Database provides in the model project folder.  

To import the PHT3D Database in ORTI3D: 

 
 Click on the “Import database” button under the Parameter/4.Chemistry section. 

 A window will appear on your screen indicating: Database imported.  

 Click the “Ok” button. 

 

ORTI3D translate the PHT3D Database under the Chemistry panel. Note that if some species do not 

appear correctly when the PHT3D Database has been modified, means that the syntax of the 

PHREEQC-2 database has not be respected. 

To open the Chemistry panel: 

 
 Click on the “Chemistry” button under the Parameter/4.Chemistry section. 

 A “Chemistry” window will appear.  

 

The Chemistry panel, presented as follows, is for information purposes only. The tab display on the 

Chemistry panel will depends on the content of the PHT3D Database, and the following options may 

be present: 

Solutions: 
Set aqueous species present in solution and the amount of each species in 

solution (for more details see “Solution components” on page 87). 

Rates: 
Set parameters and chemical formula for kinetic reaction relative to the 

aqueous phases (for more details see “Solution components” on page 87). 

Phases: 

Set mineral phases present in the reaction network, target saturation index for 

the pure phase in the aqueous phase and the amount of the phase in the 

phase assemblage (for more details see “Mineral and gas phases” on 

page 90). 

Gases: 

Set gas phases present in the reaction network, target saturation index for the 

gas phase in the aqueous phase and the amount (moles) of the phase in the 

phase assemblage (for more details see “Mineral and gas phases” on 

page 90). 

Kinetic_Minerals: 
Set parameters for kinetic reaction relative to the mineral and gas phases (for 

more details see “Mineral and gas phases” on page 90). 

Exchange: 
Set the exchange species and the amount of exchange species (for more 

details see “Exchange species” on page 92). 
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Surface: 
Set the name of a surface binding site, the total number of sites and the 

surface area (for more details see “Surface complexation” on page 93) 

 

 

From the information provide in the Chemistry panel, ORTI3D will create the interface file that 

controls the communication between: 

 The MT3DMS part and the PHREEQC-2 part of the PHT3D simulator.  

 The MODFLOW USG transport part and the PHREEQC-2 part of the PHT-USG simulator. 

This file, pht3d_ph.dat, summaries the model reaction network.  

Information about the PHT3D Database package can be found in the PHT3D user guide on page 22, 

located in the Doc folder of your ORTI3D installation folder. 

4.6.1.4 Solution Components 

In the Solutions tab, the composition of several solutions, used later in the simulation, can be 

defined. The species listed under this tab include all species define under the 

SOLUTION_MASTER_SPECIES keyword in the PHT3D Database.  

Concentrations of aqueous (mobile) chemicals need always to be provided in mol.Lw
−1 (with Lw 

referring to liter of porewater), while the model dimensions need to be defined in m. 
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Define Solutions Composition 

The user can fix a chemical composition for the background and the desired number of different 

solutions. The model will use only the species that are checked. 

To define solutions composition: 

 
 Click on the “Chemistry” button under the Parameter/4.Chemistry section. 

 A “Chemistry” window will appear.  

 Select the Solutions tab. 

 Check the “C” box in front of the species present in solutions.  

 Set the concentrations of each species for each solution. 

 Click the “Ok” button. 

 

Add Solutions  

By default, in ORTI3D, the definition of the background and four solutions is proposed. However, it is 

possible to define as many solutions necessary for the reactive transport modeling project. 

To add solutions under the Solution tab: 

 
 Click on the “Parameter” button under the Parameter/4.Chemistry section. 

 Choose PH in the first drop-down list.  

 Choose ph.6- specific option in the second drop-down list.  

 Set number of solutions in the NB_SOLU: nb solutions box.  

 Click the “Apply” button. 

 

Note that you can copy paste solution composition using the <Ctrl +c> and <Ctrl +v> shortcut 

keys, within the "chemistry" window or from an external spreadsheet. 

Equilibrium 

If a simulation problem is a pure equilibrium problem, it should be warranted that the aqueous 

solution is in chemical equilibrium and charge balanced. If the aqueous solution is not in 

equilibrium, equilibrium conditions will be adjusted within the first reaction step at the end of the 

first time step. This can cause an undesired change, for example, of the solution pH or the 

dissolution/precipitation of minerals. To avoid this issue, it is recommended to evaluate and charge 

balance the aqueous solution with PHREEQC-2 before entering the data into ORTI3D. 
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Note, that there is no need to include aqueous components that will not play a role in the 

simulations. However, consider and activate all valence states of redox-sensitive components. For 

example, activate all valence states of nitrogen (i.e., N(5), N(3), N(0) and Amm). 

Note: By default, in ORTI3D, pH and pe are properties of the aqueous solution and are transported 

(and therefore mobile). However, the numerical solution procedure of PHT3D or PHT-USG does not 

require to transport these species and they can be treated as being immobile (for more details see 

“Charge imbalance” on page 124). 

Kinetic 

In ORTI3D, parameters and chemical formula for kinetic reaction relative to the aqueous phases are 

managed under the Rates tab. Under this tab, the following information has to be provided: 

 The values of the parameters used under the RATES keyword in the PHT3D Database. The 

parameter number provide in the Rates tab matches with the parameter number used in the 

PHT3D Database.  

 The formula for each rate. The formula describes any set of elements produced or consumed 

by the kinetic reaction (relative to the aqueous phase) can be specified through a list of 

doublets formula and stoichiometric coefficient. The syntax of the formula must be exactly the 

same than one of PHREEQC (more details about the formula can be found in the PHREEQC-2 

manual).  

 If the species is considered to be immobile. For immobile species, the “IM” box has to check. 

In this case the immobile species will take part in the kinetic reaction but will be not 

transported during the simulation.  
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To define parameters and chemical formula for kinetic reaction relative to the aqueous phases: 

 
 Click on the “Chemistry” button under the Parameter/4.Chemistry section. 

 A “Chemistry” window will appear.  

 Select the Rates tab. 

 Check the “C” box in front of the desired kinetic reaction.  

 Set parameters values. 

 Define the formula. 

 Click the “Ok” button. 

Note, that in PHT3D and PHT-USG, the names of rate expressions under the RATES keyword in the 

PHT3D Database need to be associated with either a SOLUTION_MASTER_SPECIES or a PHASE. 

4.6.1.5 Mineral and Gas Phases 

In the Phase or Gases tab, the composition of several phase (mineral or gas) assemblages, used later 

in the simulation, can be defined. The species listed under this tab include all species define under 

the PHASES keyword in the PHT3D Database.  

Concentrations of mineral and gas phases need always to be provided in mol.Lv
−1 (with Lv referring 

to liter of bulk volume). 

Gas phases are only used by MIN3P (not detailed in this manual) 

Define Phase Assemblages Composition  

The user can fix a chemical composition for the background and the desired number of different 

phase assemblages. The model will use only the mineral or gas phases that are checked. 

To define solutions composition: 

 
 Click on the “Chemistry” button under the Parameter/4.Chemistry section. 

 A “Chemistry” window will appear.  

 Select the Phases or Gases tab. 

 Check the “C” box in front of the mineral present in the phase assemblage.  

 Set the concentrations of each mineral or gas for each phase assemblage. 

 Set the saturation index of each mineral or gas for each phase assemblage (see the 

following for more details). 

 Click the “Ok” button. 
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Add Phase Assemblages 

By default, in ORTI3D, the definition of the background and four phases is proposed. However, it is 

possible to define as many phases necessary for the reactive transport modeling project. 

To add assemblage under the Phases tab: 

 
 Click on the “Parameter” button under the Parameter/4.Chemistry section. 

 Choose PH in the first drop-down list.  

 Choose ph.6- specific option in the second drop-down list.  

 Set number of phase assemblages in the NB_PHASE: nb phases box.  

 Click the “Apply” button. 

Note that you can copy paste assemblage composition and Saturation Index (SI) of mineral and gas 

phases using the <Ctrl +c> and <Ctrl +v> shortcut keys. 

Equilibrium 

By default, in ORTI3D, the index saturation is set to 0 (i.e., that the mineral or gas is equilibrium with 

the solution). However, a different SI may be defined in specific situations where the aqueous 

solution is not supposed to be in complete equilibrium with a specific mineral or gas.  

The SI value can be modified for each mineral or gas.  

 SI > 0: the solution is supersaturated with respect to the mineral or gas phase, and 

precipitation is likely to occur. 

 SI < 0: the solution is below saturation of the specified mineral or gas phase, and 

dissolution is likely to occur. 

 SI = 0: the solution is in equilibrium with the specified mineral or gas phase. 

Kinetic 

In ORTI3D, parameters for kinetic reaction relative to the mineral or gas are managed under the 

Kinetic_Minerals tab. Under this tab, the values of the parameters used under the RATES keyword 

in the PHT3D Database have to be provided. The parameter number provide in the Kinetic_Minerals 

tab matches with the parameter number used in the PHT3D Database.  

To define parameters for kinetic reaction relative to the mineral or gas: 

 
 Click on the “Chemistry” button under the Parameter/4.Chemistry section. 

 A “Chemistry” window will appear.  

 Select the Kinetic_Minerals tab. 

 Check the “C” box in front of the desired kinetic reaction.  

 Set parameters values. 
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 Click the “Ok” button. 

 

4.6.1.6 Exchange Species 

In the Exchange tab, the composition of several exchange species assemblages, used later in the 

simulation, can be defined. The species listed under this tab include all species define under the 

EXCHANGE_MASTER_SPECIES keyword in the PHT3D Database.  

Concentrations of exchange species need always to be provided in mol.Lv
−1 (with Lv referring to 

liter of bulk volume). 

Define Exchange Species Assemblages Composition  

The user can fix a chemical composition for the background and the desired number of different 

exchange species assemblages. The model will use only the exchange species that are checked. 

To define the composition of the exchange species assemblages: 

 
 Click on the “Chemistry” button under the Parameter/4.Chemistry section. 

 A “Chemistry” window will appear.  

 Select the Exchange tab. 

 Check the “C” box in front of the exchange species present in the assemblage.  

 Set the concentrations of each exchange species for each assemblage. 

 Click the “Ok” button. 

 

Add Exchange Species Assemblages 

By default, in ORTI3D, the definition of the background and four exchange species is proposed. 

However, it is possible to define as many exchange species necessary for the reactive transport 

modeling project. 

To add exchange species assemblages under the Exchange tab: 

 
 Click on the “Parameter” button under the Parameter/4.Chemistry section. 

 Choose PH in the first drop-down list.  

 Choose ph.6- specific option in the second drop-down list.  

 Set number of exchange species assemblages in the NB_EXCH: nb exchange box.  

 Click the “Apply” button. 
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Note that you can copy paste assemblage composition of exchange species using the <Ctrl +c> and 

<Ctrl +v> shortcut keys. 

4.6.1.7 Surface Complexation 

In the Surface tab, the composition and other characteristic of several surface binding site 

assemblages, used later in the simulation, can be defined. The surface binding sites listed under this 

tab include all surface binding sites define under the SURFACE_MASTER_SPECIES keyword in the 

PHT3D Database.  

Concentrations of surface binding sites need always to be provided in mol.Lv
−1 (with Lv referring to 

liter of bulk volume). 

Define Surface Assemblages Composition  

The user can fix a composition for the background and the desired number of different surface 

assemblages. The model will use only the surface binding sites that are checked. Under this tab, the 

following information has to be provided: 

 The total number of sites for each binding sites for each assemblage (mol.Lv
−1). 

 The specific surface area of a surface in m2.g-1. 

 The mass of solid for calculation of surface area in gram (g); surface area is mass of solid times 

specific surface area.  

To define surface binding site assemblage composition: 

 
 Click on the “Chemistry” button under the Parameter/4.Chemistry section. 

 A “Chemistry” window will appear.  

 Select the Surface tab. 

 Check the “C” box in front of the surface binding site present in the assemblage.  

 Set the total number of sites for each binding sites for each assemblage. 

 Set the specific surface of each surface under the Specific_area box. 

 Set the mass of each surface under the mass box. 

 Click the “Ok” button. 

Coupled Surface Binding Site with Pure Phase or Kinetic Reactant 

The number of binding sites and surface area may vary if the surface is related to an equilibrium 

phases or a kinetic reaction. In this case the following information has to be provided: 

 The number of moles of surface sites per mole of phase or kinetic reactant. By convention in 

PHT3D and PHT-USG the number of sites per mole is expressed as moles per liter of bulk 

volume (mol.Lv
−1). 
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 Name of the pure phase or kinetic reactant that has this kind of surface site. The number of 

moles of surface sites will be calculated from the number of moles of the phase/reactant. 

 The type of link, to define whether a pure phase is used or a kinetic reactant. 

 The specific surface area of a surface in (m2/mol). 

To define surface binding site assemblage composition coupled with pure phase or kinetic reactant: 

 
 Click on the “Chemistry” button under the Parameter/4.Chemistry section. 

 A “Chemistry” window will appear.  

 Select the Surface tab. 

 Check the “C” box in front of the surface binding site present in the assemblage.  

 Set the total number of sites per mole for each binding sites for each assemblage.  

 Set the specific surface of each surface under the Specific_area box. 

 Set the name of a pure phase or kinetic reactant to which the surface binding site 

must be coupled under the name box. 

 Indicate Kinetic or Equilibrium under the switch box. 

 Click the “Ok” button. 

 

Add Surface Sites 

By default, in ORTI3D, the definition of the background and four surfaces site is proposed. However, 

it is possible to define as many surfaces necessary for the reactive transport modeling project. 

To add solutions under the Surface tab: 

 
 Click on the “Parameter” button under the Parameter/4.Chemistry section. 

 Choose PH in the first drop-down list.  

 Choose ph.6- specific option in the second drop-down list.  

 Set number of surface site in the NB_SURF: nb surfaces box.  

 Click the “Apply” button. 

 

Note that you can copy paste assemblage composition of surface binding sites using the <Ctrl +c> 

and <Ctrl +v> shortcut keys. 

4.6.1.8 Initial Chemistry 

The initial concentrations define the hydrogeochemistry of the aquifer at the start of the simulation 

(Time = 0). The information provided here will be translated by ORTI3D into:  

 The basic transport package file, which is called pht3d.btn for PHT3D. 
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 The block-centered transport package, which is called Projectname.bct for PHT-USG. 

The initial hydrogeochemistry for the entire model domain may be defined for: 

 The aqueous phase (solution): Set the initial water composition under the Backgrd column. 

Please see “Solution components” section on page 87. 

 The mineral or gas phases: Set the initial phase composition under the Backg_Moles column 

and the initial SI under the Backg_SI column. Please see “Mineral and gas phases” section on 

page 90. 

 The exchange species: Set the initial quantity of exchange species under the Backgrd 

column. Please see “Exchange species” section on page 92. 

 The surface complexation: Set the initial number of sites or the under the Site_back column. 

Please see “Surface complexation” section on page 93. 

Initial chemistry composition may be defined as distributed property values by with the zone tool 

(for more details see “Tools for assigning and editing distributed input data” on page 19). 

To define initial chemistry in selected grid cells: 

 Choose Pht3d / PHT-USG – PH – ph.3 Initial chemistry in the first three drop-down list 

under the Spatial Attributes section. 

 Select grid cells with the desired zone tool for assigning and editing distributed input data 

following the convention explained as follows. 

In ORTI3D, to define the initial chemistry of a zone, following this writing convention in the Zone 

value box: 

 The solution number (for aqueous phases) and assemblage number (for mineral and gas 

phases, exchange species and surface complexation) is: 0 for the background, 1 for solu1, 

Ass1_Moles and Sites1, 2 for solu2, Ass2_Moles and Site2, and so on. 

 Indicate four numbers separates by dots in the Zone value box: 

‒ First number: for aqueous phase. 

‒ Second number: for mineral and gas phases. 

‒ Third number: for exchange species assemblage. 

‒ Fourth number: for surface binding sites assemblage. 
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In ORTI3D, when initial chemistry is defined under the ph.3 Initial chemistry section or in the 

background column, the initial chemistry is written in the .BTN and .SSM files.  

Information about the BTN package can be found in the MT3DMS user guide on page 102, located 

in the Doc folder of your ORTI3D installation folder. 

Information about the BCT package can be found in the Block-Centered Transport (BCT) process for 

Modflow-Usg user guide on page 332, located in the Doc folder of your ORTI3D installation folder. 

 

4.6.1.9 Import Initial Chemistry from a Previous PHT3D Model 

In ORTI3D, it is possible to define the hydrogeochemistry of the aquifer at the start of the simulation 

from a previous PHT3D model run (only available for PHT3D). Therefore, the initial condition (of the 

actual model) will be defined by the concentrations of each chemical species (of the previous model) 

computed previously.  

The previous model and the actual model MUST have the same grid discretization and the same 

time step scheme.  

To import the initial chemistry from a previous model run: 

 Selecting Add-In/Initial chemistry from the Main menu section. 

 An Initial chemistry window will appear. 
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 After “name = ” indicate All and after “value = ” indicate importUCN to import all 

concentrations of each chemical species. 

 Select the time step to import by indicating on a line “tspep = ” following by the number of 

the period to import.  

 Click the “Ok” button. 

4.6.2 PHT3D / PHT-USG Boundary Conditions 

4.6.2.1 Boundary Conditions (BTN) (only for PHT3D) 

As for a transport model, a boundary condition array is required by reactive transport models. In 

ORTI3D, PHT3D boundary condition array are treated similarly to the MT3DMS boundary condition 

array and under the same input menus. 

To assign boundary conditions at model cells in PHT3D reactive transport model, please see 

“Boundary conditions (BTN)” section on page 70. 

In PHT3D (like in MT3DM), when a boundary conditions of -1 is assign to a model cells (constant 

concentration cell), this defines that the water composition at these grid cells will not be computed 

and therefore will not change during the entire simulation. However, in PHT3D specify a constant 

water composition at a specific place in the domain has no physical meaning. The use of constant 

concentration cells (boundary conditions of -1) should NOT be used for PHT3D simulations. A water 

composition can be specified through the injection of water in a well, or through a fixed head 

boundary condition. A fixed concentration can also be obtained by setting some minerals at 

equilibrium, or some immobile species (NAPL).  

Note that, if you previously assign boundary conditions for a MT3DMS transport model, take 

care to reset all MT3DMS model boundary conditions, otherwise the boundary conditions for 

the MT3DMS model will be kept for the PHT3D model. 

4.6.2.2 Recharge Water Composition Boundary Condition 

The recharge water composition condition specifies the chemical composition of the water 

accompanying the recharge flux specified in the flow model. When no recharge is applied to the 

recharge water composition cells, then no chemical specie will be added to the model. 

Recharge water composition may be defined as distributed property values (for more details see 

“Tools for assigning and editing distributed input data” on page 28): 

 Set background value. 

 Set zones of value. 

 Import point zone values. 
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 Interpolate recharge concentration of media from point zone values (imported or set 

manually). 

To fix the recharge water composition in selected grid cells: 

 Choose Pht3d / PHT-USG – PH – ph.5 Recharge in the first three drop-down list under the 

Spatial Attributes section. 

 Assign the solution number that corresponds to the recharge water composition with the 

desired tool for assigning and editing distributed input data following the convention 

explained as follows. 

In ORTI3D, to define the water composition of a zone, following this writing convention in the Zone 

value box: 

 The solution number is: 0 for the background, 1 for solu1, 2 for solu2, and so on. 

In ORTI3D, when recharge water composition condition is assigned under the ph.5 Recharge 

section, the recharge water composition is written: 

 In the .SSM file for PHT3D. 

 In the .RCH file for PHT-USG.  

Information about the SSM package can be found in the MT3DMS user guide on page 119, located 

in the Doc folder of your ORTI3D installation folder. 

Information about the RCH package can be found in the Block-Centered Transport (BCT) process for 

Modflow-Usg user guide on page 135, located in the Doc folder of your ORTI3D installation folder. 

 

4.6.2.3 Evapotranspiration Water Composition Boundary Condition 

The evapotranspiration water composition condition specifies the chemical composition of the 

water accompanying the evapotranspiration flux specified in the flow model. When no 

evapotranspiration is applied to the evapotranspiration water composition cells, then no chemical 

specie will be added to the model. 

Note that evapotranspiration water composition boundary condition is used only for very specific 

purpose. In most cases, only pure water is evaporated. 

Evapotranspiration water composition may be defined as distributed property values (for more 

details see “Tools for assigning and editing distributed input data” on page 28): 

 Set background value. 
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 Set zones of value. 

 Import point zone values. 

 Interpolate recharge concentration of media from point zone values (imported or set 

manually). 

To fix the evapotranspiration water composition in selected grid cells: 

 Choose Pht3d – PH – ph.7 Evapotransp in the first three drop-down list under the Spatial 

Attributes section. 

 Assign the solution number that corresponds to the evapotranspiration water 

composition with the desired tool for assigning and editing distributed input data following 

the convention explained as follows. 

In ORTI3D, to define the water composition of a zone, following this writing convention in the Zone 

value box: 

 The solution number is: 0 for the background, 1 for solu1, 2 for solu2, and so on. 

In ORTI3D, when evapotranspiration water composition condition is assigned under the ph.7 

Evapotransp section, the evapotranspiration water composition is written  

 In the .SSM file for PHT3D. 

 In the .EVT file for PHT-USG.  

Information about the SSM package can be found in the MT3DMS user guide on page 119, located 

in the Doc folder of your ORTI3D installation folder. 

Information about the EVT package can be found in the Block-Centered Transport (BCT) process for 

Modflow-Usg user guide on page 112, located in the Doc folder of your ORTI3D installation folder. 

 

4.6.2.4 Point Source Boundary Condition 

The point source condition may ONLY be assigned in grid cells containing a flow boundary 

condition, namely: 

 Constant or time-variant specified-head boundary condition 

 Well boundary condition 

 Drain boundary condition 

 River boundary condition 

 General-head boundary condition 
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IN ORDER to do so, it is advised to copy the coordinates of the concerned zone from the flow section 

to the CSS section, so that the concerned cells are exactly the same in the transport part as in the 

flow part. 

If a point source is assigned to a flow boundary condition, and the flow rate is set to 0, the point 

source will not add chemical specie to the model cells, and then no chemical specie will be added to 

the model. 

Point source water composition may be defined as distributed property values (for more details 

see “Tools for assigning and editing distributed input data” on page 28): 

 Set zones of value. 

 Import point zone values. 

In ORTI3D, to fix the point source water composition in selected grid cells: 

 Choose Pht3d / PHT-USG – PH – ph.4 Source/sink in the first three drop-down list under 

the Spatial Attributes section. 

 Assign the solution number which corresponds to the point source water composition with 

the desired tool for assigning and editing distributed input data following the convention 

explained as follows. 

In ORTI3D, to define the water composition of a zone, following this writing convention in the Zone 

value box: 

 The solution number is: 0 for the background, 1 for solu1, 2 for solu2, and so on. 

In ORTI3D, when point source water composition condition is assigned under the ph.4 Source/sink 

section, the point source water composition is written: 

 In the .BTN and .SSM files for PHT3D. Therefore, to keep fixed the inflow water composition 

during the entire simulation, apply boundary conditions of -1 to the corresponding model 

cells (constant concentration cell). 

 In the .CHD file for PHT-USG.  

Information about the SSM package can be found in the MT3DMS user guide on page 119, located 

in the Doc folder of your ORTI3D installation folder. 

Information about the CHD package can be found in the MODFLOW-USG user guide on page 11, 

located in the Doc folder of your ORTI3D installation folder. 
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5 Model Run Settings 

5.1 MODFLOW and MODFLOW USG Run Settings 

This section is about MODFLOW and MODFLOW USG. When the operation of MODFLOW and 

MODFLOW USG differs then this is specified. Otherwise, the term MODFLOW designates both codes. 

5.1.1 Time Steps 

In MODFLOW, the total simulation time is divided into stress periods (i.e., time intervals during which 

all external excitations or stresses [boundary conditions, pumping rates, etc.] are constant). The total 

simulation time and the length of stress periods are set in the “Time” button under the 

Parameter/1.Model section (for more details see “Model output time” on page 26).  

Each stress period can, in turn, divided into time steps whereby the model will calculate the head 

solution at each time step. It is possible to increment each time step size by using the time step 

multiplier. In this case, the length of a time step is calculated by multiplying the length of the 

previous time step by the multiplier factor. In ORTI3D, only one value for the time step size and the 

time step multiplier can be set and will be used for each stress period.  

To set the time step size or the time step multiplier: 

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose DIS in the first drop-down list.  

 Choose dis.8-Periods characteristics for MODFLOW or disu.9-Periods 

characteristics for MODFLOW USG in the second drop-down list.  

 Set the time step size under the NSTP: internal steps box. 

 Set the time step multiplier under the TSMULT: multiplier box 

 Click the “Ok” button. 
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Information about the DIS packages can be found in the MODFLOW-2000 user guide on page 45, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the DISU package can be found in the MODFLOW-USG user guide on page 17, 

located in the Doc folder of your ORTI3D installation folder. 

5.1.2 Steady-State and Transient Simulation 

In ORTI3D, two options are available to perform steady-state or transient simulations:  

 Steady-state: Only the first stress period is steady-state and the other stress periods are 

transient. The first steady-state stress period produces a solution that is used as the initial 

condition for subsequent transient stress periods. 

 Transient: All stress periods are transient. 

To set the temporal scheme of the model: 

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose DIS in the first drop-down list.  

 Choose dis.8-Periods characteristics for MODFLOW or disu.9-Periods 

characteristics for MODFLOW USG in the second drop-down list.  

 Set the temporal scheme under the SsTr: type drop-down list. 

 Click the “Apply” button. 

Information about the DIS packages can be found in the MODFLOW-2000 user guide on page 45, 

located in the Doc folder of your ORTI3D installation folder. 
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Information about the DISU package can be found in the MODFLOW-USG user guide on page 17, 

located in the Doc folder of your ORTI3D installation folder. 

5.1.3 Quasi-3D Confining Bed Layers Setting 

This option is not available in ORTI3D. Thus, each layer in ORTI3D requires all of the aquifer material 

properties (horizontal conductivity, horizontal anisotropy, vertical conductivity, specific storage and 

specific yield) to be assigned to each grid cell in the model.  

5.1.4 Layer Types Settings 

By default, the LPF package is used in ORTI3D to inform flow layer types. In LPF, the convertible 

formulation should be used if layer 1 represents a water table. Also, the elevation of the top of layer 

1, which is specified in the discretization file, should be higher than the water level will reach at any 

time in the simulation. 

The numerical formulations, which are used by the LPF package to describe groundwater flow, 

depend on the type of each model layer. The layer types are: 

Confined: The layer is strictly confined. For transient simulations, the confined storage coefficient 

(specific storage × layer thickness) is used to calculate the rate of change in storage. Transmissivity of 

each cell is constant throughout the simulation. 

Convertible: A layer of this type is convertible between confined and unconfined. Confined storage 

coefficient (specific storage × layer thickness) is used to calculate the rate of change in storage, if the 

layer is fully saturated, otherwise specific yield will be used. During a flow simulation, transmissivity 

of each cell varies with the saturated thickness of the aquifer.  

Note that, in ORTI3D, for MODFLOW series 3D model it is possible to select different layer type for 

each layer. Therefore, the layers of a 3D model may be either confined or convertible. 

To set the temporal scheme of the model: 

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose LPF in the first drop-down list.  

 Choose lpf.2- Type of layer (confinement) in the second drop-down list.  

 Click the “Media” button. A lpf.2 window will appear. 

 Set the layer type for each media in the Type of layer: 0 for confined layer or 1 for 

convertible layer. 

 Click the “Apply” button. 
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Information about the LPF packages can be found in the MODFLOW-2000 user guide on page 59, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the LPF package can be found in the MODFLOW-USG user guide on page 32, 

located in the Doc folder of your ORTI3D installation folder. 

5.1.5 Re-Wetting Settings 

Originally in MODFLOW, a cell falls dry when the head is below the bottom elevation of the cell. 

When a cell falls dry, the cell is set like inactive cell and cannot be wetted again. However, a re-

wetting option has been implemented in the LPF package to allow for the re-wetting of these “dry” 

cells during a transient simulation.  

5.1.5.1 Re-Wetting Option 

The re-wetting settings are the following: 

 LAYWET: is used to indicate if the wetting capability is active or inactive. 

 IWETIT: is the iteration interval for attempting to wet cells. 

 IDHWET: is a flag that determines which equation is used to define the initial head at cells 

that become wet. 

 WETFCT: is a user-specified constant, called the wetting factor, which is included in the 

calculation of the head at a cell when it is converted from dry to wet. 

 WETDRY: is a combination of the wetting threshold and a flag to indicate which neighboring 

cells can cause a cell to become wet.  

‒ Flag: If WETDRY < 0, only the cell below a dry cell can cause the cell to become wet. If 

WETDRY > 0, the cell below a dry cell and the four horizontally adjacent cells can cause 

a cell to become wet. If WETDRY is 0, the cell cannot be wetted. 

‒ Wetting threshold: The absolute value of WETDRY is the wetting threshold. Wetting 

threshold is used to determine if the dry cell needs to be wetted. For a dry cell to 

become wet, the head in the adjacent grid cell(s) must be greater than the elevation of 

the bottom of the dry cell plus the wetting threshold value.  

To set the re-wetting parameters: 

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose LPF in the first drop-down list.  

 Choose lpf.6- wetting active or inactive in the second drop-down list.  

 Set active under the LAYWET: wetting drop-down list. 

 Click the “Apply” button. 
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5.1.5.2 Setting Head Values in Dry Cells 

Each dry cell is assigned a default head value as a flag to indicate it is dry. Although this value plays 

no role in the model calculations, it is useful as an indicator when looking at the resulting heads that 

are output from the model. 

To set the head values in dry cells: 

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose LPF in the first drop-down list.  

 Choose lpf.1- General flags in the second drop-down list.  

 Set the head values in dry cells under the HDRY: head for dry cells box. 

 Click the “Apply” button. 

Information about the LPF packages can be found in the MODFLOW-2000 user guide on page 59, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the LPF package can be found in the MODFLOW-USG user guide on page 32, 

located in the Doc folder of your ORTI3D installation folder. 

5.1.6 Recharge Settings 

In ORTI3D, two options are available to specifying the model layer that receives the recharge:  

 Recharge is only applied to the top grid layer: The recharge rates assigned to dry cells or to 

no-flow cells will NOT be carried down to the underlying active (wet) grid cells. In this case, 

the inactive or dry cells act like an impermeable barrier to the recharge. 

 Recharge is applied to the highest active layer: The recharge rates assigned to dry cells or to 

no-flow cells will be carried down automatically to the highest active (wet) grid cell in the 

same vertical column of grid cells. If the highest active cell is a constant-head cell, recharge 

will be intercepted and cannot go deeper. 

In MODFLOW, recharge may also be applied to any of the user-specified model layer. However, this 

option is not implemented in ORTI3D.  

To set the recharge option: 

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose RCH in the first drop-down list.  

 Choose rch.1- Flags for recharge in the second drop-down list.  

 Set the recharge options under the NRCHOP: position of recharge drop-down list. 
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 Click the “Apply” button. 

Information about the RCH package can be found in the MODFLOW-2000 user guide on page 67, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the RCH package can be found in the MODFLOW-USG user guide on page 40, 

located in the Doc folder of your ORTI3D installation folder. 

5.1.7 Evapotranspiration Settings 

In ORTI3D, two options are available to specifying the model layer that receives the 

evapotranspiration:  

 Evapotranspiration is only applied to the top grid layer: The evapotranspiration rates assigned 

to dry cells or to no-flow cells will NOT be carried down to the underlying active (wet) grid 

cells. In this case, the inactive or dry cells act like an impermeable barrier to the 

evapotranspiration. 

 Evapotranspiration is applied to the highest active layer: The evapotranspiration rates 

assigned to dry cells or to no-flow cells will be carried down automatically to the highest 

active (wet) grid cell in the same vertical column of grid cells. If the highest active cell is a 

constant-head cell, evapotranspiration will be intercepted and cannot go deeper. 

In MODFLOW, evapotranspiration may also be applied to any of the user-specified model layer. 

However, this option is not implemented in ORTI3D.  

To set the evapotranspiration option: 

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose EVT in the first drop-down list.  

 Choose evt.1- Flags for evapotransp in the second drop-down list.  

 Set the evapotranspiration options under the NEVTOP: position of evapo drop-

down list. 

 Click the “Apply” button. 

Information about the EVT package can be found in the MODFLOW-2000 user guide on page 73, 

located in the Doc folder of your ORTI3D installation folder. 

Information about the EVT package can be found in the MODFLOW-USG user guide on page 44, 

located in the Doc folder of your ORTI3D installation folder. 
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5.1.8 Solver Settings 

ORTI3D supports five packages (solvers) for solving the numerical equations for MODFLOW 

simulation and one for MODFLOW USG simulation:  

 Direct (DE4) solver (MODLFOW) 

 Preconditioned conjugate-gradient (PCG) solver (MODLFOW) 

 Strongly implicit procedure (SIP) solver (MODLFOW) 

 Slice-successive overrelaxation (SOR) solver (MODLFOW) 

 Newton (NWT) solver (MODLFOW) 

 Sparse matrix solver (MODFLOW USG) 

The following sections provide a description of each solver parameter settings. 

5.1.8.1 Direct Solver (DE4) 

The DE4 package is not included by default in ORTI3D. Therefore, to select this solver package 

enable DE4 package (for more details see “Import MODFLOW packages” on page 39) and disable 

the default PCG solver package. The required parameters in the direct solver (DE4) are described as 

follows: 

 ITMX is the maximum number of iterations each time step. For a linear problem, a single 

inner iteration is theoretically adequate. If the budget error is unacceptably large in a linear 

model, a few iterations should be used. Nonlinear problems require generally five or more 

iterations are needed. 

 MXUP, MXLOW, and MXBW7: When the flow equations are solved, they are divided into two 

parts, an upper and lower part. Memory must be allocated for both parts. The program can 

attempt to determine the required memory, but in some situations the automatic approach is 

not optimal. Automatic allocation is used when variables MXLOW, MXUP, and MXBW are 

specified as 0. 

 IFREQ is the flag indicating the frequency at which coefficients of simulated head (like 

riverbed conductance, drain conductance, maximum evapotranspiration rate, 

evapotranspiration extinction depth, and GHB conductance) change IFREQ = 1 indicates that 

the flow equations are linear and that coefficients of simulated head for all stress terms are 

constant for all stress periods. To meet the linearity requirement, all model layers must be 

confined. IFREQ = 2 indicates that the flow equations are linear, but coefficients of simulated 

head for some stress terms may change at the start of each stress period. IFREQ = 3 indicates 

that a nonlinear flow equation is being solved. If local grid refinement is used, IFREQ should 

always be set equal to 3. 

 MUTD4 is a flag that indicates the quantity of information that is printed: 0 indicates that the 

number of iterations in the time step and the maximum head change at each iteration are 
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printed, 1 indicates that only the number of iterations in the time step is printed and 2 

indicates that no information is printed 

 ACCL is a multiplier for the computed head change for each iteration. Normally this value is 1 

for linear problems. A value greater than 1 may be useful for improving the rate of 

convergence when using external iteration to solve nonlinear problems.  

 HCLOSE is the head change criterion for convergence. When the maximum absolute value of 

head change from all cells during an iteration is less than or equal to head change, iteration 

stops. 

 IPRD4 is the time step interval for printing out convergence information. 

To specify the required parameters in the direct solver (DE4): 

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose DE4 in the first drop-down list.  

 Choose de4.1- DE4 globals or de4.2- Steps in the second drop-down list.  

 Set the solver options. 

 Click the “Apply” button. 

 

Information about the DE4 package can be found in the MODFLOW-2000 user guide on page 84, 

located in the Doc folder of your ORTI3D installation folder. 

5.1.8.2 Preconditioned Conjugate-Gradient Solver 

In ORTI3D, the PCG solver is the default solver package for MODFLOW. The required parameters in 

the PCG solver are described as follows: 

 MXITER is the maximum number of outer iterations. For a linear problem, MXITER should be 

between 1 and 10. A larger number (generally less than 100) is required for a nonlinear 

problem.  

 ITER1 is the maximum number of inner iterations. For nonlinear problems, ITER1 usually 

ranges from 10 to 30; a value of 30 will be sufficient for most linear problems.  

 NPCOND is the flag used to select the matrix conditioning method: Modified Incomplete 

Cholesky (for use on scalar computers) or Polynomial (for use on vector computers or to 

conserve computer memory). 

 PHCLOSE is the head change criterion for convergence. When the maximum absolute value 

of the head change at all nodes during an iteration is less than or equal to head change, and 

the criterion for residual is satisfied (see the following), iteration stops. 
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 RCLOSE is the residual criterion for convergence. When the maximum absolute value of the 

residual at all cells during an iteration is less than or equal to residual, and the criterion for 

head change is satisfied (see previous), iteration stops. 

 RELAX is the relaxation parameter. Usually, this parameter is equal to 1, but for some 

problems a value of 0.99, 0.98 or 0.97 will reduce the number of iterations required for 

convergence. 

 NBPOL is used when NPCOND is set to Polynomial to indicate whether the estimate of the 

upper bound on the maximum eigenvalue is 2.0, or whether the estimate will be calculated. 

NBPOL = 2 is used to specify the value is 2.0; for any other value of NBPOL, the estimate is 

calculated. Convergence is generally insensitive to this parameter. 

 IPRPCG is the printout interval for PCG. The maximum head change (positive or negative) and 

residual change are printed for each iteration of a time step whenever the time step is an even 

multiple of IPRPCG. This printout also occurs at the end of each stress period regardless of the 

value of IPRPCG. 

 MUTPCG is a flag that controls printing of convergence information from the solver: printing 

tables of maximum head change and residual at each iteration, printing only the total number 

of iterations, no printing or printing only if convergence fails. 

 DAMP is the damping factor allowing the user to reduce the head change calculated during 

each successive outer iteration. It is typically set equal to one, which indicates no damping. A 

value less than 1 and greater than 0 causes damping. DAMP does not affect inner iterations; 

instead, it affects outer iterations. 

To specify the required parameters in the PCG solver:  

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose PCG in the first drop-down list.  

 Choose pcg.1- PCG globals or pcg.2- Steps in the second drop-down list.  

 Set the solver options. 

 Click the “Apply” button. 

 

Information about the PGC package can be found in the MODFLOW-2000 user guide on page 82, 

located in the Doc folder of your ORTI3D installation folder. 
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5.1.8.3 Strongly Implicit Procedure Solver 

The SIP package is not included by default in ORTI3D. Therefore, to select this solver package enable 

SIP package (for more details see “Import MODFLOW packages” on page 39) and disable the default 

PCG solver package. The required parameters in the SIP solver are described as follows: 

 MXITER is the maximum number of iterations in one time step in an attempt to solve the 

system of finite-difference equations. 

 NPARM is the number of iteration parameters to be used. Five parameters are generally 

sufficient. 

 SACCL is the acceleration parameter. It must be greater than zero and is generally equal to 

one. 

 SHCLOSE is the head change criterion for convergence. When the maximum absolute value of 

head change from all cells during an iteration is less than or equal to head change, iteration 

stops. 

 IPCALC is a flag to define if the user enters the seed, or if the seed will be calculated at the 

start of the simulation from problem parameters. 

 WSEED is the seed for calculating iteration variables. 

 IPRSIP is the printout interval for SIP. A positive integer is required. The maximum head 

change (positive or negative) is saved for each iteration of a time step whenever the time step 

is an even multiple of IPRSIP. This printout also occurs at the end of each stress period 

regardless of the value of IPRSIP. 

To specify the required parameters in the SIP solver:  

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose SIP in the first drop-down list.  

 Choose sip.1- SIP globals or sip.2- Steps in the second drop-down list.  

 Set the solver options. 

 Click the “Apply” button. 

Information about the SIP package can be found in the MODFLOW-2000 user guide on page 80, 

located in the Doc folder of your ORTI3D installation folder. 

5.1.8.4 Slice-Successive Overrelaxation Solver (SOR) 

The SOR package is not included by default in ORTI3D. Therefore, to select this solver package 

enable SOR package (for more details see “Import MODFLOW packages” on page 39) and disable 
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the default PCG solver package. The required parameters in the slice-successive overrelaxation solver 

(SOR) are described as follows: 

 MXITER is the maximum number of iterations in one time step in an attempt to solve the 

system of finite-difference equations. 

 OACCL is the acceleration parameter, usually between 1.0 and 2.0. 

 OHCLOSE is the head change criterion for convergence. When the maximum absolute value 

of head change from all cells during an iteration is less than or equal to Head Change, 

iteration stops. 

 IPRSOR is the printout interval for SOR. A positive integer is required. The maximum head 

change (positive or negative) is saved for each iteration of a time step whenever the time step 

is an even multiple of IPRSOR. This printout also occurs at the end of each stress period 

regardless of the value of IPRSOR. 

To specify the required parameters in the slice-successive overrelaxation solver (SOR):  

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose SOR in the first drop-down list.  

 Choose sor.1- SOR globals or sor.2- SOR globals in the second drop-down list.  

 Set the solver options. 

 Click the “Apply” button. 

 

Information about the SOR package can be found in the MODFLOW-2000 user guide on page 81, 

located in the Doc folder of your ORTI3D installation folder. 

5.1.8.5 Newton Solver (NWT) 

The NWT package is not included by default in ORTI3D. Therefore, to select this solver package 

enable NWT package (for more details see “Import MODFLOW packages” on page 39) and disable 

the default PCG solver package. The required parameters in the newton solver (NWT) are described 

as follows: 

General 

 HEADTOL is the maximum head change between outer iterations for solution of the 

nonlinear problem. 

 FLUXTOL is the maximum root-mean-squared flux difference between outer iterations for 

solution of the nonlinear problem. 

 MAXITEROUT is the maximum number of iterations to be allowed for solution of the outer 

(nonlinear) problem. 
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 THICKFACT is the portion of the cell thickness (length) used for smoothly adjusting storage 

and conductance coefficients to zero. 

 LINMETH is a flag that determines which matrix solver will be used: 1 indicates that GMRES 

will be used and 2 indicates that xMD will be used. 

 IBOTAV is a flag that indicates whether corrections will be made to groundwater head 

relative to the cell-bottom altitude if the cell is surrounded by dewatered cells. Checked = a 

correction will be made; Not-checked = no correction will be made. This input variable is 

problem specific and both options (IBOTAV selected/not selected) should be tested. 

 OPTIONS are keywords that activate solver options: 

‒ SPECIFIED indicates that the optional solver input values listed for items 1 and 2 will be 

specified in the NWT input file by the user. 

‒ SIMPLE indicates that default solver input values will be defined that work well for 

nearly linear models. This would be used for models that do not include nonlinear 

stress packages and models that are either confined or consist of a single unconfined 

layer that is thick enough to contain the water table within a single layer. (See Table 2 

of package documentation for the solver input values that will be used for this option.) 

‒ MODERATE indicates that default solver input values will be defined that work well for 

moderately nonlinear models. This would be used for models that include nonlinear 

stress packages and models that consist of one or more unconfined layers. The 

“MODERATE” option should be used when the “SIMPLE” option does not result in 

successful convergence. (See Table 2 of package documentation for the solver input 

values that will be used for this option.) 

‒ COMPLEX indicates that default solver input values will be defined that work well for 

highly nonlinear models. This would be used for models that include nonlinear stress 

packages and models that consist of one or more unconfined layers representing 

complex geology and surface water/groundwater interaction. The “COMPLEX” option 

should be used when the “MODERATE” option does not result in successful 

convergence. (See Table 2 of package documentation for the solver input values that 

will be used for this option.) 

If Option Is “Specified” 

 DBDTHETA is a coefficient used to reduce the weight applied to the head change between 

nonlinear iterations. DBDTHETA is used to control oscillations in head. Values range between 

0.0 and 1.0, and larger values increase the weight (decrease under-relaxation) applied to the 

head change. 

 DBDKAPPA is a coefficient used to increase the weight applied to the head change between 

nonlinear iterations. DBDKAPPA is used to control oscillations in head. Values range between 

0.0 and 1.0, and larger values increase the weight applied to the head change. 
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 DBDGAMMA is a factor used to weight the head change for iterations n–1 and n. Values 

range between 0.0 and 1.0, and greater values apply more weight to the head change 

calculated during iteration n. 

 MOMFACT is the momentum coefficient m and ranges between 0.0 and 1.0. Greater values 

apply more weight to the head change for iteration n. 

 BACKFLAG is a flag used to specify whether residual control will be used: 1 indicates that 

residual control is active and 2 indicates that residual control is inactive. 

 MAXBACKITER is the maximum number of reductions (backtracks) in the head change 

between nonlinear iterations. A value between 10 and 50 works well. 

 BACKTOL is the proportional decrease in the root-mean-squared error of the groundwater-

flow equation used to determine if residual control is required at the end of a nonlinear 

iteration. 

 BACKREDUCE is a reduction factor used for residual control that reduces the head change 

between nonlinear iterations. Values should be between 0.0 and 1.0, where smaller values 

result in smaller head change values. 

Gmres Solver Options 

If LINMETH = 1 (GMRES), then the following options will appear: 

 MAXITINNER is the maximum number of iterations for the linear solution. 

 ILUMETHOD is the index for selection of the method for incomplete factorization (ILU) used 

as a preconditioner:  

‒ 1 indicates that ILU with drop tolerance and fill limit is selected. Fill-in terms less than 

drop tolerance times the diagonal are discarded. The number of fill-in terms in each 

row of L and U is limited to the fill limit. The fill limit largest elements are kept in the L 

and U factors. 

‒ 2 indicates that ILU(k) with order k incomplete LU factorization is selected. Fill-in terms 

of higher order than k in the factorization are discarded. 

 LEVFILL is the fill limit for ILUMETHOD = 1 and is the level of fill for: ILUMETHOD = 2. 

Recommended values: 5-10 for method 1, 0-2 for method:2. 

 STOPTOL is the tolerance for convergence of the linear solver. This is the residual of the linear 

equations scaled by the norm of the root-mean-squared error. Usually 10-8 to 10-12 works 

well. 

 MSDR is the number of iterations between restarts of the GMRES Solver. 

Xmd Solver Options 

If LINMETH = 2 (xMD), then the following options will appear: 

 IACL is a flag for the acceleration method: 0 indicates conjugate-gradient, 1 indicates 

ORTHOMIN and 2 indicates Bi-CGSTAB. 
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 NORDER is a flag for the scheme of ordering the unknowns: 0 indicates original ordering, 1 

indicates RCM ordering and 2 indicates minimum degree ordering. 

 LEVEL is the level of fill for incomplete LU factorization 

 NORTH is the number of orthogonalization for the ORTHOMIN acceleration scheme. A 

number between 4 and 10 is appropriate. Small values require less storage, but more 

iterations may be required. This number should equal 2 for the other acceleration methods. 

 IREDSYS is a flag for reduced system preconditioning: 0 indicates that reduced system 

preconditioning is not applied and 1 that reduced system preconditioning is applied. 

 RRCTOLS is the residual reduction-convergence criterion. 

 IDROPTOL is a flag for using drop tolerance in the preconditioning: 0 indicates that drop 

tolerance is not used and 1 that drop tolerance is used. 

 EPSRN is the drop tolerance for preconditioning. 

 HCLOSEXMD is the head closure criterion for inner (linear) iterations. 

 MXITERXMD is the maximum number of iterations for the linear solution. 

To specify the required parameters in the newton solver (NWT):  

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose NWT in the first drop-down list.  

 Choose nwt.1- General flags or nwt.2- flags for GMRES (if LINMETH = 1) or 

nwt.3- flags for XMD (If LINMETH = 2) in the second drop-down list.  

 Set the solver options. 

 Click the “Apply” button. 

 

Information about the NWT package can be found in the MODFLOW-NWT report, located in the 

Doc folder of your ORTI3D installation folder. 

5.1.8.6 Sparse Matrix Solver 

In ORTI3D, the SMS solver is the solver package for MODLFOW USG. The required parameters in the 

SMS solver are described as follows: 

 OPTION – SIMPLE indicates that default solver input values will be defined that work well for 

nearly linear models. 

 OPTION – MODERATE indicates that default solver input values will be defined that work 

well for moderately nonlinear models. 

 OPTION – COMPLEX indicates that default solver input values will be defined that work well 

for highly nonlinear models. 
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 sHCLOSE is the head change criterion for convergence of the outer (nonlinear) iterations. 

When the maximum absolute value of the head change at all nodes during an iteration is less 

than or equal to head change iteration stops. Commonly, HCLOSE equals 0.01. 

 sHICLOSE is the head change criterion for convergence of the inner (linear) iterations, in units 

of length. When the maximum absolute value of the head change at all nodes during an 

iteration is less than or equal to HICLOSE, the matrix solver assumes convergence. Commonly, 

HICLOSE is set an order of magnitude less than HCLOSE. 

 sMXITER is the maximum number of outer iterations. For a linear problem, MXITER should be 

between 1 and 10. A larger number (generally less than 100) is required for a nonlinear 

problem.  

 sITER1 is the maximum number of inner iterations. For nonlinear problems, ITER1 usually 

ranges from 10 to 30; a value of 30 will be sufficient for most linear problems.  

‒ IPRSMS is a flag that controls printing of convergence information from the solver: 0 

indicates to print nothing, 1 indicates to print only the total number of iterations and 

nonlinear residual reduction summaries and 2 indicates to print matrix solver 

information in addition to above 

 NONLINMETH is a flag that controls the nonlinear solution method and under-relaxation 

schemes. 

 LINMETH is a flag that controls the matrix solution method: 1 indicates that the χMD solver 

of Ibaraki (2005) is used and 2 indicates that the unstructured pre-conditioned conjugate 

gradient solver of White and Hughes (2011) is used (Not implemented in ORTI3D). 

For the χMD solver:  

 sIACL is a flag for the acceleration method: 0 indicates conjugate-gradient, 1 indicates 

ORTHOMIN and 2 indicates Bi-CGSTAB. 

 sNORDER is a flag for the scheme of ordering the unknowns: 0 indicates original ordering, 1 

indicates RCM ordering and 2 indicates minimum degree ordering. 

 sLEVEL is the level of fill for ILU decomposition. Higher levels of fill provide more robustness 

but also require more memory. For optimal performance, it is suggested that a large level of 

fill be applied (7 or 8) with use of drop tolerance. 

 sNORTH is the number of orthogonalization for the ORTHOMIN acceleration scheme. A 

number between 4 and 10 is appropriate. Small values require less storage, but more 

iterations may be required. This number should equal 2 for the other acceleration methods. 

 sIREDSYS is a flag for reduced system of equations using the red-black ordering scheme: 0 

indicates that reduced system is not applied and 1 that reduced system using red-black 

ordering is applied. 

 sRRCTOLS is the residual reduction-convergence criterion. 

 sIDROPTOL is a flag for using drop tolerance in the preconditioning: 0 indicates that drop 

tolerance is not used and 1 that drop tolerance is used. 
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 sEPSRN is the drop tolerance value. A value of 10-3 works well for most problems. 

To specify the required parameters in the PCG solver:  

 
 Click on the “Parameter” button under the Parameter/2.Flow section (for 

MODFLOW series model). 

 Choose SMS in the first drop-down list.  

 Choose sms.1a- SMS options or sms.1b- SMS globals or sms.3- XMD solver in 

the second drop-down list.  

 Set the solver options. 

 Click the “Apply” button. 

 

Information about the SMS package can be found in the MODFLOW-USG user guide on page 118, 

located in the Doc folder of your ORTI3D installation folder. 

5.2 MT3DMS Run Settings 

5.2.1 Time Steps 

In the MT3DMS model, each flow model time step (from MODFLOW model) is further divided into 

smaller time increments, called transport steps. The length of each transport step can be specified in 

the model input or determined by the model with an automatic step size control procedure. The 

following parameters are used to define the length of the transport simulation: 

 DT0 is the user-specified transport step size within each time step of the flow solution.  

 If the GCG solver is not used (explicit solution), the program will always calculate a maximum 

transport step size that meets the various stability criteria. Setting DT0 to zero causes the 

model-calculated transport step size to be used in the simulation.  

 If the GCG solver is used (implicit solutions), DT0 is the initial transport step size. Setting DT0 

to zero causes the model-calculated value of DT0, based on the user-specified courant 

number in the advection package (for more details see “Solution method” on page 117). 

 MXSTRN is the maximum number of transport steps allowed within one time step of the flow 

solution. If the number of transport steps within a flow time step exceeds MXSTRN, the model 

will stop.  

 TTSMULT is the multiplier for successive transport steps within a flow time step if the GCG 

solver is used and the solution option for the advection term is the standard finite-difference 

method. A value between 1.0 and 2.0 is generally adequate. If the GCG package is not used, 

TTSMULT is always set to 1.0 regardless of the user-specified input. Note that for the particle-

tracking-based solution options and the third order TVD scheme, TTSMULT does not apply. 
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 TTSMAX is the maximum transport step size allowed when transport step size multiplier 

TTSMULT > 1.0. Setting TTSMAX=0 imposes no maximum limit. 

For steady-state flow simulations, the length of stress periods and the flow time step is not relevant. 

However, to perform contaminant transport simulation with MT3DMS, you must specify the actual 

length of stress periods in the “Time” button under the Parameter/1.Model section (for more 

details see “Model output time” on page 26) and the flow model time step (for more details see 

“Time steps” on page 101). 

To define the length of the transport simulation for the transport model: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose BTN in the first drop-down list.  

 Choose btn.22- Period in the second drop-down list.  

 Set the time parameters.  

 Click the “Apply” button. 

 

Information about the BTN packages can be found in the MT3DMS user guide on page 102, located 

in the Doc folder of your ORTI3D installation folder. 

5.2.2 Solution Method 

5.2.2.1 Choose Solution Method 

In MT3DMS, for numerical solution of the advection-dispersion transport equation, the six following 

solution methods are provided: 

1. Standard Finite-difference methods: 

a. Upstream Finite Difference (UFD) 

b. Central Finite Difference (CFD) 

2. The higher-order finite-volume TVD method 

3. The Particle-tracking based Eulerian-Lagrangian methods: 

a. Method of Characteristics (MOC) 

b. Modified Method of Characteristics (MMOC) 

c. Hybrid MOC/MMOC (HMOC) 

To set the solution method for the transport model: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose ADV in the first drop-down list.  

 Choose adv.1- Major data in the second drop-down list.  
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 Set the transport solution method in the MIXELM: Method drop-down list.  

 Click the “Apply” button. 

 

5.2.2.2 Solution Method Setting 

The following parameter is required by the advection package of MT3DMS for all solution method: 

 PERCEL is the courant number that represents the number of cells a particle will be allowed to 

move in any direction, in one transport step. Generally, PERCEL is between 0.5 and 1.0. If the 

upstream finite-difference method for solving advection is used, PERCEL must not exceed 1. 

Values in excess of 1 can be used for other solution method.  

To define the solution method setting for the transport model: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose ADV in the first drop-down list.  

 Choose adv.1- Major data in the second drop-down list.  

 Set PERCEL in the PERCEL: Courant nb drop-down list.  

 Click the “Apply” button. 

 

5.2.2.3 Finite-Difference Methods Setting 

The following parameter is required by the advection package of MT3DMS for the standard finite-

difference methods: 

 NADVFD is an integer flag indicating which weighting scheme should be used: 0 or 1 

indicates upstream weighting and 2 indicates central-in-space weighting. 

To define the finite-difference methods setting for the transport model: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose ADV in the first drop-down list.  

 Choose adv.1- Major data in the second drop-down list.  

 Set NADVFD in the NADVFD: weighing scheme drop-down list.  

 Click the “Apply” button. 
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5.2.2.4 Particle-Tracking Methods Settings 

The following parameter is required by the advection package of MT3DMS for the particle-tracking 

methods: 

 MXPART is the maximum number of total moving particles allowed (only used by the MOC 

or HMOC solution schemes). 

 ITRACK is a flag indicating which particle-tracking algorithm is selected for the Eulerian-

Lagrangian methods. ITRACK = 1, the first-order Euler algorithm is used. ITRACK= 2, the 

fourth-order Runge-Kutta algorithm is used; this option is computationally demanding and 

may be needed only when PERCEL is set greater than one. ITRACK= 3, the hybrid first- and 

fourth-order algorithm is used; the Runge-Kutta algorithm is used in sink/source cells and the 

cells next to sinks/sources, while the Euler algorithm is used elsewhere. 

 WD is a concentration weighting factor between 0 and 1. The value of 0.5 is normally a good 

choice. This number can be adjusted to achieve better mass balance. Generally, it can be 

increased toward 1 as advection becomes more dominant. 

 DCEPS is a small relative concentration gradient below which advective transport is 

considered negligible (only used by the MOC or HMOC solution schemes). A value around 

10-5 is generally adequate. 

 NPLANE is a flag indicating whether the random or fixed pattern is selected for initial 

placement of moving particles (only used by the MOC or HMOC solution schemes).  

 If NPLANE>0, the fixed pattern is selected for initial placement. The value of NPLANE serves as 

the number of vertical "planes" on which initial particles are placed within each cell block. This 

fixed pattern works well in relatively uniform flow Fields. For 2D simulations in plan view, set 

NPLANE= 1. For cross section or 3D simulations, NPLANE=2 is normally adequate. Increase 

NPLANE if more resolution in the vertical direction is desired. 

 If NPLANE=0, the random pattern is selected for initial placement. Particles are distributed 

randomly by calling a random number generator in both the horizontal and vertical 

directions. This option generally leads to smaller mass balance discrepancy in non-uniform or 

diverging/converging flow fields. 

 NPL is the number of initial particles per cell to be placed at cells where the relative cell 

concentration gradient is less than or equal to DCEPS (only used by the MOC or HMOC 

solution schemes). Generally, NPL can be set to zero because advection is considered 

insignificant when the relative cell concentration gradient is less than or equal to DCEPS. 

Setting NPL equal to NPH causes a uniform number of particles to be placed in every cell over 

the entire grid (i.e., the uniform approach). 

 NPH is the number of initial particles per cell to be placed at cells where the relative cell 

concentration gradient is less than DCEPS (only used by the MOC or HMOC solution 

schemes). The selection of NPH depends on the nature of the flow field and also the 

computer memory limitation. Generally, use a smaller number in relatively uniform flow fields 
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and a larger number in relatively non-uniform flow fields. However, values exceeding 16 in 2D 

simulations or 32 in 3D simulations are rarely necessary. If the random pattern is chosen, NPH 

particles are randomly distributed within the cell block. If the fixed pattern is chosen, NPH is 

divided by NPLANE to yield the number of particles to be placed per vertical plane 

 NPMIN is the minimum number of particles allowed per cell (only used by the MOC or HMOC 

solution schemes). If the number of particles in a cell at the end of a transport step is fewer 

than NPMIN, new particles are inserted into that cell to maintain a sufficient number of 

particles. NPMIN can be set to zero in relatively uniform flow fields and to a number greater 

than zero in diverging/converging flow fields. Generally, a value between zero and four is 

adequate. 

 NPMAX is the maximum number of particles allowed per cell (only used by the MOC or 

HMOC solution schemes). If the number of particles in a cell exceeds NPMAX, all particles are 

removed from that cell and replaced by a new set of particles equal to NPH to maintain mass 

balance. Generally, NPMAX can be set to approximately two times of NPH. 

 INTERP is a flag indicating the concentration interpolation method for use in the MMOC 

scheme (only used by the MMOC or HMOC solution schemes). Currently, only linear 

interpolation is implemented. Enter INTERP = 1 

 NLSINK is a flag indicating whether the random or fixed pattern is selected for initial 

placement of particles to approximate sink cells in the MMOC scheme (only used by the 

MMOC or HMOC solution schemes). The convention is the same as that for NPLANE. It is 

generally adequate to set NLSINK equivalent to NPLANE. 

 NPSINK is the number of particles used to approximate sink cells in the MMOC scheme (only 

used by the MMOC or HMOC solution schemes). The convention is the same as that for NPH. 

It is generally adequate to set NPSINK equivalent to NPH. 

 DHCMOC is the critical relative concentration gradient for controlling the selective use of 

either MOC or MMOC in the HMOC solution scheme. The MOC solution is selected at cells 

where the relative concentration gradient is greater than DCHMOC. The MMOC solution is 

selected at cells where the Relative Concentration Gradient is less than or equal to DCHMOC. 

To define the particle-tracking methods settings for the transport model: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose ADV in the first drop-down list.  

 Choose adv.1- Major data or adv.2 Particles or adv.3 Particles details or adv.4 

Particles details or adv.5 Gradient to choose MOC scheme in the second drop-

down list.  

 Set the solution settings.  

 Click the “Apply” button. 
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Information about the ADV packages can be found in the MT3DMS user guide on page 113, located 

in the Doc folder of your ORTI3D installation folder. 

5.2.3 Solver Settings (GCG) 

The generalized conjugate-gradient solver package (GCG) is the solver used for implicit solution 

scheme in MT3DMS. The parameters of the generalized conjugate-gradient solver are described as 

follows: 

 MXITER is the maximum number of outer iterations. It should be set to an integer greater 

than one only when a nonlinear sorption isotherm is included in simulation. 

 ITER1 is the maximum number of inner iterations. A maximum value of 30 to 50 inner 

iterations should be sufficient for most problems.  

 ISOLVE is the type of preconditioners to be used to solve the non-advective terms in the 

transport equation. A value of 1 indicates the Jacobi option. A value of 2 indicates the SSOR 

option. A value of 3 indicates the Modified Incomplete Cholesky (MIC) option, which usually 

converges faster, but it needs significantly more memory. 

 NCRS is an integer flag for treatment of dispersion tensor cross terms. A value of 0 indicates 

that all dispersion cross terms to the righthand-side are lumped (approximate but highly 

efficient). A value of 1 indicates that full dispersion tensor is included (memory intensive). 

 ACCL is the relaxation factor for the SSOR option. A value of 1.0 is generally adequate. 

 CCLOSE is the convergence criterion in terms of relative concentration. A real value between 

10-4 and 10-6 is generally adequate. 

 IPRGCG is the interval for printing the maximum concentration changes of each iteration. Set 

IPRGCG to zero as default for printing at the end of each stress period. 

To set the solver setting for the transport model: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose GCG in the first drop-down list.  

 Choose gcg.1- Main flags or gcg.2 convergence in the second drop-down list.  

 Set the solver settings.  

 Click the “Apply” button. 

 

Information about the GCG packages can be found in the MT3DMS user guide on page 127, located 

in the Doc folder of your ORTI3D installation folder. 
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5.3 MODFLOW USG Transport Run Settings 

5.3.1 Transport simulation 

In MODFLOW USG Transport, four different options exist to define when transport simulation is 

performed: 

 Immediately after every flow time step or a steady-state flow simulation.Using the flow field of 

a previously simulated flow run. 

 Flow computations are skipped after the first time-step of the first stress period. Transport is 

then simulated using the flow field of the first stress period. 

 Transport is simulated using the flow field of the previous flow run and only the first stress 

period of flow is read.  

Only the first option is implemented in ORTI3D.  

To set the option to define when transport simulation is performed: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose BCT in the first drop-down list.  

 Choose bct.1a- Main flags in the second drop-down list.  

 Set the option to define when transport simulation is performed under the ITRNSP: 

simulation drop-down list.  

 Click the “Apply” button. 

5.3.2 Solution Method 

In MODFLOW, for numerical solution of the advection-dispersion transport equation, the two 

following solution methods are provided: 

1. The upstream-weighted scheme. 

2. The TVD method. 

To set the solution method for the transport model: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose BCT in the first drop-down list.  

 Choose bct.1a- Main flags in the second drop-down list.  

 Set the transport solution method in the ITVD box: 

‒ ITVD = 0 for the upstream-weighted scheme. 

‒ ITVD > 0 represents the number of TVD correction iterations for TVD method. 

 Click the “Apply” button. 
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5.3.3 Solver Settings 

The sparse matrix solver package (SMS) is the solver used for MODFLOW USG Transport and 

MODFLOW USG. The parameter of the sparse matrix solver for transport simulation is the 

concentration tolerance for convergence of the matrix solver CICLOSE. A real value between 10-4 and 

10-6 is generally adequate. 

To set the solver setting for the transport model: 

 
 Click on the “Parameter” button under the Parameter/3.Transport section. 

 Choose BCT in the first drop-down list.  

 Choose bct.1a- Main flags in the second drop-down list.  

 Set the solver settings in the CICLOSE box.  

 Click the “Apply” button. 

 

There is a set of possibility to finely tune time stepping for the solver, this is done in the OC file. Due 

to the high number of possibilities and the use of these options only for very specific cases, these are 

not implemented in the interface. So the user shall refer to the USG manual and set the time 

specificities manually in the OC file. 

5.4 Pht3d and PHT-USG Run Settings 

This section is about PHT3D and PHT-USG. When the operation of PHT3D and PHT-USG differs then 

this is specified.  

5.4.1 Time Steps 

In PHT3D and PHT-USG, two different options exist to set the length of reaction time step: 

 Reaction time step coincide with flow time steps (from MODFLOW or MODFLOW USF). Flow 

time step may be subdivided into multiple transport steps for which no reaction is calculated. 

The number of flow time steps plays an important role in simulation result. This number 

depends on the size of the grid and on the value of the kinetics rates. The user should verify 

that increasing the number of flow time steps has no impact on the results (for more details 

see "Time steps" on page 101).  

 Reaction time steps coincide with transport time steps (from MT3DMS or MODFLOW USG 

transport). 

Note that, a third option exists (iterative option) but it is not currently implemented in ORTI3D. 
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To set the option to define the length of reaction time step for the reactive transport model: 

 
 Click on the “Parameter” button under the Parameter/4.Chemistry section. 

 Choose PH in the first drop-down list.  

 Choose ph.1- major flags in the second drop-down list.  

 Set the option to define the length of reaction time step under the OS: splitting 

drop-down list.  

 Click the “Apply” button. 

 

Information about the reaction time step can be found in the PHT3D user guide on page 27, 

located in the Doc folder of your ORTI3D installation folder. 

5.4.2 General Settings 

The following simulation options are available in PHT3D and PHT-USG: 

 TMP_LOC is used to define if the files are written in the local directory or in a temporary 

directory. 

 RED_MODE is a flag that defines whether the starting values in the PHREEQC reaction step 

for pH and pe are variable (i.e., taken from the previous time step) or if they are fixed. Three 

options are available:  

‒ Variable pe and pH. 

‒ Fixed pe and variable pH. 

‒ Fixed pe and pH. 

 TEMP is the temperature used in chemical reaction when temperature dependence is defined 

in the PHT3D database. In PHT3D and PHT-USG, the temperature is in ◦C and the default value 

is 25◦C. Two options are available to specify the temperature used in chemical reaction:  

‒ If a positive number is entered here, this value will be used as the temperature of all the 

cells in the model domain and for all the sources and sinks.  

‒ If a negative integer number is entered, then the absolute value of this number refers to 

the species number that represents the temperature in a simulation that explicitly 

considers the transport of heat. 

 ASBIN is a flag that determines if the computed concentrations for all grid cells and for all 

output times that were defined in the BTN file are written in binary file only or in both binary 

and ASCII output files (extension .ACN).  

 EQSAQU is the threshold concentration value for executing PHREEQC. If the concentration 

change of the mobile species in a cell during the previous reaction step is smaller than 

EQSAQU, no reactions are calculated for that cell. If the value is set to 0 PHREEQC will never 
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be deactivated. If the value is set too high this might result in an inaccurate numerical 

solution. 

 EPSPH is the threshold pH value for executing PHREEQC. Same as previous, except that the 

change of pH during a reaction step is used as criterion. If the value is set to 0 PHREEQC will 

never be deactivated. 

 PACK_SZ is the maximum number of grid cells that are processed in one packet during 

reaction calculations. Three tasks are done when processing a packet: the creation of a single 

PHREEQC input file for PACK_SZ grid cells, the execution of PHREEQC-2 for those grid cells 

and the interpretation of the output file. The optimal value is hardware dependent, but a 

value of 4,000 has shown to work well for most cases. 

To set the options to define the length of reaction time step for the reactive transport model: 

 
 Click on the “Parameter” button under the Parameter/4.Chemistry section. 

 Choose PH in the first drop-down list.  

 Choose ph.1- major flags in the second drop-down list.  

 Set the general settings.  

 Click the “Apply” button. 

 

Information about the PHT3D general settings can be found in the PHT3D user guide on page 27, 

located in the Doc folder of your ORTI3D installation folder. 

5.4.3 Charge Imbalance 

In PHT3D and PHT-USG, the charge imbalance, which occur when the total sum of all positive 

charges (cations) is not equal to the total sum of all negative charges (anions), may be a transported 

property. When solution charge balance is not preserved, unexpected pH and redox conditions will 

result. Therefore, in critical cases more robust model results are obtained if all aqueous solutions that 

are applied in the simulations, either as initial water compositions or at model boundaries, are fully 

charge balanced. However for complex chemistry simulation the simulations sometime need to allow 

small charge imbalance. So for these cases, it can be helpful to allow a small charge imbalance (0.01 

for instance). 

Two options are available in PHT3D and PHT-USG: 

 CB_OFFSET = 0, is the recommended setting, then the charge imbalance is not transported. 

The user must take care in that case that all solutions in the simulation are charge balanced. 

 CB_OFFSET > 0, then the charge imbalance of solutions is transported. 
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To set the charge imbalance option for the reactive transport model: 

 
 Click on the “Parameter” button under the Parameter/4.Chemistry section. 

 Choose PH in the first drop-down list.  

 Choose ph.2- Charge imbalance in the second drop-down list.  

 Set the charge imbalance value under the CB_OFFSET box.  

 Click the “Apply” button. 

 

Information about the charge imbalance can be found in the PHT3D user guide on page 27, located 

in the Doc folder of your ORTI3D installation folder. 

5.4.4 Surface Complexation Setting 

For surface complexation reaction, it is possible to indicate that no electrostatic terms will be used in 

the mass-action equations for surface species and no explicit calculation of the diffuse-layer 

composition is performed. To set this option, the identifier no_edl. An empty box indicates that the 

option is not used. 

To set the surface complexation setting for the reactive transport model: 

 
 Click on the “Parameter” button under the Parameter/4.Chemistry section. 

 Choose PH in the first drop-down list.  

 Choose ph.6- specific options in the second drop-down list.  

 Set the surface complexation setting under the SU_OPT box.  

 Click the “Apply” button. 

 

Information about the Surface complexation setting can be found in the PHT3D user guide on 

page 36, located in the Doc folder of your ORTI3D installation folder. 
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6 Running the Model(s) 

6.1 Write Files and Running MODFLOW and MODFLOW USG 

6.1.1 This section is about MODFLOW and MODFLOW USG. When the 

operation of MODFLOW and MODFLOW USG differs then this is 

specified. Otherwise, the term MODFLOW designates both 

codes.Write MODFLOW Model Files 

When the setup of the flow model is completed, the following step consists to create all files 

necessary to run the MODFLOW model. Each model element (e.g., Rivers, Well, Recharge) was 

developed as add-on packages for the MODFLOW program, and the data for each of these packages 

are stored in separate files. ORTI3D will write all the input files for enabled packages of your flow 

model project and the other files that contain the names of the input and output files, and the 

output options used in the model simulation. 

To write the input MODFLOW model files: 

 
 Click on the “Write” button under the Parameter/2. Flow section. 

 A Files written window will appear.  

 Click the “Ok” button. 

 

6.1.2 Running MODFLOW 

When all files needed by MODFLOW are written in the model project directory, MODFLOW can be 

run.  

To run MODFLOW: 

 
 Click on the “Run” button under the Parameter/2. Flow section. 

 A window command prompt will appear during the MODFLOW execution and will 

disappear automatically at the end of the simulation. 

 A window with the message Normal termination of MODFLOW-2000 will appear. 

To be sure that MODFLOW run correctly, you MUST see this message.  

 Click the “Ok” button. 

 

Note that, if the window command prompt does not appear, it means that the model has not run. 

The main reason may be that the path name of the model project folder includes whether a blank 
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space or special characters. Make sure to remove any blank space or special characters in the path of 

the model project folder. 

During the execution of MODFLOW a number of output files are created: 

 Projectname.flo which contains the flow vectors of each cell for each time step in the 

simulation. This file is required for MT3DMS and PHT3D simulation(s). MT3DMS and PHT3D 

will not run until the file Projectname.flo exists. 

 Projectname.lst 

 Projectname.head 

6.2 Write Files and Running MT3DMS 

6.2.1 Write MT3DMS Model Files 

When the setup of the transport model is completed, the following step consists to create all files 

necessary to run the MT3DMS model. Each model elements (Advection, Dispersion, Sink and source 

mixing) was developed as add-on packages for the MT3DMS program, and the data for each of 

these packages are stored in separate files. ORTI3D will write all the input files for enabled packages 

of your transport model project and the file which contain the names of the input and output files 

used in the model simulation. 

To write the input MT3DMS model files: 

 
 Click on the “Write” button under the Parameter/3. Transport section. 

 A Files written window will appear.  

 Click the “Ok” button. 

 

6.2.2 Running MT3DMS 

When all files needed by MT3DMS are written in the model project directory, MT3DMS can be run.  

To run MT3DMS: 

 
 Click on the “Run” button under the Parameter/3. Transport section. 

 A window command prompt will appear during the MT3DMS execution and will 

disappear automatically at the end of the simulation. 

 A window with the message Normal termination of MT3DMS will appear. To be 

sure that MT3DMS run correctly, you MUST see this message.  

 Click the “Ok” button. 
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During the execution of MT3DMS a number of output files are created: 

 Mt3dms.cnf  

 MT3D001.ucn 

 Mt3dms.out 

6.3 Write Files and Running MODFLOW USG transport 

6.3.1 Write MODFLOW USG transport Model Files 

When the setup of the transport model is completed, the following step consists to create all files 

necessary to run the MODFLOW USG transport model. ORTI3D will write the input file for your 

transport model project and the file which contain the names of the input and output files used in 

the model simulation. 

To write the input MODFLOW USG transport model files: 

 
 Click on the “Write” button under the Parameter/3. Transport section. 

 A Files written window will appear.  

 Click the “Ok” button. 

 

6.3.2 Running MODFLOW USG transport 

When all files needed by MODFLOW USG transport are written in the model project directory, 

MODFLOW USG transport can be run.  

To run MODFLOW USG transport: 

 
 Click on the “Run” button under the Parameter/3. Transport section. 

 A window command prompt will appear during the MT3DMS execution and will 

disappear automatically at the end of the simulation. 

 A window with the message Normal termination of MODFLOW USG transport 

will appear. To be sure that MODFLOW USG transport run correctly, you MUST see 

this message.  

 Click the “Ok” button. 

 

During the execution of MODFLOW USG transport the main output file (including binary values) i is: 

 Projectname.cbb 
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6.4 Write Files and Running PHT3D and PHT-USG 

This section is about PHT3D and PHT-USG. When the operation of PHT3D and PHT-USG differs then 

this is specified.  

6.4.1 Write PHT3D or PHT-USG Model Files 

When the setup of the reactive transport model is completed, the following step consists to create all 

files necessary to run the PHT3D or PHT-USG model. Each model elements (Advection, Dispersion, 

Sink and source mixing, Chemistry) was developed as add-on packages for the PHT3D or PHT-USG 

program, and the data for each of these packages are stored in separate files. ORTI3D will write all 

the input files for your reactive transport model project used in the model simulation. 

To write the input PHT3D or PHT-USG model files: 

 
 Click on the “Write” button under the Parameter/4. Chemistry section. 

 A Files written window will appear.  

 Click the “Ok” button. 

6.4.2 Running PHT3D or PHT-USG 

When all files needed by PHT3D or PHT-USG are written in the model project directory, PHT3D or 

PHT-USG can be run.  

To run PHT3D or PHT-USG: 

 
 Click on the “Run” button under the Parameter/3. Transport section. 

 A window command prompt will appear during the PHT3D or PHT-USG execution 

and will disappear automatically at the end of the simulation. 

 A window with the message Normal termination of PHT3D or PHT-USG will 

appear. To be sure that PHT3D or PHT-USG run correctly, you MUST see this 

message.  

 Click the “Ok” button. 

 

During the execution of PHT3D or PHT-USG a number of output files are created: 

 MT3D.cnf (only for PHT3D) 

 phinp.dat 

 phout.dat 

 phreeqc.txt 

 pht3d.m 
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 Pht3d.out (only for PHT3D) 

 pht3d.py 

 pht3d_input_check.dat 

 PHT3D_OUTPUT_TIMES.acn 

 For PHT3D: PHT3D001.ucn, PHT3D002.ucn, PHT3D00n.ucn, with n the number of species 

in the model  

 For PHT-USG: PHT3D001.acn, PHT3D002.acn, PHT3D00n.acn, with n the number of species 

in the model  

 



 

ORTi3D User’s Manual – v2.1 132 September 2021 

7 Results Section – Displaying Model Results 

7.1 Maps 

ORTI3D displays three different types of maps: 

 Contour maps. 

 Pathline maps. 

 Velocity vectors maps. 

7.1.1 Contour Maps 

7.1.1.1 Selecting Output Times 

Model output time is the time at which the results are saved and displayed. In ORTI3D, model output 

time is managed in the same way for all type of model project (MODFLOW series and MIN3P model), 

for more details see “Model output time” on page 26. 

To select the output time to display for the current contour map: 

 Select a time step in the Tspep drop-down list under the Results/1.Model section. 

 After selecting a time step, you can use the mouse wheel to display the result at different 

time.  

7.1.1.2 3D Model Visualization Options 

3D visualization is not currently available in ORTI3D. For 3D model, results may be displayed 

following different planes: 

 X plane: results are displayed from a fixed X value (i.e., a cross section following X value). 

 Y plane: results are displayed from a fixed Y value (i.e., a cross section following Y value). 

 
Z plane: results are displayed from a fixed Z value (i.e., a horizontal plane). 

 

To select the plane to display for the current contour map: 

 Select X, Y or Z in the Plane drop-down list under the Results/1.Model section. 

X, Y or Z value may be change by selecting the layer number for the current plane.  

To select the layer to display for a given plane and for the current contour map: 

 Select the layer number for the X, Y or Z plane in the Layer drop-down list under the 

Results/1.Model section. 
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7.1.1.3 Head Contour Lines 

When flow simulation is performed with ORTI3D, the head contour lines can be displayed by the 

following action: 

 Check the Head box under the Results/2.Flow section. 

The calculated head of the flow simulation performed are loaded, and the head contours are 

displayed corresponding to the selected output time and the selected plane and layer for 3D model. 

7.1.1.4 Velocity Contour Lines 

When flow simulation is performed with ORTI3D, the Darcy flow velocity contour lines can be 

displayed by the following action: 

 Check the Veloc-magn box under the Results/2.Flow section. 

The calculated Darcy flow velocity of the flow simulation performed are loaded, and the velocity 

contours are displayed corresponding to the selected output time and the selected plane and layer 

for 3D model. 

7.1.1.5 Water Content Contour Lines 

When unsaturated flow simulation is performed with ORTI3D (MODFLOW-UZF), the water content 

contour lines can be displayed by the following action: 

 Check the Wcontent box under the Results/2.Flow section. 

The calculated water content of the unsaturated flow simulation performed are loaded, and the 

water content contours are displayed corresponding to the selected output time and the selected 

plane and layer for 3D model. 

7.1.1.6 Solute Concentration Contour Lines  

When transport simulation is performed with ORTI3D, the solute concentration contour lines can be 

displayed by the following action: 

 Check the Tracer box under the Results/3.Transport section. 

The calculated solute concentrations of the transport simulation performed are loaded, and the 

solute concentration contours are displayed corresponding to the selected output time and the 

selected plane and layer for 3D model. 
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7.1.1.7 Chemical Species Concentration Contour Lines 

When reactive transport simulation is performed with ORTI3D for multiple species, the species of 

interest concentration contour lines can be displayed by the following action: 

 Select a chemical species in the Species drop-down list under the Results/4.Chemistry 

section. 

The concentration units may be changed by the following action: 

 Select a unit in the Units drop-down list under the Results/4.Chemistry section. 

The calculated concentrations of the selected species are loaded, and the concentration contours are 

displayed corresponding to the selected output time and the selected plane and layer for 3D model. 

ORTI3D has an import option to import user species or postfix species for which calculations may be 

performed from the model results (for more details see “Import user species” on page 13 and 

“Import Postfix species” on page 14). The user or postfix species results can be displayed by the 

following action: 

 Select a user chemical species in the User drop-down list under the Results/4.Chemistry 

section. 

7.1.1.8 Contour Map Display Options 

The contour map appearance may be customized by selecting the “C” button at the right of the 

contour map being displayed. A contour options window will appear, similar to the following figure, 

with options described as follows: 

 



 

ORTi3D User’s Manual – v2.1 135 September 2021 

 Automatic: When the Automatic box is checked, the values for the minimum and maximum 

contour values and the contour interval are automatically calculated by ORTI3D each time the 

view is changed (new layer/row/column or output time). 

 Mini: This sets the minimum contour value, below which no contour lines will be plotted. This 

setting is ignored if the Automatic contour levels option is selected. 

 Maxi: This sets the maximum contour value, above which no contour lines will be plotted. 

This setting is ignored if the Automatic contour levels option is selected. 

 Interval: This sets the contour increment value, starting from the minimum value. This setting 

is ignored if the Automatic contour levels option is selected. 

 Decimals: This sets the number of decimals to plot for each contour line label. This setting is 

available if the Automatic contour levels option is or is not selected. 

 Log: This sets the contour increment value in logarithm, starting from the minimum value. 

This setting is ignored if the Automatic contour levels option is selected. 

 List of values: This sets a list of user-specified values for contours. Check the List of values 

box and click on the “List of values” button. A List of values window will appear. You can 

indicate any number of values, in ascending order, one on each line and click the “OK” 

button. This setting is ignored if the Automatic contour levels option is selected. 

7.1.1.9 Exporting Contour Map and Data 

The simulation result for a selected output time and the selected plane and layer for 3D model can 

be exported to graphics image files or to ASCII data files. For information on exporting contour map 

and data refer to “Export options” on page 16.  

7.1.2 Pathline Maps 

7.1.2.1 Pathline Display 

The pathlines map represents a historical travel of the groundwater particles. The displayed pathline 

of a forward particle in ORTI3D is presented in the following figure. The red line represents the path 

of the particle. Each number displayed is the time at which the particle reached this location. To 

simulate particle trajectories for your flow model, see “Particles” on page 57. 
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The pathline maps can be either active or hidden by checking or unchecking the Particles checkbox 

under the Results/2.Flow section.  

7.1.2.2 Pathline Display Options 

The pathline map appearance may be customized by selecting the “C” button at the right of the 

Particles checkbox. A Particles window will appear, with options described as follows: 

 Color: sets the color of the pathline.  

 Time: sets the time steps to display. 

7.1.2.3 Exporting Pathline Map 

The pathline map can be exported to graphics image files. For information on exporting pathline 

map refer to “Exporting the model display area” on page 16.  

7.1.3 Velocity Vectors Maps 

7.1.3.1 Velocity Vectors Maps Display 

In ORTI3D, the Darcy flow velocity vectors can be displayed in each model grid cell by the following 

action: 

 Check the Veloc-vect box under the Results/2.Flow section. 
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7.1.3.2 Velocity Vectors Display Options 

The velocity vectors map appearance may be customized by selecting the “C” button at the right of 

the Veloc-vect checkbox. A Veloc-vect window will appear, with options described as follows: 

 Color: set the color of the vectors.  

 Scale: set the length of the vectors. 

7.1.3.3 Exporting Velocity Vectors Map 

The velocity vectors map can be exported to graphics image files. For information on exporting 

velocity vectors map refer to “Exporting the model display area” on page 16.  

7.2 Graphs 

ORTi3D has a multiple graph display option of the following four different types: 

 Time-series graphs. 

 Horizontal and vertical profile graphs. 

 Calibration graphs. 

Two features are added to the classic graphics options: 

 Mass balance graphs. 

 Zone budget graphs. 

7.2.1 Observation Zones 

7.2.1.1 Create Observation Zones 

To visualize the simulation result at a specific location it is necessary to create an observation zone. 

In ORTI3D, observation zones are defined as distributed property values (for more details see “Tools 

for assigning and editing distributed input data” on page 28) and may be: 

 Set zones (point zone, line zone, rectangle zone or polygon zone) of value. 

 Import point zone values. 

Note that for line, rectangle and polygon zone, ORTI3D will calculate the mean of the cell values in 

the zone. 

To create an observation zone: 

 Choose Observation – OBS – obs.1 observation in the first three drop-down list under the 

Spatial Attributes section. 

 Create an observation zone with the desired tool for assigning and editing distributed input 

data. 
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Once the grid cells have been selected using one of the Add Zones options, a Zone window will 

appear. For the observation zone, set the following in this window: 

 The name of the zone in the Zone name box. 

 Zone coordinates to modify zone location in the Zone coords box. They can also be copy 

paste to create new zone at the same location. This is useful for the situation where you have 

to set a boundary condition and a value specified at the same location for example.  

The media(s) to assign the zone (Zone media box), the temporal scheme (Temporal drop-down list) 

and the value of the distributed data to assign at the zone (Zone value box) do not have to be set 

for observation zone. This information is not used by ORTI3D to display graphs results.  

7.2.2 Type of Graphs 

 

7.2.2.1 Time-Series Graphs 

A time-series graph plots the change in a selected variable with time. In groundwater flow and 

contaminant transport modeling, time-series graphs are used to evaluate and compare temporal 

trends in the calculated Head, Water content, Tracer or Chemical Species Concentration at selected 

observation zones. 
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To display a Time-Series Graph: 

 Select Time-Series Graph in the Type drop-down list under the Results/5.Observation 

section. 

 Select the simulation result to display in the Result drop-down list under the 

Results/5.Observation section: 

‒ Flow for flow simulation. 

‒ Transport for transport simulation. 

‒ Chemistry for reactive transport simulation.  

 A Plot of result window will appear. 

 Select the desired Observation zones and Layers. 

 Press the Apply button to display or update the Time-Series Graph. 

Observation Zones and Layers 

The model Observation zone specified in the model are listed under the Zones tab. The 

Observation zone displayed on the graph can be selected under the Zones tab. 

The Layers of the model are listed under the Layers tab. The model layers at which the simulation 

results are recorded can be selected under the Layers tab. 

Once the desired Observation zones and Layers are selected, press the Apply button to display or 

update the Time-Series Graph. 

Reactive Transport Result 

For reactive transport simulations involving multiple chemical species, an additional tab labelled 

Species will appear beside the Group and Points tabs. The Species tab contains the list of the 

Chemical Species being simulated by the model. One or more of these species can be selected to 

plot on the Time-Series Graph. 

Multiplot option can be display by the following action: 

 Observation zone: One graph for each selected Observation zone. 

 Chemical species: One graph for each selected Chemical species. 

To change the multiplot option: 

 Select By zone or By species in the drop-down list.  

Observed Data 

To display observed data on Time-Series Graph: 

 Check the Observed data checkbox. 

 Press the Apply button to display or update the Time-Series Graph. 
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Export Result 

Simulated data at selected Observation zone and Layers can be exported by doing the following: 

 Press the Export button. 

 A Save window will appear. Navigate to the directory where you want to save the ASCII data 

file.  

 Indicate the file name and then click the “Save” button. 

7.2.2.2 Horizontal Profile Graphs 

A Profile graph plots the change in a selected variable in space. In groundwater flow and 

contaminant transport modeling, Profile graphs are used to evaluate and compare spatial trends in 

the calculated Head, Tracer or Chemical Species Concentration at selected observation zones. 

To display a Profile Graph: 

 Select Profile Graph in the Type drop-down list under the Results/5.Observation section. 

 Select the simulation result to display in the Result drop-down list under the 

Results/5.Observation section: 

‒ Flow for flow simulation. 

‒ Transport for transport simulation. 

‒ Chemistry for reactive transport simulation.  

 A Plot of result window will appear. 

 Select the desired Observation zones and Layers. 

 Press the Apply button to display or update the Profile Graph. 

Observation Zones and Layers 

The model Observation zone specified in the model are listed under the Zones tab. The 

Observation zone displayed on the graph can be selected under the Zones tab. 

The Layers of the model are listed under the Layers tab. The model layers at which the simulation 

results are recorded can be selected under the Layers tab. 

Once the desired Observation zones and Layers are selected, press the Apply button to display or 

update the Profile Graph. 

Reactive Transport Result 

For reactive transport simulations involving multiple chemical species, an additional tab labelled 

Species will appear beside the Group and Points tabs. The Species tab contains the list of the 

Chemical Species being simulated by the model. One or more of these species can be selected to 

plot on the Profile Graph. 
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Multiplot option can be displayed by doing the following: 

 Observation zone: One graph for each selected Observation zone. 

 Chemical species: One graph for each selected Chemical species. 

To change the multiplot option: 

 Select By zone or By species in the drop-down list.  

Observed Data 

To display observed data on Profile Graph: 

 Check the Observed data checkbox. 

 Press the Apply button to display or update the Profile Graph. 

Export Result 

Simulated data at selected Observation zone and Layers can be exported by doing the following: 

 Press the Export button. 

 A Save window will appear. Navigate to the directory where you want to save the ASCII data 

file.  

 Indicate the file name and then click the “Save” button. 

7.2.2.3 Vertical profile graphs 

A Vertical Profile graph plots the change in a selected variable in space along z-axis. In groundwater 

flow and contaminant transport modelling, Vertical Profile graphs are used to evaluate and compare 

vertical spatial trends in the calculated Head, Tracer or Chemical Species Concentration at selected 

observation zones. 

To display a Vertical Profile Graph: 

 Select Vertical Profile Graph in the Type drop-down list under the Results/5.Observation 

section. 

 Select the simulation result to display in the Result drop-down list under the 

Results/5.Observation section: 

‒ Flow for flow simulation. 

‒ Transport for transport simulation. 

‒ Chemistry for reactive transport simulation.  

 A Plot of results window will appear. 

 Select the desired observation Zones and Layers. 

 Press the Apply button to display or update the Vertical Profile Graph. 
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Observation Zones and Layers 

The model Observation Zones, specified in the model, have been identified under the Zones tab. 

The Observation zone displayed on the graph can be selected under the Zones tab. 

The Layers of the model are listed under the Layers tab. The model layers at which the simulation 

results are recorded can be selected under the Layers tab. 

Once the desired Observation zones and Layers are selected, press the Apply button to display or 

update the Profile Graph. 

Reactive transport result 

For reactive transport simulations involving multiple chemical species, an additional tab labelled 

Species will appear beside the Group and Points tabs. The Species tab contains the list of the 

Chemical Species being simulated by the model. One or more of these species can be selected to 

plot on the Profile Graph. 

Multiplot option can be display by: 

 Observation zone: One graph for each selected Observation zone. 

Export Result 

Simulated data at selected Observation zone and Layers can be exported by: 

 Press the Export button. 

 A Save window will appear. Navigate to the directory where you want save the ASCII data file.  

 Indicate the file name and then click the “Save” button. 

7.2.2.4 Calibration Graph 

ORTi3D provides a Calculated vs. Observed scatter graph for evaluating the model calibration.  

To display a Calibration Graph: 

 Select Calibration Graph in the Type drop-down list under the Results/5.Observation 

section. 

 Select the simulation result to display in the Result drop-down list under the 

Results/5.Observation section: 

‒ Flow for flow simulation. 

‒ Transport for transport simulation. 

‒ Chemistry for reactive transport simulation.  

 A Plot of result window will appear. 

 Select the desired Observation zones. 
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 Press the Apply button to display or update the Profile Graph. 

Calibration Times 

The Calculated vs. Observed Scatter Graph represent a snap-shot in time of the comparison between 

the calculated and observed values. For transient simulation, the calibration may be evaluated at 

different times or for all times where observed data are available. 

To select the option time at which the calibration graph is displayed:  

 Select the desired time in the Time drop-down list.  

 Select All to display the calibration graph at all times where observed data are available. 

Export Result 

Calculated vs. Observed data at selected Observation zone can be exported by doing the following: 

 Press the Export button. 

 A Save window will appear. Navigate to the directory where you want to save the ASCII data 

file.  

 Indicate the file name and then click the “Save” button. 

7.2.3 Mass balance Graphs 

The governing equation of both the groundwater flow, and the mass transport, are based on a 

mathematical statement of mass conservation, such that the mass of water or chemicals entering 

the system through various sources should equal the mass of water or chemicals leaving the system 

through the various sinks. The Mass balance Graphs provide graphical representations of the mass of 

water or chemicals entering and leaving the system through the various sources and sinks. 

7.2.3.1 Flow Mass balance Graphs 

The Flow Mass balance Graphs plot the volumes of water and volumetric flow rates into (sources) or 

out (sinks) of the model as a whole at the end of each stress period.  

There are four different Flow Mass balance Graphs: 

 Percent Discrepancy: plots the temporal changes in the Flow Mass balance (total flow IN 

minus total flow OUT) expressed as a percentage of the total flow. 

 IN - OUT plots the temporal change in the Flow Mass balance (total flow IN minus the total 

flow OUT). 

 Time Series plots the temporal flows IN and OUT of the system through the individual sources 

and sinks (flow boundary conditions and storage). 
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 Time step plots a bar chart of the flow IN to the system and the flow OUT of the system 

through the individual sources and sinks (flow boundary conditions and storage) for selected 

Output Times. 

To display a Flow Mass balance Graphs: 

 Select Mass balance Graphs in the Type drop-down list under the Results/5.Observation 

section. 

 Select Flow in the Result drop-down list under the Results/5.Observation section  

 A Plot of result window will appear. 

 Select the desired Type of graph in the first drop-down list. 

 Press the Apply button to display or update the Flow Mass balance Graph. 

Cumulative volume or flow rate 

The volumetric budget can be plot as the flow rates for the last time step or as cumulative volumes 

from the beginning of simulation for each component of flow. By default, the volumetric budget 

window plots the flow rates for the last time step.  

The second drop-down list can be used to select plotting Cumulative volume or flow Rate. 

Note: the Percent Discrepancy graph presents only the percent error at each time step. 

Sources and Sinks 

All potential sources and sinks for the current flow model (boundary conditions not included in the 

model will not be listed) are listed under the In (sources) and Out (sinks) tabs.  

These checkbox can be used to add or remove the individual source and sink terms from either the 

Time Series graph or the Time step graph. 

The Percent Discrepancy graph and the IN-OUT graph consider only the total flow into and out-of 

the entire system as a whole. As a result, the settings for the individual In and Out terms do not 

influence the results and appearance of these graphs. 

7.2.3.2 Transport and Chemistry Mass balance Graphs 

The Transport Mass balance Graphs plot the mass of tracer or chemical species entering and leaving 

the system through all sources and all sinks, and the total mass of tracer or chemical species 

remaining in the system at the end of each stress period.  

There are three different Transport Mass Balance Graphs: 

 Percent Discrepancy plots the temporal changes in the Transport Mass Balance (cumulative 

mass IN minus cumulative mass OUT) expressed as a percentage of the cumulative mass IN. 
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 Time Series plots the temporal changes in mass entering, remaining, and leaving the system. 

 Time step plots a bar chart of the mass that has entered, mass that remains, and mass that 

has left the system, at a specified Output Time. 

To display a Transport or Chemistry Mass balance Graphs: 

 Select Mass balance Graphs in the Type drop-down list under the Results/5.Observation 

section. 

 Select Transport or Chemistry in the Result drop-down list under the 

Results/5.Observation section  

 A Plot of result window will appear. 

 Select the desired Type of graph in the first drop-down list. 

 Press the Apply button to display or update the Transport or Chemistry Mass balance Graph. 

Cumulative mass or mass loading rate 

The mass budget can be plot as the mass loading rates for the last time step or as cumulative mass 

from the beginning of simulation. By default, the mass budget window plots the cumulative mass 

from the beginning of simulation.  

The second drop-down list can be used to select plotting Cumulative mass or mass loading Rate. 

Note: the Percent Discrepancy graph presents only the percent error of the cumulative mass. 

MT3DMS  

Sources and sinks for MT3DMS transport model are listed under the In/Out tab and are the 

following: 

 TOTAL IN is the mass added to the system through sources, and reduction in mass storage, 

 TOTAL OUT is mass removed from the system through sources, and increase in mass storage, 

 SOURCE IN is the mass entering through sources, 

 SINKS OUT is the mass leaving the system through sinks,  

 TOTAL MASS IN AQUIFER is the mass remaining. 

These checkbox can be used to add or remove the source and sink terms from either the Time Series 

graph or the Time step graph. 

The Percent Discrepancy graph considers only the total mass into and out-of the entire system as a 

whole. As a result, the settings for the individual In and Out terms do not influence the results and 

appearance of these graphs. 
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PHT3D  

For reactive transport simulations involving multiple chemical species, a third drop-down list labeled 

Species will be present. The Species drop-down list contains the list of the Chemical Species being 

simulated by the model. One of these species can be selected to plot on the Chemistry Mass balance 

Graphs. 

All potential sources and sinks for the current reactive transport model (boundary conditions not 

included in the model will not be listed), the mass transfers due to both transport and chemical 

reaction are listed under the In (sources) and Out (sinks) tabs.  

These checkbox can be used to add or remove the individual source and sink terms from either the 

Time Series graph or the Time step graph. 

The Percent Discrepancy graph considers only the total mass into and out-of the entire system as a 

whole. As a result, the settings for the individual In and Out terms do not influence the results and 

appearance of these graphs. 

7.2.3.3 Export Result 

Mass balance data can be exported as ASCII text file: 

 Press the Export button under the plot. 

 A Save window will appear. Navigate to the directory where you want save the ASCII data file.  

 Indicate the file name and then click the “Save” button. 

7.2.4 Zone budget Graphs 

Zone Budget is USGS program that reads cell to cell flow data produced by MODFLOW and 

calculates water budgets for subregions of the modeled area. The Zone Budget program essentially 

calculates the flow mass balance for each user observation zone. 

For (reactive) transport simulations, the transport mass balance can also be calculated for user 

observation zones, either if MT3DMS or PHT3D are being used. 

7.2.4.1 Flow Zone budget Graphs 

The Flow Zone budget Graphs plot the flow rates of water entering and leaving the user-defined 

zones through the flow boundary conditions, from aquifer storage, and through other user-defined 

zones. 

There are four different Flow Zone budget Graphs: 

 Percent Discrepancy: plots the temporal changes in the Flow Mass balance for the selected 

zone (total flow IN minus total flow OUT) expressed as a percentage of the total flow. 
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 IN - OUT plots the temporal change in the Flow Mass balance for the selected zone (total flow 

IN minus the total flow OUT). 

 Time Series plots the temporal flows IN and OUT of the selected zone through the individual 

sources and sinks (flow boundary conditions and storage). 

 Time step plots a bar chart of the flow IN to the system and the flow OUT of the system 

through the individual sources and sinks (flow boundary conditions and storage) for selected 

Output Times. 

To display a Flow Zone budget Graphs: 

 Select Zone budget Graphs in the Type drop-down list under the Results/5.Observation 

section. 

 Select Flow in the Result drop-down list under the Results/5.Observation section  

 A Plot of result window will appear. 

 Select the desired Type of graph in the first drop-down list. 

 Press the Apply button to display or update the Flow Zone budget Graph. 

Cumulative volume or flow rate 

The volumetric zone budget can be plot as the flow rates for the last time step or as cumulative 

volumes from the beginning of simulation for each component of flow. By default, the volumetric 

budget window plots the flow rates for the last time step.  

The second drop-down list can be used to select plotting Cumulative volume or flow Rate. 

Note: the Percent Discrepancy graph presents only the percent error at each time step. 

Selecting Zones 

The third drop-down list a list of the Zone Budget zones available for the current model. The Zone 

Budget graphs will display the Zone Budget data for the selected Zone Budget zone. 

Sources and Sinks 

All potential sources and sinks for the current flow model (boundary conditions not included in the 

model will not be listed) and the other user-defined zones are listed under the In (sources) and Out 

(sinks) tabs.  

These checkbox can be used to add or remove the individual source and sink terms from either the 

Time Series graph or the Time step graph. 
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The Percent Discrepancy graph and the IN-OUT graph consider only the total flow into and out-of 

the entire system as a whole. As a result, the settings for the individual In and Out terms do not 

influence the results and appearance of these graphs. 

In order to get flow on specific faces of zone 1 it is necessary to create a zone 2 in the neighboring 

cells of the selected zone 1 face, then the flow from zone 1 to zone 2 will appear in the dialog box. 

7.2.4.2 Transport and Chemistry Zone budget Graphs 

The Transport Zone budget Graphs plot the mass of tracer or chemical species in the user-defined 

zones at the end of each stress period. The volume of water in each cell is calculated and then 

multiplied by the concentration computed by MT3DMS or PHT3D. 

There are two different Transport Zone budget Graphs: 

 Time Series plots the temporal changes of mass in the selected zone budget.  

 Time step plots a bar chart of the mass in the selected zone budget at a specified Output 

Time. 

To display a Transport or Chemistry Zone budget Graphs: 

 Select Zone budget Graphs in the Type drop-down list under the Results/5.Observation 

section. 

 Select Transport or Chemistry in the Result drop-down list under the 

Results/5.Observation section  

 A Plot of result window will appear. 

 Select the desired Type of graph in the first drop-down list. 

 Press the Apply button to display or update the Transport or Chemistry Zone budget 

Graph. 

Cumulative mass or mass loading rate 

The mass zone budget can be plot as the mass loading rates for the last time step or as cumulative 

mass from the beginning of simulation. By default, the mass budget window plots the cumulative 

mass from the beginning of simulation.  

The second drop-down list can be used to select plotting Cumulative mass or mass loading Rate. 

Selecting Zones 

The user-defined zones available for the current model are listed under the Zones tab. The Zone 

Budget graphs will display the Zone Budget data for the selected Zone Budget zone. 
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PHT3D  

For reactive transport simulations involving multiple chemical species, a third drop-down list labeled 

Species will be present. The Species drop-down list contains the list of the Chemical Species being 

simulated by the model. One of these species can be selected to plot on the Chemistry Zone budget 

Graphs. 

7.2.4.3 Export Result 

Zone budget data can be exported as ASCII text file: 

 Press the Export button under the plot. 

 A Save window will appear. Navigate to the directory where you want save the ASCII data file.  

Indicate the file name and then click the “Save” button. 

7.2.5 Types of Results 

The types of simulation results to display in the Result drop-down list under the 

Results/5.Observation section are: 

 Flow for flow simulation. 

 Transport for transport simulation. 

 Chemistry for reactive transport simulation.  

For each of these types of simulation different results may be plot:   

 Flow: Head and Water content. 

 Transport and Chemistry: Concentrations, weighted concentrations, mass discharge and 

mass flux. 

The different results may be selected in the Type of result drop-down list located in the Plot of 

results window. 

7.2.5.1 Head 

The value of head may be plot. Hydraulic head unit is [L]. 

7.2.5.2 Wcontent 

The Value of the water content may be plot. Water content has no unit [-]. Water content is available 

for this model: 

 MODFLOW UZF 

 MODFLOW USG 
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7.2.5.3 Tracer and chemical species concentrations 

The value of tracer and chemical species concentrations can be plotted. Tracer concentrations unit 

is [ML-3] and chemical species concentrations unit is [NL-3]. 

7.2.5.4 Weighted concentration 

Weighted concentration is calculated by weighing the concentration by the water flux passing 

through each section. It is equivalent to the total flux divided by the area of the zone perpendicular 

to the flow. It is mainly useful to see the average concentration pumped in a well which is pumping 

in several cells. Tracer and chemical species weighted concentrations unit is the same as 

concentration respectively [ML-3] and [NL-3].  

7.2.5.5 Mass discharge (Md) 

Mass discharge is the water discharge through an area (Darcy flux) multiplied by the concentration. 

Tracer and chemical species mass discharge unit is respectively [MT-1] and [NT-1]. 

7.2.5.6 Mass Flux (J) 

Mass flux (J) is the mass discharge divided by the total area of the zone. Tracer and chemical species 

mass discharge unit is respectively [ML-2T-1] and [NL-2T-1]. 

7.2.6 Customizing the Graphs 

The Results Graphs are all plotted using the same graphing component. The display options for 

exploring, customizing the appearance, and for save the graphs are available in a Toolbox located 

below the plot. 

7.2.6.1 The toolbox 

The Toolbox section contains the following options: 

 Back to the initial plot view. 

 Redo undo the view of the plot 

 Dragging the plot to a new position. 

 Zoom in the plot. 

 Modify the margin of the plot. 

 
Opens the Graph Properties window, as described in “Graph Properties” section 

bellow. 
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 Save the plot as files with the following extensions: png, ps, eps, svg and pdf. 

 x and y value of the mouse position in the plot.  

7.2.6.2 Graph properties 

The appearance properties of the graph can be modified by clicking the Graph Properties icon from 

the toolbox. 

The Graph Properties window for the graph will appear, as shown in the following figure: 

 

The Graph Properties window contains two tabs listing the appearance settings for the categories 

described in the following sections. 

7.2.6.3 Axes 

The Axes settings tab controls the appearance of the X and Y axes on the graph, including the 

minimum and maximum axes values, axes labels and scale. 

7.2.6.4 Curves 

The Curves settings tab is used to control the appearance of each data series, and how they are 

plotted on the graph. 

 



 

ORTi3D User’s Manual – v2.1 152 September 2021 

8 Parameter Optimization: PEST 

ORTI3D allow writing the main PEST files and running PEST. One file MUST be provided in the model 

project directory:  

 The observation file, which MUST be called « pest_obs.txt ». 

8.1 PEST Input Data 

8.1.1 PEST Parameters 

In ORTI3D, parameters to optimize may be selected from the interface. There are two different types 

of parameters: 

 Background parameters: distributed model parameters for which the value is applied in all 

cells of your model (for more details see “Background Value” on page 28). 

 Zone parameters: distributed model parameters for which the value is applied in zones (for 

more details see “Creating Zone” on page 28). 

To select PEST background parameters: 

 
 Click on the “PEST background parameters” button under the Parameter/5.PEST 

section. 

 Select the type of parameters that you want to optimize. Note that there is 

different tab for flow, transport and reactive model parameters.  

 Click the “Ok” button. 

 Check the “Use” box of the parameters to optimize and choose: 

‒ The min and max value of the parameter values during the optimization 

(cf. PEST manual).  

‒ The transformation of parameter during the optimization (cf. PEST 

manual). 

‒ The name of the group to assign each parameter to (cf. PEST manual).  

Note that there are different tabs for flow, transport and reactive model 

parameters.  

 Click the “Ok” button. 

 

To select PEST zone parameters: 

 
 Click on the “PEST zone parameters” button under the Parameter/5.PEST section. 

 Select the type of parameters that you want to optimize. Note that there is 

different tab for flow, transport and reactive model parameters.  
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 Click the “Ok” button. 

 Check the “Use” box of the parameters to optimize and choose: 

‒ The min and max value of the parameter values during the optimization 

(cf. PEST manual).  

‒ The transformation of parameter during the optimization (cf. PEST 

manual). 

‒ The name of the parameter group to assign each parameter to (cf. PEST 

manual).  

Note that there is different tab for flow, transport and reactive model parameters.  

 Click the “Ok” button. 

 

8.1.2 PEST Observations 

The data file formats currently supported by ORTI3D for the observation file (pest_obs.txt) is ASCII 

text files (.TXT). The file must contain on the first line the keywords Type, Well, Time, Value, Weight 

and Group and on the following lines your PEST observations information. This information has to 

be provided on one line for each point, as follows (in bold the key words that must contain the file 

and between hook the information provided by the modeler): 

Type Well Time Value Weight Group 

‘Type’ ‘Name’ ‘Time’ ‘Value’ ‘Weight’ ‘Group’ 

… … … … … … 

… … … … … … 

‘Type’ ‘Name’ ‘Time’ ‘Value’ ‘Weight’ ‘Group’ 

 

‘Type’ is the keyword used to specify the type of observation or the name of species for chemical 

observations: 

 For flow model ‘type’ = Head. 

 For transport model: ‘type’ = Tracer. 

 For reactive transport model: ‘type’ = the name of the chemical specie. 

‘Name’ is the name of the observation zone.  

‘Time’ is the time at which the simulated values at the observation zone are read.  

‘Value’ is the value of the observed data.  

‘Weight’ is the weight of the value of the observed data (cf. PEST manual). 
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‘Group’ is the name of the observation group to assign each observation to (cf. PEST manual). 

For example: 

Type Well Time Value Weight Group 

Head obs1 50 10.5 1 GPH 

Tracer obs1 50 500 1 GPT 

 

8.2 PEST Run Settings 

To set PEST run settings: 

 
 Click on the “Parameter” button under the Parameter/5.PEST section.  

 Choose the category of settings in the first drop-down list.  

 Choose the subcategory of settings in the second drop-down list.  

 Modify or select your variable. 

 Click the “Apply” button. 

 

The category of PEST run settings are: 

SYS: To select the operating system used to run the model and specify the path of model project 

directory. On sys.1: If you use ORTI3D on windows and run PEST on windows then select windows. In 

this case, the pest file will be written in your model project directory. If you use ORTI3D on windows 

and run PEST on Linux, then select Linux. In this last case you can specify the model project directory 

path used on Linux on sys.2. 

CTD: To specify the variables in “control data” section of PEST control file (cf. PEST manual). 

SVD: To specify the variables in “singular value decomposition” section of PEST control file (cf. PEST 

manual). 

PGR: To specify the variables required for each parameter group in “parameter groups” section of 

PEST control file (cf. PEST manual).  

OBS: To specify observation transformation for the computation of objective function (for advance 

users).  

REG: To specify the variables in optional “regularization” section of PEST control file (cf. PEST 

manual). To use this option PESTMODE have to be selected on regularization: Select regularization 

under Parameter/5.PEST section CTD/ctd.1-Control Data l1/PESTMODE. 
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PPP: To specify the variables in optional “PEST++” section of PEST control file (cf. PEST++ manual). 

Information about the PEST file parameters can be found in the PEST user guide on page 95, 

located in the Doc folder of your ORTI3D installation folder. 

8.3 Running PEST 

8.3.1 Write PEST Files 

To write PEST files: 

 
 Click on the “Write” button under the Parameter/5.PEST section.  

 A files written window will appear.  

 Click the “Ok” button. 

 

The following files have been created: 

 runmod.bat: This is the batch file that PEST will run as “the model.” First the pre-processing 

code scriptPest1.py is running following by the model (MODFLOW or/and MT3DMS and 

PHT3D). To finish the post-processing code scriptPest2.py is executed.  

 pest_tpl.txt: is the template file used by PEST to write the optimized parameters in the file 

pest_run.txt.  

 scriptPest1.py: script used to write the new optimized parameter into the model project files 

(.orti files) and rewrite the input model files.  

 scriptPest2.py: allow to read the simulated observation values from the model output and 

write them in the file pest_out.txt. 

 pest.ins: an instruction file allowing PEST to read the file pest_out.txt. 

8.3.2 Check PEST Files 

ORTI3D use the pestchek application of the PEST suite to check if the pest files are correctly written. 

To check if there is no error in PEST files: 

 
 Click on the “Pestchek” button under the Parameter/5.PEST section.  

 A message will appear in the window command prompt. Read the message in the 

cmd to check if there is error.  

 Press a key to continue in the cmd. 

 A file checked window will appear.  

 Click the “Ok” button. 
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8.3.3 Running Pest 

When all files needed by PEST are written in the model project directory, PEST can be run.  

To run PEST: 

 
 Click on the “Run” button under the Parameter/5.PEST section. 

 A window command prompt will appear during the PEST execution and will 

disappear automatically at the end of the simulation. 

 At the end of the simulation, a window with the message Normal termination of 

PEST will appear.  

 Click the “Ok” button. 

 



 

ORTi3D User’s Manual – v2.1 157 September 2021 

9 Batch Option 

9.1 Open Batch Window 

In ORTI3D, a batch function is available to run Python scripts from the interface. All Python function 

may be used to perform any type of calculation. In groundwater flow and contaminant transport 

modeling the main use of batch function may be: 

 A specific way to display output data,  

 Running a model with multiple times with different parameters.  

To open the batch function in ORTI3D: 

 Select Add-In/Batch from the Main menu section. A Batch program window will appear.  

 Edit any Python scripts/commands under this window.  

 Click the “OK” button to run the scripts. 

 

 

Some basic Python functions are available in ORTI3D for modifying parameters, writing model files, 

running model and getting the results. These functions are presented in the following section.  
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9.2 Write Files, Run and Save Model 

9.2.1 Write Model Files 

The Python function used to write model files is: 

core.writeModel ('Model', info=False) 

Replace 'Model' by the suitable type of model: 

 ‘Modflow’ 

 'Mt3dms'  

 'Pht3d' 

 ‘Min3p’ 

9.2.2 Save ORTI3D Project File (.Orti) 

The Python function used to save ORTI3D project file is as follows: 

core.saveModel (‘fdir’, ‘fname’) 

Replace ‘fdir’ and ‘fname’ by doing the following: 

 ‘fdir’: path of the ORTI3D project file directory (‘D:/…/model_directory’). 

 ‘fname’: name of the ORTI3D project file (.orti). 

9.2.3 Run Model 

The Python function used to run the model is as follows: 

core.runModel ('Model', info=False) 

Replace 'Model' by the suitable type of model by doing the following: 

 ‘Modflow’ 

 'Mt3dms'  

 'Pht3d' 

9.3 Observations Data 

The Python function used to get the model results at a specific observation zones is as follows: 

t, d0, labels = core.onPtObs (‘typ’, iper, ‘group’, ‘zname’, [‘e’], layer) 

The keywords of this function are explained as follows: 

‘typ’ is the keyword with a letter to define the types of plot series following by a number to define 

the types of results, as follows:  

  ‘B0’ or ‘P0’ or ‘B1’ or ‘P1’ or ‘B2’ or ‘P2’ 
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The types of plot series are the time-series graph (Breakthrough) or the space-series graph (Profile). 

The keywords are as follows: 

 Breakthrough = B. 

 Profile = P. 

The types of results are as follows: 

 For flow model:  

‒ Head value = 0. 

‒ Darcy flux = 2. 

 For (reactive) transport model:  

‒ Concentration value = 0.  

‒ Weighted value = 1. 

‒ Mass discharge = 2. 

iper is the period at which you want to get the results. Note that the first period is 0. Replace iper by 

the suitable period number.  

‘group’ is the keyword used to indicate the type of model as follows: 

 MODFLOW model = 'Flow'. 

 MT3DMS model = ‘Transport’. 

 PHT3D model = ‘Chemistry’. 

‘zname’ is the name of the observation zone at which you want gets the results. Replace ‘zname’ by 

the name of the suitable observation zone.  

[‘e’] is the keyword used to specify the type of information or the name of species to get, as follows: 

 For flow model:  

‒ Head value = [‘Head’]. 

‒ Darcy flux = [‘Flux’]. 

 For transport model:  

‒ Solute name = [‘Tracer’]. 

 For reactive transport model:  

‒ Name of the chemical specie = [‘sp’]. With ‘sp’ the name of the chemical specie.  

layer is the layer at which you want to get the results. Replace layer by the suitable layer number. For 

2D and cross section model layer = 0. 
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9.4 Change Flow and Transport Parameters Value  

The Python function to set the zone value of a parameter is as follows: 

core.diczone ['model'].setValueFromName ('type', zname, str(v0)) 

The keywords of this function are explained as follows: 

'Model' is the keyword used to indicate the type of model. Replace 'Model' by the suitable type of 

model: 

 ‘Modflow’ 

 'Mt3dms'  

 'Pht3d' 

‘type’ is the type of distributed model parameter: 

 For flow model:  

‒ Horizontal hydraulic conductivity = ‘lpf.8’  

‒ Vertical hydraulic conductivity = ‘lpf.9’ 

 For (reactive) transport model:  

‒ Porosity = 'btn.11' 

‒ Boundary condition = 'btn.12' 

‒ Concentration = 'btn.13' 

‒ Longitudinal dispersivity = 'dsp.2' 

‒ R = dt/dl = 'dsp.3' 

‒ R = dv/dl = 'dsp.4' 

‘zname’ is the name of the parameter zone at which you want sets the results. Replace ‘zname’ by 

the name of the suitable parameter zone.  

v0 is the new parameter value. Replace v0 by the suitable parameter value. 

9.5 Change Chemicals Parameters (PHT3D) 

Change chemicals parameters involve the use of the four following Python functions:  

1. To get the type of the parameter involved: 

tdict = core.addin.pht3d.getChemDict ('type') 

2. To get the index of the parameter by providing the name of the chemical species: 

iz = tdict ['rows'].index (‘sp’) 

3. To set the value of the parameter: 

tdict ['data'] [iz] [nparm+1] = v0 

core.addin.pht3d.setChemDict ('type', tdict) 
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The keywords of this function are explained as follows: 

‘type’ is the type of chemical model parameter: 

 For chemical composition to the aqueous phases: 'Solutions' 

 For kinetic reaction parameters relative to the aqueous phases: 'Rates' 

 For chemical composition to mineral and gas phases: 'Phases' 

 For kinetic reaction parameters relative to the mineral and gas phases: 'Kinetic_Minerals' 

 For chemical composition to the exchange species: ‘Exchange’ 

 For parameters relative to surface complexation reaction: 'Surface' 

‘sp’ is the name of the chemical specie. With ‘sp’ the name of the chemical specie. 

‘nparm’ is the number of: 

 For 'Solutions': the solution number. 

 For 'Rates': the kinetic parameter number. 

 For 'Phases': the assemblage number or the SI number. 

 For 'Kinetic_Minerals': the kinetic parameter number. 

 For ‘Exchange’: the assemblage number. 

 For 'Surface': the assemblage number or the specific surface area of a surface or the mass of 

solid. 

v0 is the new parameter value. Replace v0 by the suitable parameter value. 
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